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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices 
referring only to property damage have no safety alert symbol. These notices shown below are graded according to 
the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may 
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.
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Calendar Options overview 1
Contents

The Calendar Options Information System provides important information concerning the 
"WinCC/Calendar Scheduler" and "WinCC/Event Notifier" options.
These WinCC Calendar Options share components. The entry "Calendar Options" appears in the 
WinCC Explorer after the installation of one or both options. The functionality available depends 
on the installed option.
In some chapters, alternate terminology may be used to represent names where functionality is 
the same in the options.

Terminology Calendar Scheduler Event Notifier
schedule action schedule notification schedule
resource action, calendar notification, contact, contact group, cal‐

endar

WinCC/Calendar Options Installation Notes
This chapter describes the installation of server and client components for the Calendar 
Scheduler and Event Notifier options. The software for both options is included on the same CD. 
A special license is required for each option.

WinCC/Calendar Options Release Notes
This chapter provides important and up-to-date information about the Calendar Scheduler and 
Event Notifier options.

WinCC/Calendar Options Getting Started
This chapter provides a quick introduction to the Calendar Scheduler and Event Notifier options. 
It does not contain a comprehensive list of all functions, but includes information for you to 
create a schedule and see the results.

WinCC/Calendar Scheduler Documentation
This chapter provides comprehensive information about all functions in the Calendar Scheduler 
option.

WinCC/Event Notifier Documentation
This chapter provides comprehensive information about all functions in the Event Notifier 
option.

WinCC/Calendar Options
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WinCC/Calendar Options Installation Notes 2
2.1 Installing server and client

Introduction   
The WinCC/Calendar Options include the WinCC/Calendar Scheduler and the WinCC/Event 
Notifier. A WinCC Calendar Option consists of server and client components that can be installed 
together on the same computer. These components can be installed across multiple computers 
in the WinCC Client/Server, redundant, and WebNavigator system configurations.
Only the functionality for the installed Calendar Option is available. When both options are 
installed, the functionality of both options is available.

Requirements       
The following components are required on any system where a Calendar Option is installed, 
including WebNavigator clients:
License key for one or both Calendar Options:
• WinCC/Calendar Scheduler Server and Client
• WinCC/Event Notifier Server and Client

Note
Hardware and software requirements
.NET Framework 4.0 must be installed in the WebNavigator client machine.
For other hardware and software prerequisites to install Calendar Options V7.5 SP2, refer WinCC 
Information System > Installation Notes > WinCC installation requirements.
All WinCC advanced options follow the same requirements as WinCC.

Licensing       
Each computer where you want to install the server component of a Calendar Option must have 
a license for the WinCC Calendar Option. No license is required for the computer where the 
clients of the Calendar Option will run. Information about licensing is in the WinCC Information 
System under "Installation Notes" and "Licensing".

WinCC/Calendar Options
System Manual, 11/2020, A5E49472488-AA 9



Installing Calendar Option             
Installing server and client
You can install the server and client components of a Calendar Option on a system where the 
WinCC Server software is installed. Detailed information about WinCC installation is in the 
WinCC documentation.

Installing client only
You can install the client component of a Calendar Option on a system where the WinCC Client 
software is installed.

Installing on WebNavigator client   
You can install the Calendar Options WebPlugin component on a system where the WinCC 
WebNavigator Client software is installed. Detailed information about WebNavigator installation 
is in the WinCC\WebNavigator documentation.

Installation of server/client     
1. Insert the Calendar Options DVD into the DVD drive.

The DVD starts automatically if Autorun is enabled in the operating system. If the Autorun 
function is disabled, start the Setup.exe program on the DVD.

2. Choose the setup language for the installation and click "Next".
3. Follow the on-screen instructions.

When prompted, read and accept the license agreements.
4. Select the following calendar options: "Event Notifier" and/ or "Calendar Scheduler"

Note
When a server component is selected, the appropriate client component will also be installed 
at the same time.

5. Click "Next" and start the installation.
You can track the status of the installation in the displayed dialog.

6. At the end of the installation, restart the computer.
The editor for the options is installed and added under "Calendar Options" in the navigation 
window of the WinCC Explorer.

Note
Cascaded server configuration
The cascaded server configuration is not supported.

WinCC/Calendar Options Installation Notes
2.1 Installing server and client
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Installation on WebNavigator client   
1. On the client machine, enter the address of the WebNavigator server in the Internet Explorer, 

for example: http://server_name.
2. If the WebNavigator Client software is not installed, a message will be displayed for you to 

confirm installation of the software.
3. When the "Download/Install - WebNavigator Custom Plugins" screen displays, click the arrow 

for the "WinCC Calendar Options WebPlugin". Follow the on-screen instructions.

Installation: Calendar Option in demo mode
The typical setup installs both Calendar Options. If only one Calendar Option is licensed, the 
Calendar Option with the missing license will run in demo mode.
If you do not wish to install both options, select "Custom" on the "Setup Type" screen and choose 
the desired option.

See also
http://support.automation.siemens.com/WW/view/en/73443294 (http://
support.automation.siemens.com/WW/view/en/73443294)

2.2 Importing packages

Introduction
A client requires the packages from the servers whose data it wants to use. Detailed information 
about importing a package is in the WinCC documentation.

Requirements     
• For a client only installation, you must import the server package into the project to ensure 

a proper connection.
• Server packages must be imported in the following cases:

Standard clients For a Calendar Control to access the Calendar Option servers, a 
server package must be imported into the client for each server 
where a calendar is to be accessed.

WebNavigator clients For a Calendar Control, running in a WebNavigator client to ac‐
cess the Calendar Option servers, a server package must be im‐
ported into the WebNavigator server for each server where a 
calendar is to be accessed.
If the WebNavigator server runs a Calendar Option server, the 
WebNavigator server must have a package created for itself.

WinCC/Calendar Options Installation Notes
2.2 Importing packages
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2.3 Uninstalling Calendar Options

Introduction         
You can uninstall the server and the client of WinCC Calendar Options.

Procedure
1. Open the Windows "Control Panel" and double-click the "Add or Remove Programs" symbol.
2. Click the "Change or Remove Programs" icon.
3. Select the Calendar Options server or client and then click "Remove".
4. Click "Next" and follow the on-screen instructions.

The Calendar Options server or client is removed from your system.

WinCC/Calendar Options Installation Notes
2.3 Uninstalling Calendar Options
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WinCC/Calendar Options Release Notes 3
3.1 Release notes

Contents
These release notes contain important instructions.
The statements in these release notes are more important than the instructions in the manuals 
and online help.
Please read these release notes carefully as they contain useful information.

3.2 Notes on Calendar Options

Migrating single-user projects created before V7.2
After migrating a single-user project, you need to run the CalendarDCF program to automatically 
add the Calendar Options entries to the DCF file for each project.
1. Run the CalendarDCF program from the following path:

"Program Files (x86)\Siemens\WinCC\Options\Calendar Options\bin\CalendarDCF.exe"
2. Browse for the DCF file (ProjectName.dcf) in the project directory. Click "Add" to insert the 

appropriate Calendar Options entries.

Migrating projects
The Calendear Options system supports implicit migration of the calendar options project. Only 
user need to reboot the machine after the installation of the latest version. The calendar options 
will automatically migrate all the projects present in the machine.

Configuration of E-Mails 
The testability of e-mails is improved.
The encryption via TLS is possible and is automatically used on Port 587.
TLS was renamed to SSL and is required only for SSL.
Yahoo email account is supported through SSL authentication.

Delta-upload
It is possible to delta-upload an Operator Station (OS), but changes made for Calendar Options 
at the Engineering Station (ES) are not transferred to the OS.

WinCC/Calendar Options
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Multiuser engineering
Multiuser engineering is not supported.

Installation of .NET Framework 4.0
Installation of the .NET Framework 4.0 in the WebNavigator client machine is required to display 
the Calendar Options Control.

3.3 Performance Restrictions

Restrictions due to performance and capacity limits
This section contains information on the tested performance and capacity limits of Calendar 
Options V7.5 SP2.
Based on the information in this section, determine whether the allocation you have planned is 
within the expected performance and capacity limits.

Configuration/ supported limits
Supported limits define the tested value for a specific parameter. The standard values for these 
parameters were established in tests and represent the known limitations of the product.
Exceeding the supported limits can lead to unexpected results, significant performance losses, 
and other negative consequences.
The following sample configuration is intended to provide you with a guide to the dimensions 
within which the functionality of Calendar Options is guaranteed.
Sample configuration:
• WinCC server with WebNavigator server and multi-user project
• Number of Text Library entries: 12 000
• Number of activation and notification schedules, as well as actions and notifications:

– Actions and notifications: 200
– Schedules: 200

Result
Picture opening times with the CalendarControl
Server 10 seconds
Client 10 seconds
Web 10 seconds

WinCC/Calendar Options Release Notes
3.3 Performance Restrictions
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Loading time of the CalendarControl
Server 10 seconds
Client 10 seconds

3.4 Service and Support

3.4.1 Warnings

Safety notes
Warning notice system
This manual contains notices you have to observe in order to ensure your personal safety, as well 
as to prevent damage to property. The notices referring to your personal safety are highlighted 
in the manual by a safety alert symbol, notices referring only to property damage have no safety 
alert symbol. These notices shown below are graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.

Note
is an important information about the product, the way to handle the product or the respective 
part of the documentation and we wish to especially bring this to your notice.

If more than one degree of danger is present, the warning notice representing the highest 
degree of danger will be used. A notice warning of injury to persons with a safety alert symbol 
may also include a warning relating to property damage.

WinCC/Calendar Options Release Notes
3.4 Service and Support
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Qualified Personnel
The product/system described in this documentation may be operated only by personnel 
qualified for the specific task in accordance with the relevant documentation, in particular its 
warning notices and safety instructions. Qualified personnel are those who, based on their 
training and experience, are capable of identifying risks and avoiding potential hazards when 
working with these products/systems.

Proper use
Note the following:

WARNING
Proper use of Siemens products
Siemens products may only be used for the applications described in the catalog and in the 
relevant technical documentation. If products and components from other manufacturers are 
used, these must be recommended or approved by Siemens. Proper transport, storage, 
installation, assembly, commissioning, operation and maintenance are required to ensure that 
the products operate safely and without any problems. The permissible ambient conditions 
must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks 
in this publication may be trademarks whose use by third parties for their own purposes could 
violate the rights of the owner.

Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions constitute one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected to 
an enterprise network or the internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.
For additional information on industrial security measures that may be implemented, please 
visit 
http://www.siemens.com/industrialsecurity
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats.

WinCC/Calendar Options Release Notes
3.4 Service and Support

WinCC/Calendar Options
16 System Manual, 11/2020, A5E49472488-AA



To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under
http://www.siemens.com/industrialsecurity

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and 
software described.
Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included 
in subsequent editions. Suggestions for improvement are welcomed.
The statements in the online documentation are more binding than the statements in the 
manuals and PDF files.
Please follow the Release Notes and Installation Notes. The information in these Release Notes 
and Installation Notes has priority over that in the manuals and online help with regard to legal 
validity.

Copyright © Siemens AG 2020
Änderungen vorbehalten / All rights reserved
It is prohibited to transfer, copy, evaluate or communicate this document in full or part unless the 
same has been explicitly approved. Violation of this rule can lead to claims for damage 
compensation. All rights reserved, especially for granting patents or for GM registration.
Siemens AG
Division Digital Factory
SIMATIC Human Machine Interfaces
P.O. Box 4848
D-90327 Nuremberg, Germany

3.4.2 GDPR - General Data Protection Regulations
Siemens takes data privacy principles, such as the privacy by design and default principle, into 
account when developing its products and services.
For this product SIMATIC WinCC V7.5 incl. Options this means the following:

WinCC/Calendar Options Release Notes
3.4 Service and Support
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Personal data processed by the Application
This product collects and processes the following personal data:
• User name, i. e. Login, which may directly contain or establish a reference to the family name 

and/or first name
• Timestamps: date / time of login, logoff and access

In the WinCC Option for Process Control application "Split Screen Manager", the login 
timestamp and user name are saved without encryption with the picture management data.
In the WinCC/WebNavigator diagnostic page, logged in users and timestamps are saved 
without encryption.

• Location data (time zone)
• Computer name
• IP addresses
• MAC addresses
• E-mail addresses (WinCC Options)
• In case of using UMC, additional personal data can be added in the tool, e. g. telephone 

numbers or addresses.
This data is not needed for the product functionality and should not be stored on the same 
medium.

If the user links the above mentioned data with other data, e. g. shift plans, or stores personal 
data on the same medium, e. g. hard disk, and thus establishes a personal reference, the user 
must ensure compliance with data protection regulations.

Purposes
The above data is required for the following purposes:
• Access protection and security measures (e. g. Login, IP address)
• Process synchronization and integrity (e. g. time zone information, IP addresses)
• Archiving system for traceability and verification of processes (e. g. access timestamps)
• Message system for traceability and availability (e. g. e-mail notification)
The storage of data is appropriate and limited to what is necessary, as it is essential to identify 
the authorized operators and process events.

Data configuration
The customer may configure the data collected via the product as follows:
• Display data in process pictures
• Data output in form of reports, e. g. for printing or display as electronic file
• Data collection and evaluation in form of graphics, e. g. for KPI analysis

Deletion policy
The product does not provide an automatic deletion of the above data.

WinCC/Calendar Options Release Notes
3.4 Service and Support
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If necessary, these can be deleted manually if desired. To do this, please refer to the product 
documentation or contact customer support.

Securing of data
The above data will not be stored anonymously or pseudonymized, because the purpose of 
access and event identification cannot be achieved otherwise.
The above data is secured by adequate technical measures, such as:
• Encryption of log data
• Storing the process data in access-protected SQL databases

The user must ensure the access protection as part of their process configuration.

3.4.3 Customer Support

Customer Support and Technical Support      
You can reach the SIMATIC hotlines at the times specified in the following table. The SIMATIC 
hotline employees speak German and English. The Authorization hotline offers French, Italian or 
Spanish customer support in addition to German and English.

Technical support

Nuremberg (GMT +1:00)
Service Hours Monday - Friday, 8:00 to 17:00 (CET/CEST)
Phone +49 (0)911 895 7222
Fax +49 (0)911 895 7223
E-mail http://www.siemens.com/automation/support-request

(http://www.siemens.com/automation/support-request)  (http://
www.siemens.com/automation/support-request)

An overview of the Technical Support is available at the following URL:
• http://support.automation.siemens.com/WW/view/en/16605032 (http://

support.automation.siemens.com/WW/view/en/16605032)

Automation Value Card (AVC)
The Automation Value Card (AVC) provides extended Technical Support and is available 24 hours 
every day of the week. Information on the AVC can be found at the following URL:
• http://support.automation.siemens.com/WW/view/en/21981898 (http://

support.automation.siemens.com/WW/view/en/21981898)
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SIMATIC Customer Online Support 
Service and Support 
An overview of the support offering for our products is available at the following URL:
• http://www.siemens.com/automation/service&support (http://www.siemens.com/

automation/service&support)
In Product Support, for example, you will find downloads of firmware updates, service packs and 
useful utilities.
Online Help is available so that you can successfully use the Support offering. Open the Online 
Help by selecting the corresponding button on the Internet site or at the following URL:
• http://support.automation.siemens.com/WW/support/html_00/help/Online_Hilfe.htm 

(http://support.automation.siemens.com/WW/support/html_76/help/Online_Hilfe.htm)

WinCC FAQs
WinCC Online Support with information on FAQs (Frequently Asked Questions) may also be 
found at the following URL:
• http://support.automation.siemens.com/WW/view/de/10805548/133000 (http://

support.automation.siemens.com/WW/view/en/10805583/133000)

Technical Forum
The Technical Forum supports exchange with other SIMATIC users. It is available at the following 
URL:
• http://www.siemens.com/automation/csi/forum (http://www.siemens.de/automation/

csi_en/forum)

Technical documentation for SIMATIC products
You can find a guide to the technical documentation provided for individual SIMATIC products 
and systems at the following URL:
• http://www.siemens.com/simatic-tech-doku-portal (http://www.siemens.com/simatic-tech-

doku-portal)

Contact person database
To contact your local agent, search our contact database at the following URL:
• http://www.automation.siemens.com/partner/index.asp (http://

www.automation.siemens.com/partner/index.asp?lang=en)

Product Information 
SIMATIC WinCC
Go to the following URL for additional information about WinCC products:
• http://www.siemens.com/wincc (http://www.siemens.com/wincc)
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SIMATIC Products
Go to the following URL for additional information about SIMATIC products:
• http://www.siemens.com/simatic (http://www.siemens.com/simatic)

See also
Internet: Support Request (http://www.siemens.com/automation/support-request)
Internet: Technical support (http://support.automation.siemens.com/WW/view/en/16605032)
Internet: Automation Validation Card (AVC) (http://support.automation.siemens.com/WW/view/
en/21981898)
Internet: Service and Support (http://www.siemens.com/automation/service&support)
Internet: WinCC FAQs (http://support.automation.siemens.com/WW/view/en/
10805583/133000)
Internet: Support Technical Forum (http://www.siemens.de/automation/csi_en/forum)
Internet: Support Online Help (http://support.automation.siemens.com/WW/support/html_76/
help/Online_Hilfe.htm)
Internet: Technical documentation for SIMATIC products (http://www.siemens.com/simatic-
tech-doku-portal)
Internet: Contact person database (http://www.automation.siemens.com/partner/index.asp?
lang=en)
Internet: Information about WinCC (http://www.siemens.com/wincc)
Internet: SIMATIC Products (http://www.siemens.com/simatic)
http://www.siemens.com/automation/support-request (http://www.siemens.com/automation/
support-request)

3.4.4 Support Request

Dear customer
In order to provide you with fast and effective support, please complete the "Support Request" 
form online on the Internet. Describe the problem in as much detail as possible. We would 
appreciate if you would provide us with all project data, so that we can reproduce the error 
situation or shorten the turn-around time.
Before filling out the support request, check whether your configured quantity structure is within 
the range of tested quantity structures (see topic "Performance Data").

Support Request form
The Support Request form is available at the following URL:   
• http://www.siemens.com/automation/support-request (http://www.siemens.com/

automation/support-request)
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When filling out the report, you will be guided through several steps, which will ask about all 
required information.
A detailed description of the Support Request can be found at the following URL:
• http://support.automation.siemens.com/WW/view/en/16605654 (http://

support.automation.siemens.com/WW/view/en/16605654)

Procedure
1. Open the "Support Request" form using the link on the Internet. Step 1 "Select product" is 

displayed:
2. Enter the project name in the "Product/Order number" box. Upper/lower case is not relevant.

Search for parts of the product name or enter the full product name in the correct order. You 
can e. g. search for the following terms:
- "WinCC Runtime"
- "WinCC DataMonitor"
- "WinCC webnavigator"
- "Connectivity"
The found products are offered in the "Product selection" field. 

3. Select the desired product and click on "Next" to switch to step 2 "Select use case".
4. Select a use case or describe your specific use case in the "Other application case" field. 
5. Press "Next" to switch to step 3 "Our solutions".

Suggested solutions and FAQs for the selected key words are listed.
Once you have found a suggested solution for your problem, you can close the form in the 
browser.
If you did not find any applicable suggested solutions, press "Next" to switch to step 4 
"Describe problem".

6. Describe your problem as exactly as possible in the "Details" field.
Pay particular attention to the following questions and comments. Please also check the 
WinCC installation and configuration with regard to the following references.
If you have any idea what has caused the error, please let us know. No detail should be 
omitted, even if you consider it unimportant.
- Was the configuration data created with older WinCC versions?
- How can the error be reproduced?
- Are other programs running simultaneously with WinCC?
- Have you deactivated the screen saver, virus checker and power management function?
- Search the computer for log files (WinCC\Diagnose\*.log, drwatson.log, drwtsn32.log). The 
log files are needed for error analysis. Thus, be sure to send the log files as well.

7. Use the "Search" button to upload your affected project and the log files (e. g. as a Zip file) to 
the Support Request.
Press "Next" to switch to step 5 "Provide contact information".

8. Enter your contact information.
Read the privacy notice and choose whether your personal data should be permanently 
saved.
Press "Next" to switch to step 6 "Summary & Send".

9. Press the "Print" button if you would like to print the support request.
You close the support request by clicking the "Send" button.
Your data will be transmitted to Customer Support and processed there.
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Thank you for your cooperation. We hope that we can be of assistance in solving your problems.
Your WinCC Team 

See also
Internet: Error report (http://www.siemens.com/automation/support-request)
Internet: Overview of Support Request  (http://support.automation.siemens.com/WW/view/en/
16605654)

WinCC/Calendar Options Release Notes
3.4 Service and Support

WinCC/Calendar Options
System Manual, 11/2020, A5E49472488-AA 23

http://www.siemens.com/automation/support-request
http://support.automation.siemens.com/WW/view/en/16605654
http://support.automation.siemens.com/WW/view/en/16605654


WinCC/Calendar Options Release Notes
3.4 Service and Support

WinCC/Calendar Options
24 System Manual, 11/2020, A5E49472488-AA



WinCC/Calendar Options Getting Started 4
4.1 Introduction

Welcome to the WinCC/Calendar Options Getting Started document. WinCC/Calendar Options 
includes Calendar Scheduler and Event Notifier.     
The Calendar Scheduler manages time-based activities for controlling automated processes that 
WinCC supervises. You can configure action schedules to change the value of WinCC tags in 
order to drive real world Inputs/Outputs (I/O) and turn the equipment on/off.
The Event Notifier manages time-based scheduling of personnel to receive notifications from 
automated processes that WinCC supervises. The Event Notifier notifies about an alarm 
condition to the scheduled person based on time of the day and day of the week.
This Getting Started document provides a quick introduction to Calendar Options. It does not 
contain a comprehensive list of all possible functions, but includes information to create a 
schedule and see the results.

4.2 Prerequisites

Configuration
The Example described in this document uses the configuration where the server and client 
components are installed on the same computer.
It is assumed that the user is aware of working with WinCC.

Note
Detailed installation information is available in WinCC documentation and WinCC/Calendar 
Options documentation.

Requirements
• A computer with WinCC V7.5 SP2 installed.
• Calendar Options is installed successfully.
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• License key for one or both the Calendar Options:
– Calendar Scheduler - Server and Client
– Event Notifier - Server and Client
The options can run in demo mode without licensing. Information about licensing and demo 
mode is available in the WinCC Information System under "Installation Notes > Licensing".

• WinCC project with configured tags, scripts, and alarms.
This document references the WinCC demo project named "DemoProjectV7.5 SP2". You may 
download this project from the following URL:
– Internet: WinCC demo projects (https://support.industry.siemens.com/cs/products?

search=demo&dtp=ExampleOfUse&o=DefaultRankingDesc&pnid=14867&lc=en-WW)
Alternatively, you may use your own project that has configured tags, scripts, and alarms.

4.3 Starting the Calendar Options Editor

Introduction   
The Calendar Options Editor can be started only for the project currently open in WinCC Explorer. 
The Calendar Options Editor contains elements of the Calendar Scheduler and Event Notifier, if 
both the options are installed. If only one option is installed, the editor provides elements of the 
installed option.
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Procedure
1. Open "DemoProjectV7.5 SP2" in WinCC Explorer.

For more information, see the WinCC Information System under "Working with Projects".
2. In the navigation window, right-click "Calendar Options" and choose one of the installed 

options:
– "Open Calendar Scheduler"
– "Open Event Notifier"
The Calendar Options Editor window opens and the "Default" calendar is displayed.

4.4 Scheduling an action

4.4.1 Overview
This chapter provides instructions to create an action schedule and see the results.
In this demonstration, WinCC, Calendar Scheduler Server, and Calendar Scheduler Client are all 
installed on the same computer.
Detailed information is available in the WinCC documentation and in the WinCC/Calendar 
Scheduler documentation.
This chapter provides instructions to:
• Create an action that sets a tag value.
• Create an action schedule to execute the action at the specified time.
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• Insert the Calendar Control into a picture to display the schedule.
• View the action schedule in Runtime.

4.4.2 Creating an action

Introduction       
In this section, you will configure an action that sets a tag value.

Prerequisite
In WinCC Explorer, create a tag named "ToolPress" with the data type "Unsigned 16-bit value" in 
"Tag Management". This tag is used while creating an action. Information about tags is in the 
WinCC Information System under "Working with Tags".

Procedure
1. In the Calendar Options Editor, click "Edit > Actions". "Action Editor" window appears.

2. In the "Name" field, enter the action name.
To create an action in a group, enter the group name followed by a backslash "\" as seperator 
and the action name.
Example: "Plant1\Machine1\Machine1Start".
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3. Click "Add Tags". In the "Tag Selection" dialog, select the "ToolPress" tag to link with the action. 
Click "OK".
The selected tag appears as a subaction.

4. Click in the "Value" field of this subaction and enter "45" as the tag value.
5. Click "OK".

The configured action group and action displays in the "Resources" window of the Calendar 
Options Editor.

4.4.3 Creating an action schedule

Introduction                 
In this section, you will create a calendar to allow schedules to display in Runtime. You will create 
an action schedule to associate with this calendar. You will also configure the schedule to repeat 
multiple times.

Procedure
1. Create a calendar:

– In the Calendar Options Editor, click "Edit > Calendars". "Calendar List Editor" appears.

– Enter "Line1" as the calendar name. Click the color picker and choose a color, such as "light 
blue". Click "OK".
The calendar is displayed in the "Resources" window.

2. Click "View > Day View", to change the view of the calendar to daily view.
3. Verify the action schedule preference is set by clicking "View > Preferences > Default 

Schedule Type > Action". This preference can be verified if both the Calendar Options are 
installed.
This preference causes the Action Schedule Editor to open when double-clicking a date or a 
time slot.
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4. Double-click a time slot close to the current time of day to open the Action Schedule Editor.
The time slot you clicked displays as the time the schedule will start and end.

5. Enter "Machine1Activate" as the action schedule name.
6. Under "Start Actions" section, click "Select". Expand the group in the "Actions" list and select 

the "Machine1Start" action you created.
The action displays under "Start Actions".

7. Click the "Calendar" drop-down list at the bottom and select "Line1" to associate the schedule 
with this calendar. Unselect "Default" to remove this calendar association.
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8. Click "OK".
The schedule is displayed in the calendar at the specified time in the editor. If you do not see 
the schedule, verify the "Line1" calendar option is selected in the "Resources" window. The 
color of the schedule matches the color of the calendar.

9. To configure this schedule to repeat every weekday:
– Double-click the schedule to open the editor and click "Recurrence".
– Set the "Recurrence pattern" to "Daily" and "Every weekday". Click "OK" to save the 

schedule.
– Change the calendar to month view by clicking "View > Month View".

The schedule displays on each weekday at the specified time. This schedule will execute 
10 times because the "Range of recurrence" has a default setting of 10 occurrences.

4.4.4 Adding Calendar Control to a picture

Introduction       
In this section, you will insert the Calendar Control into a picture and configure the control to 
display the schedules in the calendar during Runtime. You will insert a bar graph and I/O field in 
the picture so that you can see the tag value of an action schedule is set at the specified time.
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Procedure
1. In WinCC Explorer, open the Graphics Designer and create a picture.
2. Open the "Controls" tab available on the right side of the picture and select ".NET controls > 

WinCC_Calendar.Calendar".
3. Drag-and-drop the WinCC_Calendar.Calendar control onto the picture and resize as desired.

4. Open the "Standard" tab and select "Smart Objects > Bar".
5. Drag-and-drop the "Bar" object next to WinCC_Calendar.Calendar control in the picture. "Bar 

Configuration" window appears.
6. Select the "ToolPress" tag that you associated with the action referenced in the schedule for 

the "Tag" field.
7. Set the limits for the bar display to minimum = 0 and maximum = 100.

This bar object will display the tag value when the schedule is executed.
8. Click "OK".
9. Under "Smart Object", drag-and-drop the "I/O Field" below the bar object. "I/O Field 

Configuration" window appears.
10.Select "ToolPress" tag for the "Tag" field.

You will use this field in Runtime to reset the tag value so that you can see the schedule's tag 
value set again at the specified time.
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11.Select the Calendar control and go to "Object Properties > Properties > Control properties". 
Set the following attributes:

Attribute Value
ActiveViewType Day
DefaultScheduleType Action

12.Save the picture.
You have now designed and configured a Calendar Control to display schedules in Runtime.

4.4.5 Viewing an action schedule in Runtime

Introduction       
To see the results of action schedules, you can view the calendar during Runtime and observe 
that the tag value is set at the specified time. Using the sample calendar picture you configured, 
you can manually change the tag's value and the schedule's start time to execute the schedule 
again.

Procedure
1. In the Graphics Designer, click the "Activate" button to view the picture in Runtime.
2. Open your computer's system clock by double-clicking the time in the system tray. Position 

the clock and the Runtime picture so both are visible.
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3. In the calendar, scroll until the schedule is visible.
4. Double-click the schedule to open the Action Schedule Editor. Set the time to 1 minute after 

the current time and click "OK".
5. Watch the tag value change to the configured value at the specified time.

6. To reset the tag's value manually, enter a different value in the "I/O Field" box and repeat step 
4 to make this schedule occur again.
Each time the specified time is met, the bar graph changes to display the tag value entered 
in the schedule's action.

4.5 Scheduling notifications

4.5.1 Overview
This chapter provides instructions to create a notification schedule and see the results. Detailed 
information is available in WinCC documentation and WinCC/Event Notifier documentation.
In this demonstration, WinCC, Event Notifier Server, and Event Notifier Client are all installed on 
the same computer.
The chapters show you how to:
• Configure a test communication service to simulate the delivery of notification email to 

contacts and their replies.
• Create contacts and notifications.
• Create notification schedules to specify contacts to receive notification email.
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• View and acknowledge notifications.
• View notification schedules at Runtime.

4.5.2 Configuring a test communication service

Introduction  
To send a notification email, first you must configure a communication service that specifies how 
WinCC connects to the email service.
To simulate the delivery of notification email to contacts and their replies, you will need to 
configure the "Mail Simulator" in Communication Service Editor. "Mail Simulator" is provided for 
demonstration purposes only. You must configure your communication service for actual 
processing.

Procedure
1. In WinCC Explorer, expand "Calendar Options > Event Notifier". Double-click "Communication 

Service" to open the "Communication Service Editor".

2. Enter "MailSimulator" as the communication service name.
3. Click the "Type" drop-down menu and select "Test Mailer".
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4. In the "Email Address" field, enter "notifier@mymailserver.com" as the mailbox on your email 
server.
The Event Notifier uses this mailbox to send notification email and to receive 
acknowledgments from the contacts.

5. Click "Save" and then click "Close".
"Mail Simulator" window opens.

4.5.3 Creating contacts

Introduction       
In this section, you will configure contacts to receive notification email. A 'Contact' is a WinCC 
user with a specified email address. The users created in "WinCC User Administrator" only can be 
used as a contact. Each contact will use the "MailSimulator" communication service to simulate 
the sending of notification email.
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Procedure
1. In the Calendar Options Editor, click "Edit > Contacts".

The "Contact Editor" displays the users configured in the WinCC User Administrator.

2. Create WinCC users that can be used as contacts.
– Right-click on the "Users" section area and select "User Administration". "User 

Administrator" window opens.
– In "User Administrator", create the following user groups and users.

User Group User Authorizations
Managers Jack all authorizations except "Web Access - monitoring 

only"Locke
Operators Charlotte • "Process controlling"

• "Change picture"
• "Window selection"
• "Hardcopy"
• "Confirm alarms"

Sawyer

Information about user administration is in the WinCC Information System under 
"Working with WinCC > Structure of the User Administration".

3. In Contact Editor, create contact groups with the same name as the user groups.
– Under "Contacts", right-click and choose "Add Group". Enter "Managers" and press 

<Enter>.
– Create another contact group named "Operators".
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4. Drag-and-drop the users created under "Managers" group in the "Users" section onto the 
"Managers" group created in the "Contacts" section. Repeat the step to drag-and-drop users 
under "Operators" in the "Users" section to the "Operators" group in the "Contact" section.

5. For each contact, select the contact name and enter the contact properties.
– Select "MailSimulator" as the "Server Name".
– Enter the email address and select a color to associate with the contact. Click "Apply".

Contact Color Email
Jack blue jack@gmail.com
Locke brown locke@yahoo.com
Charlotte yellow charlotte@hotmail.com
Sawyer orange sawyer@gmail.com

The configuration for Jack will be:

– Click "OK".
The configured contacts display in the "Resources" window of the Calendar Options Editor.
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4.5.4 Creating notifications

Introduction       
In this section, you will configure two notifications to filter configured alarm messages.

Procedure
1. In Calendar Options Editor, click "Edit > Notifications". The "Notification Editor" window 

opens.

2. Enter "Furnace Alarm" as the notification name.
3. Under the "Selection" tab, enter the filter criteria:

Criteria Operator Setting
Event equal to Furnace
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4. Under the "Message Blocks" tab, use the message blocks to define the subject and body of the 
email:
– Drag the "Event" message block to the "Subject" field.
– Drag the "WinCC Message text" to the "Message" field.
– Enter "Acknowledged:" and drag "WinCC Message text" to the "Acknowledge" field.

The message blocks are configured in WinCC Alarm Logging. Information about message 
blocks is in the WinCC Information System under "Working with WinCC > Setting Up a 
Message System > Configuring the Message System".

5. Click "Apply".
6. Click "New" and create another notification named "Infeed Alarm". Enter the same 

configuration used for the "Furnace Alarm", except enter "Infeed" in the "Setting" field.
7. Click "OK".

The configured notifications display in the "Resources" window.

4.5.5 Creating notification schedules

Introduction                 
In this section, you will create a calendar to allow schedules to display in Runtime. You will create 
schedules to associate with this calendar. You will also configure the schedule to repeat multiple 
times.
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Procedure
1. Create a calendar:

– In the Calendar Options Editor, click "Edit > Calendars".

– Enter "Personnel" as the calendar name. Click the color picker and choose a color, such as 
"light green".

– Click "OK". The calendar displays in the "Resources" window.
2. In the Calendar Options Editor, change the view of the calendar to daily by clicking "View > 

Day View".
3. If both Calendar Options are installed, verify if the notification schedule preference is set by 

clicking "View > Preferences > Default Schedule Type > Notification".
This preference causes the Notification Schedule Editor to open when double-clicking a date 
or time slot.

4. Double-click a time slot close to the current time of day to open the Notification Schedule 
Editor.
The time slot you clicked displays the time the schedule will start and end.

5. Enter "Furnace check" as the schedule name.
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6. Under "Contacts" section, choose the contacts for this schedule.
– Click "Select". In the "Contacts" list, select operator "Charlotte" and manager "Jack" to 

receive the notifications.
– Click "OK".
– For "Jack", set the "Escalation" time to 1 minute.

This is the delay in time an alarm must remain unacknowledged before the contact is 
notified. A "0" value indicates the contact is notified immediately.

7. Under "Notifications" section, click "Select".
8. In the "Notifications" list, select "Furnace Alarm" and click "OK".
9. Click the "Calendar" drop-down below and select "Personnel" to associate the schedule with 

this calendar. Unselect "Default" to remove this calendar association.
10.Click "Apply" to save this schedule.

WinCC/Calendar Options Getting Started
4.5 Scheduling notifications

WinCC/Calendar Options
42 System Manual, 11/2020, A5E49472488-AA



11.Click "New" and create another schedule that references contact groups.
– Enter "Infeed check" as the schedule name.
– Under "Contacts" section, click "Select" and select "Managers" and "Operators".
– Click "OK".
– Set the "Escalation" time for Managers to 1 minute.
– Under "Notifications" section, click "Select" and select "Infeed Alarm".
– Click "OK".
– Associate this schedule with the "Personnel" calendar.

12.Click "OK".
The schedules display in the calendar as the color defined for the "Personnel" calendar. If you 
do not see the schedules in the calendar, verify the "Personnel" calendar is selected in the 
"Resources" window. If a schedule is not at the time you want, simply drag the schedule to the 
desired time.

13.To configure this schedule to repeat every weekday:
– Double-click the schedule to open the editor and click "Recurrence".
– Set the "Recurrence pattern" to "Daily" and "Every weekday". Click "OK" and then save the 

schedule.
– Change the calendar to month view by clicking "View > Month View".

The schedule displays on each weekday at the specified time. This schedule will execute 
10 times because the "Range of recurrence" has a default setting of 10 occurrences.
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4.5.6 Viewing and acknowledging notifications

Introduction     
In this section, you will activate the "DemoProjectV7.5 SP2" and set an alarm. You will see that 
the notification email is sent to appropriate contacts in the "Mail Simulator". You will let a contact 
acknowledge the notification. You will also set an alarm and let it escalate to the next contact.

Procedure
1. In WinCC Explorer, activate "DemoProjectV7.5 SP2" to see the startup picture in Runtime.

The "Mail Simulator" opens after the picture displays. You may need to reposition the dialog 
and the picture so that both the windows are visible on the screen.

2. In the picture, click "WinCC icon > Favorites > Tips & Tricks > Alarm Logging > AlarmControl 
Extra functions".
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3. Click "Set" to generate an alarm for "Alarm 2".
The message displays in the picture.

The "Mail Simulator" shows that "Charlotte" received the notification email.
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4. Select the notification email and click "Ack".
The "Mail Simulator" shows that the acknowledgment email is sent.

The alarm state in the picture changes to acknowledged.
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5. Reset "Alarm 2" and then set it again. Wait at least 1 minute.
The "Mail Simulator" shows that manager "Jack" received the notification email because 
"Charlotte" had not acknowledged the alarm within the escalation time.

6. Generate the "Warning 2" alarm to send notification email to both the operators. Either of the 
operators can acknowledge the alarm.

7. Generate the alarm again. Wait for 1 minute to see both managers receive the notification 
email.
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4.5.7 Viewing notification schedules in Runtime

Introduction           
In this section, you will create a picture so that operators can view and create schedules. You will 
insert the Calendar Control into a picture and configure the control to display the schedules in 
the calendar.

Procedure
1. In WinCC Explorer, open Graphics Designer and create a picture.
2. Open the "Controls" tab available on the right side of the picture and go to ".NET controls > 

WinCC_Calendar.Calendar".

3. Drag-and-drop the Calendar control onto the picture and resize as desired.
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4. Double-click the control and go to "Object Properties > Properties > .NET Control > Control 
properties" and set the following attributes:

Attribute Value
ActiveViewType Day
DefaultScheduleType Notification
SelectedCalendar Personnel

5. Save the picture. Click the "Activate" button to view the picture in Runtime
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WinCC/Calendar Scheduler Documentation 5
5.1 Introduction

The Calendar Scheduler is a WinCC option that provides an easy way to manage time-based 
activities for controlling automated processes that WinCC supervises. You can easily create 
schedules to execute actions at desired times.
With the WinCC/Calendar Scheduler, you can:
• Easily set WinCC tag values or run global scripts at specified times to drive real world I/O and 

turn equipment on and off.
• Secure operator scheduling through user authorizations.
• Create recurring schedules with overrides for holidays or maintenance activities.
• Choose the system configuration where this option is installed: WinCC Client/Server, multi-

user systems, redundant systems, and WebNavigator.

5.2 Calendar Options

5.2.1 How Calendar Options work

Structure   
The WinCC/Calendar Options include the WinCC/Calendar Scheduler and the WinCC/Event 
Notifier. A license is required for each option. The entry "Calendar Options" appears in the WinCC 
Explorer after the installation.
The Calendar Options share components. Only the functionality for the installed option is 
available. When both options are installed, the functionality of both options is available. The 
following diagram shows the relationship of editors used when configuring the Calendar 
Scheduler and the Event Notifier. Light blue indicates Runtime.
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Each Calendar Option has a calendar that serves as a named grouping of action schedules or 
notification schedules. The Calendar Scheduler has action schedules that reference one or more 
actions that will execute when the schedule starts and ends. The Event Notifier has notification 
schedules that specify a start and end time when a list of referenced contacts can be sent alarms 
that match the referenced notifications.

Calendar Options components   
The Calendar Options consist of server and client components that can be installed together on 
the same computer. These components can be installed across multiple computers in the WinCC 
Client/Server, multi-user, redundant, and WebNavigator system configurations.

Calendar Options Editor   
The Calendar Options Editor is accessed from the WinCC Explorer. The Calendar Options Editor 
is used to set up or edit a WinCC project's Calendar Scheduler or Event Notifier configuration.
The Calendar Scheduler lets you create schedules to execute actions. The Event Notifier lets you 
create schedules to send email notifications to specified contacts when WinCC alarm messages 
match the configured notification criteria. You would set an authorization on an action, 
notification, or contact to prevent unauthorized use by operators.

Calendar Scheduler Server       
The Calendar Scheduler Server runs as a background service on each WinCC Server in the project 
executing the configured activities. The Calendar Scheduler Server starts when the WinCC 
project is activated in Runtime and stops when Runtime is deactivated.
The Calendar Scheduler follows the same redundancy model as other WinCC functions. The 
Calendar Scheduler Servers start on both WinCC Servers. Only the server located on the active 
server executes actions. During a server switch, the standby server becomes active and executes 
the actions.
Configuration data (actions and calendars) is synchronized manually between the redundant 
servers. For information, see the WinCC Information System under "Working with WinCC > 
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Working with Projects > Copying and Duplicating Projects". Runtime data (schedules) is 
synchronized automatically.

Note
Time synchronization between the pair of redundant WinCC servers is essential for correct 
operation.

Note
In Runtime, making changes from the standby server is not supported in this version. You can 
only make changes on the master server.

Event Notifier Server     
The Event Notifier Server runs as a background service on each WinCC Server in the project 
sending the configured notifications to the scheduled contacts. The Event Notifier Server starts 
when the WinCC project is activated in Runtime and stops when Runtime is deactivated. The 
Event Notifier Server loads the configuration information at startup and loads any operator 
changes immediately.
The Event Notifier follows the same redundancy model as other WinCC functions. The Event 
Notifier Servers start on both WinCC Servers. Only the server located on the active server sends 
emails. During a server switch, the standby server becomes active without loss of Event Notifier 
data. For example: A contact who received an email from the primary server is allowed to 
acknowledge the email after a switch to the secondary server.
Configuration data (notifications, contacts, and calendars) is synchronized manually between 
the redundant servers. For information, see the WinCC Information System under "Working with 
WinCC > Working with Projects > Copying and Duplicating Projects". Runtime data (schedules) 
is synchronized automatically.

Note
Time synchronization between the pair of redundant WinCC servers is essential for correct 
operation.

Note
In Runtime, making changes from the standby server is not supported in this version. You can 
only make changes on the master server.

Calendar Control   
The Calendar Control can be placed into one or more WinCC pictures using the WinCC Graphics 
Designer. You would configure this control to display and manage the subset of schedules 
specific to the portion of the application's process used in the picture.
A server package cannot be imported or deleted while a WinCC Client is running. The Calendar 
Option servers do not recognize the imported or deleted package because the Calendar Control 
reads at startup.
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Calendar Scheduler in Runtime   
In Runtime, operators use the Calendar Control to view and manage the time-based activities. 
Operators can create and edit action schedules only with the preconfigured actions they are 
authorized to use.
When operators attempt to select an action they are not authorized to use, they receive the 
"Insufficient permission" message. When they attempt to edit action schedules that contain at 
least one unauthorized action, the schedule remains unchanged at its preconfigured date and 
time.

Event Notifier in Runtime   
In Runtime, operators use the Calendar Control to view and manage the scheduling of personnel 
to receive email when a new alarm matches the configured notifications. Operators can create 
and edit notification schedules only with the preconfigured notifications and contacts they are 
authorized to use. If configured to do so, operators can create and edit contacts and contact 
groups.
When operators attempt to select a notification or contact they are not authorized to use, they 
receive the "Insufficient permission" message. When they attempt to edit notification schedules 
that contain at least one unauthorized notification or contact, the schedule remains unchanged 
at its preconfigured date and time.

Time display format       
The Calendar Scheduler Server and the Event Notifier Server save the date and time in the UTC 
(Coordinated Universal Time) format. The Calendar Options Editor and Calendar Control display 
time based on the local time setting of the client computer. This allows multiple operators using 
WinCC systems with clients located in different time zones to view and manage schedules in 
their own time.

Alternate terminology
Throughout the documentation, alternate terminology may be used to represent names where 
functionality is the same in the Calendar Options.

Terminology Calendar Scheduler Event Notifier
schedule action schedule notification schedule
resource action, calendar notification, contact, contact group, cal‐

endar
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5.2.2 Calendar Scheduler

Structure   
The Calendar Scheduler lets you create schedules to execute actions. The following diagram 
shows the relationship of editors and dialogs used when configuring the Calendar Scheduler. 
Light blue indicates Runtime.

• "Calendar": Serves as a named grouping of configured action schedules. Optionally, a 
calendar name can have translated text.

• "Action Schedule": References one or more actions that will execute when the schedule starts 
and ends (if configured). Optionally, the schedule can be defined to reoccur, and the schedule 
name can have translated text.

• "Action": Contains at least one subaction. A subaction represents either a tag setting or C-
script execution. Optionally, an action can have a security authorization, and the action name 
can have translated text.

Workflow
In a typical WinCC project, you would configure all the actions necessary to control the process, 
independent of the action schedules. In each action, enter a descriptive name for each of the 
project’s languages and select the user authorization necessary to create a schedule using the 
action.
During Runtime, operators can create and edit schedules that execute actions for which they are 
authorized.
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5.2.3 Event Notifier

Structure   
The Event Notifier lets you create schedules to send email notifications to specified contacts 
when WinCC alarms or messages match the configured notification criteria. The following 
diagram shows the relationship of editors and dialogs when configuring the Event Notifier. Light 
blue indicates Runtime.

• "Calendar": Serves as a named grouping of configured notification schedules. Optionally, a 
calendar name can have translated text.

• "Notification Schedule": Specifies a time frame that the referenced "Contacts" or "Contact 
Groups" can be sent alarms that match the referenced "Notifications". Associated with each 
contact is an "Escalation" time that the alarm must remain unacknowledged before the 
contact is notified. Optionally, the schedule can be defined to reoccur, and the schedule name 
can have translated text.

• "Contact": Specifies an individual that can be sent notifications. Each contact is a WinCC user 
with a specified email address. Each contact identifies a communication service through 
which notification email is sent. Optionally, a contact can have a security authorization.
A "Contact Group" is a list of contacts. Messages may be sent to all contacts in the contact 
group. Optionally, a contact group name can have translated text.

• "Notification": Identifies a set of alarms or other WinCC messages. Each notification contains 
message blocks and selection filter criteria to use for the alarm output. The configuration 
defines the information to send when an alarm occurs. Optionally, a notification can have a 
security authorization, and the notification name can have translated text.

• "Communication Service": Specifies how WinCC is to connect to the email server or other 
communication service that will deliver notification email to contacts and their responses to 
the email. Multiple services can be configured.
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Workflow
In a typical WinCC project, you would:
1. Configure a communication service during initial project setup.
2. Configure the notifications and contacts necessary for your application, independent of the 

notification schedules.
– In each notification, enter a descriptive name for each of the project’s languages. Select 

the user authorization necessary to create schedules using the notification.
– In each contact group, enter a descriptive name for each of the project's languages. Drag 

contacts to the contact groups.
– In each contact, enter its email address and server name. Select the user authorization 

necessary to create schedules using the contact.
During Runtime, operators can create and edit schedules using contacts and notifications for 
which they are authorized. Occasionally, operators may be allowed to create and edit contacts 
and contact groups. WinCC alarm messages that match the notifications in the active schedules 
may be sent to the specified contacts. Messages are sent to a contact only if the alarm is not 
acknowledged before the contact's configured escalation time.

5.2.4 Calendar Options System Tags
Calendar Options has the following system tags. These tags are displaying specific message/
information for an action or event at runtime. These tags will created as “internal tag” and are 
part of the “Calendar” group in WinCC Tag Management.

@CalendarMsg
This tag holds the string value for information related to an appointment (while creating/
Modifying/deleting) and resources (Calendar changed/Notification changed/contact changed/
action changed). The message string contains information such as appointment status, 
machine name, and event name.

@EventMsg
This tag holds the string value of an initiated events. The message string contains information 
such as machine name, server status (server up/server initialized), event status (start executed/
stop executed), appointment Id, and appointment subject.

@ExecuteMsg
This tag holds the string value of an executed action/sub-action. The message string contains 
information such as system Id, executed action/sub-action, executed action/sub-action Id.
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@SynchronizeMsg
This tag holds the string value of the synchronized events. The message string contains 
information related to the synchronization of data of the actual server machine to redundant 
server machine

5.3 Working with Calendar Scheduler

5.3.1 Opening the Calendar Options Editor

Introduction   
The Calendar Options Editor can be started only for the project currently open in the WinCC 
Explorer. The Calendar Options Editor contains elements of the Calendar Scheduler and the 
Event Notifier when both options are installed. If only one option is installed, the editor provides 
the elements of the installed option.

Procedure
You can open the Calendar Options Editor in the navigation window of WinCC Explorer in the 
following ways:
• Right-click "Calendar Options" and choose the installed option: "Open Calendar Scheduler" or 

"Open Event Notifier".
• Expand "Calendar Options" and double-click the installed option: "Calendar Scheduler" or 

"Event Notifier".
• Expand "Calendar Options" and select "Calendar Scheduler". In the data window, right-click 

"Action Schedule" and choose "Open".
• Expand "Calendar Options" and select "Event Notifier". In the data window, right-click 

"Notification Schedule" and choose "Open".
Note
The option you select determines which schedule type to open when double-clicking a date 
or time slot. The default schedule type for Calendar Scheduler is "Action". The default 
schedule type for Event Notifier is "Notification".

Results
The Calendar Options Editor starts and a calendar is opened in the data window. A list of all 
available resources is visible. The month view displays the first time this editor is opened. If you 
change the calendar view, that view will display anytime the editor is opened.
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5.3.2 Calendar Options Editor

5.3.2.1 Calendar Options Editor elements

Introduction
When you start a Calendar Option in WinCC Explorer, the Calendar Options Editor is opened. The 
Calendar Options Editor is used to configure a project's initial time-based activities in the 
Calendar Scheduler or time-based scheduling of personnel to receive notifications in the Event 
Notifier. Only the elements of the installed Calendar Option display.

Elements of the Calendar Options Editor   
The user interface of the Calendar Options Editor consists of the following elements:

① Menu bar
② Toolbar
③ Resources window
④ Data window
⑤ Date Navigation window
⑥ Status bar
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5.3.2.2 Menu bar

Introduction     
The menu bar includes the commands that you can use in the Calendar Options Editor. Some 
commands can be activated using the key combinations (shortcut keys). The following tables 
provide brief information on the commands in the menu bar.
Only the menu commands of the installed Calendar Options are visible.

File menu   
The File menu includes one command:

Command Key combination Function
Exit <Alt+F4> Closes the Calendar Options Editor.

Edit menu   
The Edit menu includes the following commands:

Command Key combina‐
tion

Op‐
tio
n

Function

Action 
Schedules

<Ctrl+N> C Opens the Action Schedule Editor with the next default, unconfig‐
ured action schedule name displaying.

Actions --- C Opens the Action Editor with the next default, unconfigured action 
name displaying.

Calendars --- C E Opens the Calendar List Editor with the next default calendar name 
displaying.

Notifica‐
tion Sched‐
ules

<Ctrl+N> E Opens the Notification Schedule Editor with the next default, un‐
configured notification schedule name displaying.

Contacts --- E Opens the Contact Editor with the list of WinCC users and groups 
displaying so you can create contacts and contact groups.

Notifica‐
tions

--- E Opens the Notification Editor with the next default, unconfigured 
notification name displaying.

"C": Visible when Calendar Scheduler is installed.
"E": Visible when Event Notifier is installed.
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View menu   
The View menu includes the following commands:

Command Key combination Function
Day View --- Displays all schedules in a 24-hour day format for the 

selected day.
Work Week View --- Displays all schedules in a 5-day week, 24-hour day for‐

mat. A work week contains Monday through Friday and 
begins with the selected Monday or with the Monday 
prior to the selected day or date range.

Week View --- Displays all schedules for the selected week. A week in‐
cludes all 7 days of the week and begins with the selec‐
ted Monday or with the Monday prior to the selected day 
or date range.

Month View --- Displays all schedules in a monthly format. A month be‐
gins with the week containing the selected day or date 
range.

Timeline View --- Displays all schedules in a timeline format. A timeline 
highlights 15 days and begins with the selected day or 
first day of a date range.

Toolbar --- Displays or hides the toolbar.
Status Bar --- Displays or hides the status bar.
Go to This Day --- With the month or week view visible and one date se‐

lected, this command displays the selected date in day 
view. The work start time is highlighted. This command 
is not available in the other views.

Go to Today --- Displays schedules for the current day or for the work 
week, week, month, or timeline that contains the cur‐
rent day. In each resulting view, the current day is high‐
lighted. On the timeline view, the current day is the first 
day in the timeline.

Go to Date --- Opens a dialog for you to enter a specific date and which 
calendar view to display. You can choose the date from a 
pop-up calendar. The view changes to the specified view 
with the work start time highlighted on the specified 
date.

Grouping --- Displays the schedules in multi-resource views in addi‐
tion to the standard calendar views. The way the group‐
ing displays depends on the selected calendar view.
• "None": Grouping is off so that only the standard cal‐

endar view is visible.
• "Date": Grouping is by the dates displayed horizon‐

tally with the selected resources underneath display‐
ing either horizontally or vertically.

• "Resource": Grouping is by the selected resources 
displayed horizontally with the dates underneath 
displaying either horizontally or vertically.

Preferences --- If more than one Calendar Option is installed, this com‐
mand sets the default schedule type to open when a day 
or time slot in the data window is double-clicked. The 
schedule type can be an "Action" or "Notification".
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Command Key combination Function
Time Scales --- With the timeline view visible, this command changes 

the increment of time to display in the timeline. Select‐
ing the same scale again switches between hiding and 
showing the scale.

Time Scale Cap‐
tions

--- With the timeline view visible, this command sets the 
time scale caption to display in the timeline. Selecting 
the same caption again switches between hiding and 
showing the caption.

Refresh F5 Refreshes the data in the Calendar Options Editor.

Tools menu   
The Tools menu includes the following commands:

Command Key combination Function
Language --- Displays the "Select Language" dialog so you can change 

the configuration language of the Calendar Options and 
WinCC.

Servers --- Displays the server names when multiple servers are 
configured. You can choose a server and have the WinCC 
project connect to a different server.

Help menu   
The Help menu includes the following commands:

Command Key combination Function
Contents and In‐
dex

--- Opens the Calendar Options Information System.

Direct Help --- Activates the direct help (What's this?).
About Calendar 
Options

--- Displays the installed version and the installed compo‐
nents of the Calendar Options.

5.3.2.3 Toolbar
The toolbar contains buttons that allow you to quickly activate commands. You can switch 
between hiding and showing the toolbar by clicking "View > Toolbar". Only the toolbar buttons 
of the installed Calendar Options are visible.     
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Selecting the toolbar and dragging it along the borders of the Calendar Options Editor lets you 
move the toolbar. You can reposition the toolbar by moving it either left and right or up and 
down.

Ic
o
n

Tooltip Op‐
tion

Description

Hide/Show 
Resources

C E Switches between showing and hiding the "Resources" window in the Calendar 
Options Editor.

Hide/Show 
Date Navi‐
gation

C E Switches between showing and hiding the "Date Navigation" window in the 
Calendar Options Editor.

Action 
Schedule 
Editor

C Opens the Action Schedule Editor with the next default, unconfigured action 
schedule name displaying.

Action Edi‐
tor

C Opens the Action Editor with the next default, unconfigured action name dis‐
playing.

Calendar 
List Editor

C E Opens the Calendar List Editor with the next default calendar name displaying.

Notifica‐
tion Sched‐
ule Editor

E Opens the Notification Schedule Editor with the next default, unconfigured 
notification schedule name displaying.

Contact Ed‐
itor

E Opens the Contact Editor with the list of WinCC users and groups displaying so 
you can create contacts and contact groups.

Notifica‐
tion Editor

E Opens the Notification Editor with the next default, unconfigured notification 
name displaying.

Calendar 
Options 
Help

C E Opens the Calendar Options Information System.

"C": Visible when Calendar Scheduler is installed.
"E": Visible when Event Notifier is installed.

5.3.2.4 "Resources" window
The "Resources" window displays a grouping of the configured resource names and determines 
which resources to show in the data window. Depending on the installed Calendar Options, a 
resource can be an action, notification, contact, or calendar.     
For quick recognition, the color configured for a resource displays in the "Resources" window. 
The resources are grouped by resource type.

WinCC/Calendar Scheduler Documentation
5.3 Working with Calendar Scheduler

WinCC/Calendar Options
System Manual, 11/2020, A5E49472488-AA 63



Selecting the check box next to a resource group selects all resources in the group and displays 
a black check mark. Expanding the group and selecting individual resources changes the check 
mark color to gray for the group.
All selected resources display in the data window, based on a standard calendar view or a multi-
resource view.

5.3.2.5 "Date Navigation" window
The "Date Navigation" window controls the date or date range to display in the data window. The 
number of consecutive months that display in this window depends on the size of the Calendar 
Options Editor window. Clicking a day or highlighting a range of days in this window displays the 
selected day or range of days in the data window. Clicking the left and right arrows next to the 
month and year allows you to quickly move through the months and years in the calendar.    

5.3.2.6 Data window

Data area      
The data window displays the date range and the schedules for the resources selected in the 
"Resources" window. The way the data displays in this window depends on the selected calendar 
view. A standard calendar view can be a day, work week, week, month, or timeline. Each view 
displays the schedules in the color configured for the associated calendar. If a schedule is 
associated with multiple calendars, the color of the schedule displays as the first selected 
calendar when the schedule was configured.
In addition to the standard calendar views, the data window can display multi-resource views. 
In these views, multiple date areas are displayed vertically or horizontally. The color configured 
for a selected resource displays as the background color for the resource. Each date area displays 
the schedules associated with the selected resource. The schedules display as a neutral color to 
complement the background color. Depending on the installed Calendar Options, a resource can 
be an action, notification, contact, or calendar.
Double-clicking a day, time slot, or schedule in the data window opens the editor, so you can 
create a schedule or edit an existing one. You can also highlight a range of days and create a 
schedule for the duration of the selected days.

Navigating
On the left and right borders of the data window are "Previous" and "Next" tabs. These tabs are 
available when the selected calendars contain schedules not visible in the current view. Clicking 
an available tab either advances the view to display the next schedule or goes backwards to the 
previous schedule.
When multi-resource view is selected, a navigation toolbar displays for working with schedules. 
The toolbar provides navigating, scrolling, and increasing/decreasing the number of visible 
resources.
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① Goes back one page
② Sliding scroll bar
③ Goes forward one page
④ First 
⑤ Previous Page
⑥ Previous
⑦ Next
⑧ Next Page
⑨ Last
⑩ Increase visible resources count
⑪ Decrease visible resources count

5.3.2.7 Status bar
The status bar displays the current user logged in to use the Calendar Options Editor and 
indicates whether the server is running or not running. The status bar also displays the server 
name and computer name where the WinCC project is connected.     

5.3.2.8 "Agenda" list

Introduction   
The "Agenda" list is opened from the data window in the Calendar Options Editor.
When a date or time slot contains more schedules than what displays in the calendar view, an 
arrow displays on the date or time slot. Clicking the arrow opens the "Agenda" list to display the 
additional schedules that are not visible on that date or time slot.
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Usage
In the "Agenda" list, you can:
• Double-click a schedule to display its configuration in the editor.
• Click a column heading to sort the schedules in ascending or descending order by start time, 

end time, or description.

5.3.3 Opening the Action Schedule Editor

Introduction   
The Action Schedule Editor is used to create, rename, modify, and delete action schedules. This 
editor lets you set the start and end time for selected actions to execute.

Procedure
You can open the Action Schedule Editor in the following ways:
• From the toolbar, click .
• From the menu bar, select "Edit > Action Schedules".
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• In the data window:
– Double-click a date or time slot.
– Right-click a date or time slot and choose "New Action Schedule".
– Double-click an action schedule.
– Right-click an action schedule and choose "Open". For all occurrences in a recurring 

schedule, right-click and choose "Edit Series".
Note
If other schedule types are available, the action schedule preference must be selected as 
the default schedule type for this editor to open when double-clicking a date or time slot. 
To set the preference, click "View > Preferences > Default Schedule Type > Action".

• From the "Agenda" list, double-click an action schedule.

Results
When the Action Schedule Editor is opened from the toolbar or menu bar, a default 
unconfigured action schedule displays. Opening a configured action schedule displays its 
configuration.
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5.3.4 Opening the Action Editor

Introduction   
The Action Editor is used to create, rename, modify, or delete tag and script actions to execute 
in an action schedule.

Procedure
You can open the Action Editor in the following ways:
• From the toolbar, click .
• From the menu bar, select "Edit > Actions".
• Click the "Add New" button in the Action Schedule Editor.
• Right-click in an actions area in the Action Schedule Editor and choose "New".

Results
When the Action Editor is opened, a default unconfigured action displays. Selecting an action 
displays its configuration.
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5.3.5 Opening the Calendar List Editor

Introduction   
The Calendar List Editor is used to create, rename, and delete calendars. This editor lets you 
choose a color to identify a calendar and its associated schedules. Depending on the installed 
Calendar Options, a schedule can be an action schedule or notification schedule.

Procedure
You can open the Calendar List Editor in the following ways:
• From the toolbar, click .
• From the menu bar, select "Edit > Calendars".

Results
The Calendar List Editor opens with a default calendar and color displaying.

5.3.6 Changing the configuration language

Introduction       
You can change the configuration language in which a calendar displays by selecting a language 
from a list. The languages available for Calendar Options are those installed with WinCC except 
ASIAN languages.

Procedure
1. In the Calendar Options Editor, click "Tools > Language".
2. Select the language from the list and click "OK".

The Calendar Options Editor and WinCC configuration language change to the selected 
language.

WinCC/Calendar Scheduler Documentation
5.3 Working with Calendar Scheduler

WinCC/Calendar Options
System Manual, 11/2020, A5E49472488-AA 69



5.3.7 Field descriptions

5.3.7.1 Calendar List Editor
In the Calendar List Editor, you create, rename, and delete calendars. You can specify a color to 
quickly identify a calendar and its associated schedules. Depending on the installed Calendar 
Options, a schedule can be an action schedule or notification schedule.   

Field Description
Name A unique, descriptive name for the calendar that represents a grouping of 

schedules.
Selecting the arrow next to this field displays a list of calendar names created 
in the opened WinCC project. You create a calendar by clicking "New", en‐
tering a unique name in this field, and clicking "OK".

Locale button Opens the Locale Editor so you can specify translated text to represent the 
calendar name. 
Calendars not configured with translated text will display in the language 
configured for the Calendar Option.
This button displays only for configured calendars. Clicking "Apply" while 
creating a calendar saves the name and displays this button.

Color picker Opens the color palette so you can select a color to associate with a calendar 
name and its schedules.

New Clears the visible configuration in the editor and displays a default calendar 
name.

Delete Deletes the selected calendar name and its associated schedules permanent‐
ly. You must confirm a calendar deletion.

OK Saves the configuration and closes the editor.
Apply Saves the configuration and keeps the editor open.
Cancel Exits the editor without saving any modifications.

5.3.7.2 Action Schedule Editor
In the Action Schedule Editor, you define the general properties for an action schedule.   

Field Description
Name A descriptive name for the schedule. When this editor is opened initially, a 

default name displays. Although you can keep the default name, it is rec‐
ommended that you rename the schedule for easy recognition.

Description Information that describes the schedule.
Start Time The date and time you want the schedule's start actions to execute. You can 

enter the date and time or use the arrows. Clicking the date arrow opens a 
pop-up calendar so you can choose the date. 

End Time The date and time you want the schedule's end actions to execute. You can 
enter the date and time or use the arrows. Clicking the date arrow opens a 
pop-up calendar so you can choose the date.

Start Actions A list of actions to perform at the specified start time for the associated 
schedule. An action schedule references one or more actions.

WinCC/Calendar Scheduler Documentation
5.3 Working with Calendar Scheduler

WinCC/Calendar Options
70 System Manual, 11/2020, A5E49472488-AA



Field Description
End Actions A list of actions to perform at the specified end time for the associated 

schedule. An end action is not required.
Select Opens the "Actions" list that contains configured actions so you can quickly 

choose the actions to execute in the schedule.
You can select the check box next to an action group to select all actions in 
a group. A black check mark displays in the check box. Expanding an action 
group and selecting individual actions displays a black check mark for the 
action and a gray check mark for the action group.

Add New Opens the Action Editor so you can configure a new action to attach to the 
schedule. After the action is created, it displays in the respective "Start Ac‐
tions" or "End Actions" area of the Action Schedule Editor. The action is also 
added to the "Actions" list and the "Resources" window.
This button is not visible in Runtime.

Execute on startup Enables the execution of actions if the following conditions occur:
• Executes start actions if the schedule becomes active at startup.

Execute on change Enables the execution of actions if the following conditions occur:
• Executes start actions if the schedule becomes active due to a date/time 

change.
• Executes end actions if the schedule becomes inactive due to a date/time 

change.
Calendar Selects the calendars where the schedule is to display. Clicking the arrow lets 

you choose one or more configured calendars.
Locale button Opens the Locale Editor so you can specify translated text to represent the 

schedule name. Names not configured with translated text will display in the 
language configured for the Calendar Option.
This button displays only for configured schedules. Clicking "Apply" while 
creating a schedule saves the name and displays this button.
This button is not visible in Runtime.

Recurrence Opens the "Recurrence" dialog so you can set the frequency and time period 
to repeat the schedule.

New Clears the visible configuration in the editor and displays the next available 
default schedule name.

Delete Deletes the schedule from the selected calendar. If recurrence is configured, 
you can delete the schedule on a specific date and time, without deleting the 
series.

OK Saves the configuration and closes the editor. 
Apply Saves the configuration and keeps the editor open.
Cancel Exits the editor without saving any modifications.

WinCC/Calendar Scheduler Documentation
5.3 Working with Calendar Scheduler

WinCC/Calendar Options
System Manual, 11/2020, A5E49472488-AA 71



5.3.7.3 "Recurrence" dialog
In the "Recurrence" dialog, you configure a schedule to repeat many times, so you will not need 
to create the schedule again and again. Depending on the installed Calendar Options, a schedule 
can be an action schedule or notification schedule.     

Field Description
Recurrence time The time period that the schedule is to start and end. 

When you select the start and end times, the duration is calculated auto‐
matically. If you change the duration, the end time changes to reflect the 
selected duration.

Recurrence pattern Defines the frequency that the schedule is to repeat. The options change 
based on the selected frequency:
• "Minutely"
• "Hourly"
• "Daily"
• "Weekly"
• "Monthly"
• "Yearly"
Example: To set a schedule to repeat every Friday, you would select "Weekly" 
and "Friday" and set "Recur every" to "1".

Range of recurrence Defines the date range that the recurrence pattern is to start and end.
The end date has the following options:
• "No end date"
• "End after": Specifies the number of occurrences. After you enter the 

number of occurrences, the "End by" date changes so you can see the end 
date of the range.

• "End by": Specifies a date. After you select a date from the pop-up calen‐
dar, the schedule's end time is added automatically.

Remove Recurrence Deletes the recurrence configuration from the schedule. All occurrences of 
the schedule except the initial configured instance are removed.

OK Saves the configuration and closes the dialog.
Cancel Exits the dialog without saving any modifications.
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5.3.7.4 Action Editor
In the Action Editor, you define the general properties for an action.   

Field Description
Name A unique, descriptive name to identify an action that can be associated with 

an action schedule. When this editor is opened initially, a default name dis‐
plays. Although you can keep the default name, it is recommended that you 
rename the action for easy recognition.
You can save the action in a group by entering the group name and action 
name in a path structure. Use the backslash "\" as a separator to form the 
groups. Example: "Plant1\Machine2\Machine2Start"

Locale button Opens the Locale Editor so you can specify translated text to represent the 
action name. Names not configured with translated text will display in the 
language configured for the Calendar Option.
This button displays only for configured schedules. Clicking "Apply" while 
creating a schedule saves the name and displays this button.

Color picker Opens the color palette so you can select a color to identify this action.
Subactions A list of tag and script actions grouped together to form one action. A sub‐

action can be a tag action that sets a specific value or a script action that 
executes C-scripts. An action must have at least one configured subaction.

Add Tags Creates a subaction by opening the "Tag Selection" dialog so you can choose 
the desired tags to execute. The selected tags are appended to the list of 
subactions.

Add Scripts Creates a subaction by opening a list of scripts so you can choose the desired 
C-scripts to execute. The selected scripts are appended to the list of subac‐
tions.

Test Executes the subactions in the selected action. 
Authorization Opens a list of authorizations so you can set a user restriction on the use of 

the action. The selected authorization displays next to the "Authorization" 
button. The default authorization is "<No access-protection>".

Enable Messaging Enables the logging of messages to the WinCC messaging system anytime 
this action is executed.

New Clears the visible configuration in the editor and displays the next available 
default action name. 

Delete Deletes the selected action. If the action is used in a schedule, a message 
displays stating you cannot delete the action.

OK Saves the configuration and closes the editor.
Apply Saves the configuration and keeps the editor open.
Cancel Exits the editor without saving any modifications.
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5.3.7.5 Locale Editor
In the Locale Editor, you specify text to represent the translated name for a schedule or resource. 
Depending on the installed Calendar Options, a schedule can be an action schedule or 
notification schedule. A resource can be an action, notification, contact group, or calendar.   

Field Description
Language Displays a list of languages installed in WinCC.
Name The translated text to represent the selected schedule or resource name for 

a particular language. The translated names will display in Runtime. Names 
not configured with translated text will display in the language configured for 
the Calendar Option.

OK Saves the configuration and closes the editor. 
Cancel Exits the editor without saving any modifications.

5.4 Configuration

5.4.1 Configuring action schedules

5.4.1.1 Creating a calendar

Introduction     
You create calendars to allow subsets of schedules to display in Runtime. The Calendar Options 
contain a default calendar. The Calendar List Editor lets you create additional calendars and 
manage the list of calendars.
When creating a calendar, you choose a color for easy identification of the calendar and its 
schedules.

Procedure
1. Select "Edit > Calendars" to open the Calendar List Editor.
2. Click "New".
3. Replace the default name with a unique name for the calendar.
4. Click the color picker arrow and select a color to associate with this calendar and its schedules.
5. To specify translated text (Page 82), click "Apply" and then click the "Locale" button. Enter 

the translated text for the calendar name in each language and click "OK".
6. Click "OK".

The calendar is added and sorted alphabetically in the "Resources" window. The calendar can 
be selected in the schedule editor.
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5.4.1.2 Creating an action schedule

Introduction     
You create action schedules to set the time to execute actions. You create the schedules using 
the Action Schedule Editor by selecting actions from a preconfigured list or by configuring new 
actions.

Procedure
1. Double-click a date or time slot in the data window to open the Action Schedule Editor.

Note
If other schedule types are available, the action schedule preference must be selected as the 
default schedule type for this editor to open when double-clicking a date or time slot. To set 
the preference, click "View > Preferences > Default Schedule Type > Action".

2. In the "Name" field, enter a name for the action schedule.
3. Optionally, enter information to describe the schedule in the "Description" field.
4. Under "Start Time", set the time you want the schedule to start on the selected date.
5. Under "Start Actions", choose the actions you want to execute at the selected start time:

– To choose from a list of preconfigured actions, click "Select". Select the actions (Page 84) 
and click "OK".

– To configure a new action, click "Add New". The Action Editor opens for you to configure 
a new action (Page 77) to attach to this schedule.

6. Under "End Time", set the date and time you want the schedule to stop.
7. Under "End Actions", use "Select" or "Add New" to choose the actions to execute at the 

selected end time.
Note
An end action is not required.

8. To change the execution order of the actions, click a row to highlight it. Drag the action to the 
desired location. A red line appears at the point where the action will move.
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9. Click the "Calendar" arrow and select the calendars where the schedule is to display. Click 
outside the list.
Note
Clicking  closes the list without saving the selections made.
If you do not select a calendar, the schedule is associated with the "Default" calendar.

10.Choose whether to execute the schedule due to a startup/shutdown or a date/time change:
– Select "Execute on startup" to enable the execution of start actions if the schedule 

becomes active at startup.
– Select "Execute on change" to enable the execution of start actions if the schedule 

becomes active due to a date/time change or the execution of end actions if the schedule 
becomes inactive due to a date/time change.

11.To configure the schedule to repeat, click "Recurrence". Set the desired recurrence pattern 
and time (Page 80) and click "OK".

12.To specify translated text (Page 82), click "Apply" and then click the "Locale" button. Enter 
the translated text for the schedule name in each language and click "OK".

13.After you finish configuring the action schedule, click "OK".

Results 
The action schedule displays in the selected calendars at the specified times. The color of a 
schedule is the same as its associated calendar. The way the schedule color (Page 103) displays 
depends on the selection of multiple calendars in the "Resources" window and a multi-resource 
view.
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An arrow displays in the date or time slot when it contains schedules that are not visible. Clicking 
the arrow displays the additional schedules in the "Agenda" list.

5.4.1.3 Creating an action

Introduction                   
The Calendar Scheduler Server executes the actions associated with an action schedule at the 
specified time. You create actions and subactions to associate with schedules using the Action 
Editor during configuration. You must configure at least one subaction for each action. A 
subaction can be a tag action that sets a specific value or a script action that executes C-scripts.
If the project will contain several actions, you can create action groups to achieve a structured 
sorting of the actions. An action group is created when you enter a name for an action.
To prevent unauthorized use of an action in Runtime, you can set a user authorization on the 
action. After an action is configured, it appears in the "Actions" list so that you can use the action 
again for creating schedules quickly.

Procedure
1. Select "Edit > Actions" to open the Action Editor.

Note
While creating or modifying a schedule, you can click "Add New" to open the Action Editor 
and configure a new action to attach to the schedule.

2. In the "Name" field, replace the default name with a descriptive name for this action.
If you want to create the action in a group, enter the group name and action name in a path 
structure (Page 79). Use the backslash "\" as a separator to form the groups, for example: 
"Plant1\Machine2\Machine2Start".
Although you can keep the default name, it is recommended that you rename the action for 
easy recognition.

3. Click the color picker arrow and select a color to associate with this action.
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4. Configure tag subactions to associate with this action:
– Click "Add Tags".
– In the "Tag Selection" dialog, select the tags to attach to the action and click "OK".

The tags are added as subactions in the Action Editor. Information about tags is in the 
WinCC Information System under "Working with Tags".

– In the Action Editor, click in the "Value" field for each subaction, and enter the value that 
the action is to set.

5. Choose the C-script subactions to associate with this action if desired:
– Click "Add Scripts".
– In the "Scripts" list, select the scripts to attach to the action and click "OK".

The scripts are added as subactions in the Action Editor. Information about scripting is in 
the WinCC Information System under "Working with WinCC > ANSI-C for Creating 
Functions and Actions".

6. To change the execution order of the subactions, click a subaction's row to highlight it. Drag 
the subaction to the desired location. A red line appears at the point where the subaction will 
move.

7. To permit only authorized users to create schedules using this action, click "Authorization". 
Choose an authorization that was defined in the User Administrator and click "OK".
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8. To log messages (Page 85) to the WinCC messaging system anytime this action is executed, 
select the "Enable Messaging" check box.

9. To specify translated text (Page 82) , click "Apply" and then click the "Locale" button. Enter 
the translated text for the action name in each language and click "OK".

10.Save the configuration.

Results
The new action is added to the "Actions" list for use in configuring schedules. The notification is 
also added and sorted alphabetically in the "Resources" window.

If the action was created while configuring a schedule, the action is added to the start or end 
actions area in the Action Schedule Editor.

5.4.1.4 Creating action groups

Introduction     
Action groups allow you to achieve a structured sorting of the actions. You create an action 
group when you enter an action name in the Action Editor.
You can move a non-grouped action to a group or move a grouped action to a different path. 
Actions can have the same name in different groups.
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Entering action group names
• Non-grouped actions:

Enter the name in the "group name\action name" path structure. Use the backslash "\" as a 
separator to form the groups.
Example: Move the action named "Machine2Start" to "Plant1\Machine2\Machine2Start".

• Grouped actions:
Select the action and enter the path were you want to move the action.

Selecting actions and action groups
In the Action Editor,  represents an action group and  represents an action.
• Selecting a grouped action and clicking "New" lets you create an action in the same group.
• Selecting an action group and clicking "New" lets you create an action in this group.
An action group displays in the "Resources" window and the "Actions" list according to the 
specified path structure.
Selecting an action group from the "Actions" list when creating a schedule adds all actions in the 
group to the schedule.

5.4.1.5 Configuring a recurring schedule

Introduction       
A recurring schedule is one schedule configured to repeat multiple times. Rather than adding the 
same schedule to a calendar several times, you can configure one recurring schedule that 
appears in the calendar at the specified dates and times.

WinCC/Calendar Scheduler Documentation
5.4 Configuration

WinCC/Calendar Options
80 System Manual, 11/2020, A5E49472488-AA



Procedure
1. Create a new schedule or double-click a schedule to display its configuration.
2. In the editor, click "Recurrence" to open the "Recurrence" dialog.

3. Under "Recurrence time", set the time the schedule is to start and end.
This step is not necessary if you are adding a recurrence to a schedule where the time remains 
the same.

4. Under "Recurrence pattern", choose the frequency the schedule is to repeat.
You can set the schedule to repeat by the minute, hour, day, week, month, or year. Different 
options display based on the frequency you choose.
Example: To set a schedule to repeat every Friday, you would select "Weekly" and "Friday" and 
set "Recur every" to "1".
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5. Under "Range of recurrence", select when you want the recurrence pattern to start and end:
– The recurrence has no end.
– The recurrence is to end after a specified number of occurrences.
– The recurrence is to end at a specified date.

6. After you finish configuring the recurrence, click "OK".
The schedule displays in the calendar at the times specified in the recurrence pattern. In 
Runtime, the recurrence symbol  displays to identify the schedule as recurring.

5.4.1.6 Adding translated text

Introduction           
You can specify text to represent the translated names of schedules and resources to display in 
Runtime. Names not configured with translated text will display in the language configured for 
the Calendar Option. Depending on the installed Calendar Options, a schedule can be an action 
schedule or notification schedule. A resource can be an action, notification, contact group, or 
calendar.

Procedure
1. Open the appropriate editor and display the configuration for a schedule or resource.
2. Click the "Locale" button  to open the Locale Editor.

The languages configured with the WinCC project display. You can make more languages 
available by opening the "Text Library" editor and selecting "Language > Add/Remove". 
Information about the text library is in the WinCC Information System under "Setting Up 
Multilingual Projects".
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3. For each displayed language, click in the "Name" field and enter the translated text to display 
for the name.

4. Click "OK".
5. Save the configuration.

5.4.1.7 Setting user authorizations

Introduction
The management of the user rights for the Calendar Options takes place in the WinCC User 
Administrator. Users are assigned various authorizations in it for operating and monitoring 
purposes.
The tasks of the WinCC User Administrator include:
• Creation and editing of users and user groups.
• Assignment and administration of access rights known as authorizations.
After users are configured in the User Administrator, you will need to assign authorizations to 
them. You can create authorizations for frequently used calendar scheduling functions.

Configuring user administration     
1. If desired, create authorizations for frequently used calendar scheduling functions in the 

User Administrator.
Example authorizations are "Production Line 1 Manager" and "Calendar Editing". Information 
about user administration is in the WinCC Information System under "Working with WinCC > 
Structure of the User Administration".

2. Create groups and users and assign the appropriate authorizations.

Setting authorizations on resources     
You can set an authorization on a resource to permit only authorized operators to create 
schedules using this resource. When operators attempt to select a resource they are not 
authorized to use, they receive the "Insufficient permission" message. When operators attempt 
to modify a schedule that contains at least one unauthorized resource, the schedule remains at 
its preconfigured date and time.
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Depending on the installed Calendar Options, a resource can be an action, notification, or 
contact.

Note
Operators can select a resource that is not assigned an authorization. To prevent unauthorized 
operators from creating or modifying any schedules, set an authorization on all resources.

1. In the editor, select the name of the resource to display its configuration.
2. Click "Authorization".
3. Choose an authorization that was defined in the User Administrator and click "OK".
4. Save the configuration.

5.4.1.8 Selecting multiple actions, scripts, and tags

Introduction   
In some editors, dialogs, and lists, you can select a range or multiple actions, subactions, tags, 
or scripts.
Information about tags is in the WinCC Information System under "Working with Tags". 
Information about scripting is in the WinCC Information System under "Working with WinCC > 
ANSI-C for Creating Functions and Actions".

Action Schedule Editor and Action Editor 
To select a range of actions:
Click a row to highlight it. Press <Shift> while clicking another row. All actions between the two 
rows that you clicked are selected.
To select multiple actions:
Click a row to highlight it. Press <Ctrl> while clicking additional rows. All actions that you clicked 
are selected.

Note
In the Action Schedule Editor, the actions associated with the schedule display under "Start 
Actions" and "End Actions". In the Action Editor, the group of tag and C-script actions that form 
the action display under "Subactions".

"Tag Selection" dialog   
To select a range of tags:
Click a tag to highlight it. Press <Shift> while clicking another tag. All tags between the two tags 
that you clicked are selected.
To select multiple tags:
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Click a tag to highlight it. Press <Ctrl> while clicking additional tags. All tags that you clicked are 
selected.

"Actions" list
To select all actions in a group:
Select the check box next to an action group. A black check mark displays in the check box. 
Expand the action group to see all actions selected.
To select individual actions:
Expand an action group and select the desired actions. A black check mark displays next to the 
selected actions. The check mark for the group appears gray.

"Scripts" list     
To select a range of scripts, use these ways:
• Drag over the scripts you want selected.
• Click a script to highlight it. Press <Shift> while clicking another script. All scripts between the 

two scripts that you clicked are selected.
To select multiple scripts:
Click a script to highlight it. Press <Ctrl> while clicking additional scripts. All scripts that you 
clicked are selected.

5.4.1.9 Logging schedule messages

Introduction     
The Calendar Scheduler supports the logging of schedule messages in the WinCC message 
system. Logging occurs only for the schedules that reference an action configured with the 
"Enable Messaging" capability. The Calendar Scheduler Server generates a message each time 
the action schedule is executed during Runtime.
The WinCC message system records the messages from the Calendar Scheduler Server and 
writes them in chronological order to the message log. The messages can be viewed in various 
message lists in the message window. The message lists contain a selection of all messages in 
the log. The schedule messages display in the color configured for a calendar.

Single message configuration
The Calendar Scheduler automatically creates a single message in WinCC Alarm Logging. The 
single message contains the following parameters that you can set:

Class: System, without acknowledgment
Type: Process control system
Message text: CALSCH:@103%s@
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Info Text: Calendar Scheduler
This message: will be archived

Detailed information about messaging is in the WinCC Information System under "Setting Up a 
Messaging System > Configuring the Message System > Working with Single Messages".

5.4.2 Modifying action schedules

5.4.2.1 Adding actions and subactions

Introduction
An action can contain tag actions and C-script actions. You can add tag and script actions as 
subactions to an action. You can also change the execution order. Any modifications to an action 
take effect immediately to all schedules that reference the modified action.

Adding actions to a schedule   
1. Double-click an action schedule to display its configuration in the editor.

If the schedule is configured with a recurrence, right-click the schedule and choose "Edit 
Series". For information, see editing the recurrence series (Page 91).

2. Click "Select". In the list, select the preconfigured actions to associate with this schedule and 
click "OK".
Note
You can configure a new action to attach to this schedule by clicking the "Add New" button.

3. Save the configuration.

Adding tag subactions     
1. In the Action Editor, select an action to display its configuration.
2. Click "Add Tags". In the "Tag Selection" dialog, select the tags to attach to the action and click 

"OK".
The tags are added as subactions.
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3. Click in the "Value" field for each subaction added and enter the tag value.

4. Save the configuration.
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Adding script subactions     
1. In the Action Editor, select an action to display its configuration.
2. Click "Add Scripts". In the "Scripts" list, select the C-scripts to attach to the action and click 

"OK".
The scripts are added as subactions.

3. Save the configuration.

Changing execution order     
1. Click an action's or subaction's row to highlight it.
2. Drag the action or subaction to the desired location. A red line appears at the point where the 

action or subaction will move.
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5.4.2.2 Renaming schedules and resources

Introduction
You can rename schedules and resources. You can quickly rename a schedule from a calendar 
view in the data window. The editors let you rename and make additional changes to the 
schedules and resources.
Depending on the installed Calendar Options, a schedule can be an action schedule or 
notification schedule. A resource can be an action, notification, or calendar.

Note
You cannot rename the "Default" calendar.

Renaming a resource   
1. In the appropriate editor, select the resource you want to rename.
2. Enter a new name.
3. If the previous resource name contained translated text, click the "Locale" button. Change the 

entries to reflect the new translated names and click "OK".
4. Save the configuration.

The new name appears in the list of preconfigured resources, the "Resources" window, and 
the schedules that reference it.

Renaming a schedule   
From calendar view in the data window
1. Click the schedule to highlight it and then click again.
2. Enter a new name.

If this schedule is in a recurrence series, the name changes only for the selected date. The 
name and time of other occurrences in the series do not change.

From the editor
1. Double-click the schedule. Optionally, right-click the schedule and choose "Open".
2. In the editor, enter a name and click "OK".

If this schedule is in a recurrence series, the name changes only for the selected date. The 
name of other occurrences in the series does not change.

Renaming a recurring schedule   
1. Right-click a schedule configured with a recurrence and choose "Edit Series".
2. In the editor, enter a name and click "OK".

The name changes for all occurrences of the schedule.
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5.4.2.3 Changing schedule dates

Introduction   
Schedules are labeled in the calendars according to the start and end time. You can quickly 
change a schedule by dragging it to the desired date and time in a calendar view. You can also 
drag the schedule to a date in the "Date Navigation" window. The day and work week views allow 
you to quickly change the duration of a schedule. The editor lets you change the date and time 
and make additional changes.

Dragging and dropping schedules     
In the displayed calendar view
Day: Drag the schedule to the desired time slot on the same day.

The schedule moves to the selected time. The configured duration 
remains the same. Depending on the selected time, the schedule 
may extend into another day.

Work Week: • Drag the schedule to the desired time slot on the same day. The 
schedule moves to the selected time.

• Drag the schedule to another displayed day and time slot. The 
schedule moves to the selected day and time slot.

The configured duration remains the same. Depending on the selec‐
ted time, the schedule may extend into another day.

Week, Month, or Timeline: Drag the schedule to another day in the displayed view.
The schedule moves to the selected date. The configured time and 
duration remain the same.

To the "Date Navigation" window
From any calendar view, drag the schedule to a date in the "Date Navigation" window. The 
schedule moves to the selected date. The configured time and duration remain the same.

Changing the duration   
1. Select a schedule in the day or week view.
2. Move the mouse arrow over the start or end border until the arrow changes to a vertical 

arrow.
3. Drag the border to the desired time and then release.

Changing dates in the editor   
1. Display the configuration for a schedule or recurring schedule in the editor.
2. Under "Start Time" and "End Time", set the time the schedule is to start and end.
3. Click "OK".

The schedule moves in the selected calendars to the modified date and time.
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5.4.2.4 Changing a schedule and resource color

Introduction
You can change the color defined for a schedule or resource. You can also delete a schedule from 
a calendar and add it to another calendar. The way the schedule or resource color (Page 103) 
displays depends on the selections in the "Resources" window and the selected calendar view 
and multi-resource view. Depending on the installed Calendar Options, a schedule can be an 
action schedule or notification schedule. A resource can be an action, notification, contact, 
contact group, or calendar.

Changing a resource color   
1. In the appropriate editor, select the resource name whose color you want to change.
2. Click the color picker arrow and choose a color.
3. Click "OK".

The color changes everywhere the selected resource name is used. If a calendar color is 
changed, the color changes for all schedules in that calendar.

Changing a schedule to a different calendar     
1. Display the configuration for a schedule or recurring schedule in the editor.

Note
For a recurring schedule, you must edit the series. You cannot set an occurrence of the 
schedule in different calendars.

2. Click the "Calendar" arrow and choose the calendars:
– Click a previously selected calendar to remove the schedule from that calendar.
– Select the calendars where the schedule is to display. Click outside the list.

Note
Clicking  closes the list without saving the selections made.

3. Save the configuration.
The schedule displays in the selected calendars. The schedule color changes to match the 
color of each associated calendar.

5.4.2.5 Modifying or restoring a recurring schedule

Introduction   
Modifying occurrences in a recurring schedule provides time-saving ways of working with 
schedules. You can override a schedule for a particular day, without changing the initial 
configured time of the recurring schedule. For example, you might want the schedule to start 
and end at a different time on one day.
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You can make changes to all occurrences in the recurring schedule or change an occurrence for a 
specific day. In case you want to revert a recurring schedule to its initial configuration, you can 
remove all overrides.

Editing the recurrence series   
1. Right-click a schedule configured with a recurrence and choose "Edit Series".
2. Make the desired changes.
3. Click "Recurrence" to edit the recurrence pattern and time (Page 72) in the "Recurrence" 

dialog. Click "OK".
4. When the confirmation message to remove the exceptions associated with this recurring 

schedule displays, click "Yes".
Any overrides made previously to this recurring schedule will be removed.

5. Click "OK" to save the configuration.
The modifications take effect immediately for all occurrences of the schedule.

Note
Modifying an instance of a recurring schedule
The "Recurrence" button is disabled if the user opens a single instance of a recurring schedule as 
the modification applies only to that instance.

Overriding a recurrence series   
1. Double-click the schedule on the date you want to change. Optionally, right-click the 

schedule and choose "Open".
2. Make the desired changes.
3. Click "OK".

The modifications take effect immediately only for the selected date and do not change the 
other occurrences in the series.
Note
You can quickly override a date and time by dragging the schedule to the desired date.

Restoring a recurring schedule     
Restoring one override
Right-click an occurrence of the schedule that contains an override and choose "Restore Default 
State". Only this occurrence of the schedule changes to the initial configured state of the 
recurring schedule.

Restoring all overrides
1. Right-click any occurrence in the recurring schedule and choose "Edit Series".
2. In the editor, click "Recurrence".
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3. In the "Recurrence" dialog, click "OK" without making any changes.
4. Click "Yes" when the confirmation message displays. Click "OK" to close the editor.

All modified and deleted occurrences are returned to the initial configured state of the 
recurring schedule. All occurrences of this schedule now have the same settings.

Removing a recurrence   
1. Right-click any occurrence in the recurring schedule and choose "Edit Series".
2. In the editor, click "Recurrence".
3. In the "Recurrence" dialog, click "Remove Recurrence".
4. Click "OK" to close the editor.

All occurrences except the initial configured instance of the schedule are removed.
Note
Rather than removing a recurring schedule, you may want to change the "End by" time so you 
can keep a record of past occurrences.

5.4.2.6 Deleting actions and subactions

Introduction   
You can delete actions and subactions. Deleting an action from a schedule does not remove its 
configuration from the calendars. The action remains available in the "Actions" list for 
configuring other schedules.
Deleting an action from the Action Editor removes its configuration completely from the 
calendars and the "Actions" list. You cannot delete an action if it is used in a schedule.

Prerequisite
Before you can delete all occurrences of an action, you must delete the action from all schedules.
You can use the "Resources" window to find these schedules.
Example: To display all schedules that reference the action "Machine2Start", select only 
"Machine2Start" in the "Resources" window. The check box next to the other resource groups 
should not be selected.
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Deleting an action from a schedule   
1. Double-click an action schedule to display its configuration in the editor.

If the schedule is configured with a recurrence and you want to delete the action from the 
series, right-click the schedule and choose "Edit Series".

2. Choose which actions to delete:
– To delete one or multiple actions:

Select the desired rows in the start or end actions area. Right-click and choose "Delete".
– To delete all actions:

Right-click anywhere in the start or end actions area and choose "Clear".
3. Save the configuration.

Deleting an action configuration     
1. In the Action Editor, select the action to delete.
2. Click "Delete".

The action and its associated subactions are deleted from the "Actions" list and the 
"Resources" window. The action is no longer available for configuring schedules.

Deleting subactions     
1. In the Action Editor, select the desired action rows.
2. Right-click and choose "Delete".

The selected subactions are deleted only from this action. You must have at least one 
subaction configured for the action.

5.4.2.7 Deleting schedules and calendars

Introduction     
You can delete schedules and calendars. Deleting a schedule removes the schedule and its 
associated resources from the selected calendars. The resources are not removed from the 
selection lists and are available for configuring other schedules. Depending on the installed 
Calendar Options, a resource can be an action, notification, contact, or contact group.
You can override a recurrence series by deleting a schedule on the date you do not want it to 
execute. This override does not change the default configuration of the recurring schedule.
Deleting a calendar removes the entire calendar and its associated schedules. A schedule 
referenced in the deleted calendar is removed, but remains in the other calendars.
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Deleting a schedule from the calendar view 
1. Right-click the schedule and choose "Delete". Optionally, click the schedule and press 

<Delete>.
2. If the schedule is in a recurrence series, a message displays asking if you want to delete all 

occurrences or only the occurrence of the selected day and time. Choose what to delete and 
click "OK".
Deleting the selected occurrence is an override to the schedule and does not affect the other 
occurrences in the series. Deleting the series deletes all occurrences of the schedule.

Deleting a schedule from the editor
1. Double-click a schedule to display its configuration in the editor.
2. To delete a schedule from a calendar, click the "Calendar" arrow and unselect the calendar. 

Click "OK".
3. To delete a schedule from all selected calendars, click "Delete".

If the schedule is in a recurrence series, only the occurrence for the selected day and time is 
deleted.

Deleting a recurring schedule from the editor   
1. Right-click a schedule and choose "Edit Series".
2. In the editor, click "Delete".

All occurrences of the schedule are deleted.
Note
Rather than deleting a recurring schedule series, you may want to modify the schedule and 
change the "End by" time in the "Recurrence" dialog so you can keep a record of past 
occurrences.

Deleting a calendar     
1. In the Calendar List Editor, select the calendar name to delete.

You cannot delete the "Default" calendar.
2. Click "Delete". When the confirmation message to delete this calendar and its associated 

schedules appears, click "OK".
The entire calendar and all schedules associated with this calendar are deleted permanently. 
The calendar name is removed from the "Resources" window in the Calendar Options Editor.
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5.4.3 Configuring the Calendar Control

5.4.3.1 Calendar Control
The Calendar Control is a .NET control that can be inserted into WinCC pictures using the WinCC 
Graphics Designer. The control in WinCC pictures at Runtime allows operators to view calendars. 
The control allows an operator to create, edit, and delete schedules.   
You can configure this control to display the schedules of one or more configured calendars. 
View options provide single or multiple months, weeks, or days in a single view of the schedules. 
Additionally, you can configure a multi-resource view to show the schedules of multiple 
resources at the same time. Each date area in a multi-resource view displays the schedules 
associated with the selected resource.
The values assigned to the attributes of the control's object properties determine how the 
calendar displays to the operators in Runtime. You can set properties for the opening calendar 
view, work shift view, and navigation capabilities. In addition to providing the means for 
displaying and editing the schedules, the control's intrinsic events can be configured to trigger 
tag and C-script actions. 

5.4.3.2 Configuring the Calendar Contol

Introduction     
You insert the Calendar Control into WinCC pictures and configure the control to display the 
schedules associated with a calendar. You can customize the opening view and set properties to 
prevent or allow operators to use functions of the Calendar Control.

Procedure
1. In the Graphics Designer, either create a new picture or open a picture where you want to 

insert a calendar.
2. In the Object Palette, click the "Controls" tab. Under ".NET controls", click 

"WinCC_Calendar.Calendar" and drag the control to the desired size in the picture.
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3. Double-click the control. Click "Control properties" and set the attributes:
– To configure how you want the calendar to display, set the appearance attributes 

(Page 98) of the object properties.

– To prevent or allow operators to use functions of the Calendar Control, set the navigation 
and usage attributes (Page 99) of the object properties.

4. Save the picture.
You can click the "Activate" button on the toolbar to see the appearance of the Calendar 
Control in Runtime.
This figure shows the Calendar Control configured to display schedules in the day calendar 
view.
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5.4.3.3 Changing appearance of the Calendar Control

Introduction
You can set the properties in the WinCC Calendar Control to customize the opening view of a 
calendar in a particular WinCC picture. Additional pictures can contain calendars set to open 
with different views. You can set the properties for these pictures to restrict the view and 
scheduling to specific areas of a process, equipment, or personnel.

Prerequisite
• You opened the Graphics Designer and configured a picture with the Calendar Control.
• The object properties dialog of the Calendar Control is open.

Setting the opening calendar view   
Double-click "ActiveViewType". Choose the standard calendar view to display when the calendar 
is opened: "Day", "Week", "Month", "WorkWeek", or "Timeline".
If you want a multi-resource view to display, double-click "GroupType" and choose "Date" or 
"Resource".
The control changes to reflect the selection.

Setting the default selected calendar   
Double-click "SelectedCalendar". Enter the calendar name exactly as it appears in the 
"Resources" window and click "OK".
In Runtime, only the specified calendar and its schedules display on initial opening.
An incorrect calendar name entry results in no calendar selected and no schedules displaying on 
initial opening. To have all calendars selected with schedules displaying, leave the attribute 
value blank.

Setting a work shift   
To set the start time:
Double-click "WorkStartTime". Enter the start time in 24-hour format (hours:minutes:seconds). 
Click "OK".
To set the end time:
Double-click "WorkEndTime". Enter the end time in 24-hour format (hours:minutes:seconds). 
Click "OK".
In Runtime, the control displays the specified time period in a different color than the 
background color.
To restrict the calendar view to display only the work shift time period:
Doublie-click "ShowWorkTimeOnly" to set the attribute to "True". Double-clicking toggles 
between "True" and "False". The work shift is visible in the day and work week calendar views.
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5.4.3.4 Changing navigation and usage of the Calendar Control

Introduction     
You can set the properties in the WinCC Calendar Control to customize the navigation 
capabilities in Runtime. You can set properties to prevent or allow operators to use functions of 
the Calendar Control.

Prerequisite
• You opened the Graphics Designer and configured a picture with the Calendar Control.
• The object properties dialog of the Calendar Control is open.

Preventing resources selection   
Double-click "ShowResources" to set the attribute to "False". Double-clicking toggles between 
"True" and "False".
When the attribute is "False", the control hides the "Resources" window. In Runtime, the operator 
cannot select and view other resources.

Preventing date navigation   
Double-click "ShowNavigation" to set the attribute to "False". Double-clicking toggles between 
"True" and "False".
When the attribute is "False", the control hides the date navigation window. In Runtime, the 
operator cannot select a date or date range to display future or previous schedules in the data 
window.

Preventing schedule editing   
Double-click "ViewOnly" to set the attribute to "True". Double-clicking toggles between "True" 
and "False".
When this attribute is "True", the control places the data window in view-only mode. In Runtime, 
the operator cannot create and edit schedules.

Restricting schedule editing to authorized operators   
Double-click "OperatorAuthorization". Select a predefined standard authorization in the WinCC 
User Administrator and click "OK". User-defined authorizations are not available for selection.
A logged in operator who is not assigned with the selected authorization can only view 
schedules. An operator with this authorization can create and edit schedules.
When this attribute is "NoAccessProtection", an authorization is not required. All operators can 
create and edit schedules using the actions, contacts, and notifications they are authorized to 
use.
Information about user administration is in the WinCC Information System under "Working with 
WinCC > Structure of the User Administration".
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5.4.3.5 Calendar Control object properties

Control properties     
The attributes in the Calendar Control object properties let you set how the calendar is to display 
in Runtime. You can customize the opening view and set properties to prevent or allow operators 
to use functions of the calendar control.

ActiveViewType
This attribute defines the default calendar view that displays when the Calendar Options Editor 
is opened. The schedules in the configured calendars display in the selected view in the data 
window. Double-clicking the attribute displays the following choices:

Day Displays a 24-hour day format.
Week Displays all 7 days of the week, beginning with Monday.
Month Displays in a monthly format, beginning with the week that contains the se‐

lected day or date range.
WorkWeek Displays a 5-day week, 24-hour day format. A work week contains Monday 

through Friday.
Timeline Displays in a timeline format. A timeline highlights 15 days and begins with the 

selected day or first day of a date range.
The default value is "Month".

DefaultScheduleType
This attribute defines the default schedule type to open when double-clicking a date or time slot 
in the Calendar Options Editor. Double-clicking the attribute displays the following choices:

Action Sets the Action Schedule Editor to open.
Notification Sets the Notification Schedule Editor to open.
The default value is "Action" if both Calendar Options are installed.

GroupType
This attribute defines whether to place the Calendar Control in a multi-resource view in addition 
to the standard calendar views. The way the grouping displays depends on the selected calendar 
view. Double-clicking the attribute displays the following choices:

None Grouping is off so that only the standard calendar view is visible.
Date Grouping is by dates displayed horizontally with the resources underneath 

displaying either horizontally or vertically.
Resource Grouping is by resources displayed horizontally with the dates underneath 

displaying either horizontally or vertically.
The default value is "None".
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OperatorAuthorization
This attribute defines whether to place the Calendar Control in view only mode for unauthorized 
operators. Double-clicking the attribute lets you select a predefined standard authorization in 
the WinCC User Administrator. User-defined authorizations are not available for selection.
A logged in operator who is not assigned with the selected authorization can only view 
schedules. An operator with this authorization can create and edit schedules.
Setting the attribute value to "NoAccessProtection" indicates no authorization is required. All 
operators can create and edit schedules using the actions, contacts, and notifications they are 
authorized to use.
The default value is "<No access protection>".

ProjectName
This attribute identifies the project name that is used to configure the Calendar Control for 
WebNavigator.
The default value is blank.

SelectedCalendar
This attribute defines whether to display the schedules of a specific calendar or all calendars 
when the Calendar Options Editor is opened initially in Runtime. Double-clicking the attribute 
opens a dialog for you to enter the calendar name exactly as it appears in the "Resources" 
window.
An incorrect calendar name entry results in no calendar selected and no schedules displaying on 
initial opening. 
The default value is blank.

ServerName
This attribute identifies the server that the Calendar Option is accessing. Double-clicking the 
attribute opens a dialog for you to connect to a different server name.
This attribute is useful in WinCC solutions where clients can be connected to multiple servers.
The default value is the server name where the WinCC project is connected.

ShowNavigation
This attribute defines whether to allow or prevent the operator's capability to use date navigation 
in the calendar. Double-clicking the attribute toggles between "True" and "False".
When this attribute is "False", the control hides the "Date Navigation" window. The operator 
cannot select a date or date range to display future or previous schedules in the data window.
The default value is "True".

WinCC/Calendar Scheduler Documentation
5.4 Configuration

WinCC/Calendar Options
System Manual, 11/2020, A5E49472488-AA 101



ShowResources
This attribute defines whether to allow or prevent the operator's capability to select resources. 
Double-clicking the attribute toggles between "True" and "False".
When this attribute is "False", the control hides the "Resources" window. The operator cannot 
select and view other resources.
The default value is "True".

ShowStatus
This attribute defines whether to display or hide the status bar. Double-clicking toggles between 
"True" and "False".
When this attribute is "True", the operator can see the status bar.
The default value is "False".

ShowWorkTimeOnly
This attribute defines whether to restrict the day and work week calendar views to the time 
frame specified in the "WorkStartTime" and "WorkEndTime" attributes. Double-clicking the 
attribute toggles between "True" and "False".
When this attribute is "True", the calendar view displays only the work shift time period. An 
operator can see only the schedules within the specified work shift.
When this attribute is "False", the calendar view displays all 24 hours and the schedules.
The default value is "False".

ViewOnly
This attribute defines whether to allow or prevent the operator's capability to create and edit 
events. Double-clicking the attribute toggles between "True" and "False".
When this attribute is "True", the control places the data window in view-only mode and prevents 
the operator from creating and editing schedules.
The default value is "False".

WorkStartTime
This attribute defines a time for a work schedule shift to start in the calendar. When set with the 
"WorkEndTime" attribute, the control displays the specified time period in a different color than 
the background color. Double-clicking the attribute opens a dialog for you to enter the start time 
in 24-hour format (hours:minutes:seconds).
The default value is "09:00:00".
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WorkEndTime
This attribute defines the time for a work schedule shift to end in the calendar. When set with the 
"WorkStartTime" attribute, the control displays the specified time period in a different color than 
the background color. Double-clicking the attribute opens a dialog for you to enter the end time 
in 24-hour format (hours:minutes:seconds).
The default value is "18:00:00".

5.5 Operation in Runtime

5.5.1 Calendar Scheduler in Runtime

Preconfigured schedules     
The Calendar Scheduler Server executes the preconfigured action schedules and any operator-
created action schedules at the specified times for a WinCC project. If action schedules are 
scheduled close together, the second schedule executes after the first schedule finishes. 
The preconfigured action schedules and the opening view of the calendar that operators see are 
determined during configuration. Any functions of the Calendar Control that an operator is 
allowed to use can be configured.

Schedules and resource colors
In standard calendar views, a schedule displays in the color of the associated calendar. If a 
schedule is associated with multiple calendars, the color of the schedule displays as one of the 
selected calendars. Typically, the color displays as the first selected calendar when the schedule 
was configured.
In multi-resource views (Page 106), the color configured for a selected resource displays as the 
background color for the resource in the data window. The schedule displays as a neutral color 
to complement the background color.
The following symbols may display on a schedule:

Displays during the start and end time of an active schedule.
Identifies a recurring schedule.
Indicates whether the start or end time of a schedule occurs from 0:00 to 11:59 (12:00 AM to 
11:59  AM). This symbol displays in the timeline view or when the schedule covers a range of days.
Indicates whether the start or end time of a schedule occurs from 12 to 23:59 (12:00 PM to 11:59 
PM). This symbol displays in the timeline view or when the schedule covers a range of days.

Scheduling capabilities
When configured to do so, an operator can create and modify action schedules and calendars 
depending on the assigned authorizations. Drag and drop allows quick editing of the schedules. 
Any changes that the operators make take effect immediately.
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Operators cannot create actions during Runtime. They can choose only from the authorized 
actions available in the "Actions" list. The actions are created during configuration.
If schedules are configured to execute on startup or change, operators must confirm the 
activation of a schedule that becomes active due to a date/time change or the deactivation of a 
schedule that becomes inactive.

5.5.2 Viewing schedules and resources

Introduction
The schedules in the configured calendars display when a picture that contains the Calendar 
Control is opened in Runtime. The Calendar Control is configured to display in a standard 
calendar view or a multi-resource view (Page 106).
If the "Resources" window is configured to display, operators can view or hide the schedules for 
a resource. The schedules associated with the selected resources display in the data window. 
Depending on the installed Calendar Options, a schedule can be an action schedule or 
notification schedule. A resource can be an action, notification, contact, or calendar.
If the "Date Navigation" window is configured to display, operators can view schedules for a 
selected day or a range of dates. The calendar view changes based on the selections made in the 
"Date Navigation" and data windows.

Viewing schedules for selected resources         
In the "Resources" window, select the resource names so that a check mark appears. The 
schedules for all selected resources are visible for the scheduled dates. The schedules for any 
calendars not selected are hidden.
When a date or time slot contains more schedules than what displays in the calendar view, an 
arrow displays on the date or time slot. Clicking the arrow opens the "Agenda" list to display the 
additional schedules that are not visible on that date or time slot. You can double-click a schedule 
in the list to display its configuration in the editor.

Navigating to schedules in "Date Navigation" window   
Selecting dates in the "Date Navigation" window displays the schedules for the selected dates in 
the data window. You can do the following tasks in the "Date Navigation" window to show dates:
• Click a day to show the selected day in the day view.
• Highlight a range of days to show the selected range in the month view. You can highlight 

the range by dragging over the desired days. You can also click a day and press <Shift> while 
clicking another day.

• Click a day and then press <Ctrl> while clicking additional days to show the selected days as 
a series of day views.

• Click the "Today" button to show schedules for the current day in the day view.
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Navigating to schedules in data window 
Right-clicking on a calendar view in the data window provides various ways to navigate to 
schedules. The resulting view depends on the selected day and date range of the current view.

"Go to Today" from menu
Click this option to display the current day or the work week, week, month, or timeline that 
contains the current day. In each resulting view, the current day is highlighted. On the timeline 
view, the current day is the first day in the timeline.

"Go to Date" from menu
Click this option to open a dialog to enter a specific date and to select the calendar view to 
display. You can choose the date from a pop-up calendar. The view changes to the specified view 
with the work start time highlighted on the specified date.

"Go to This Day" from menu
This option is available only on the month and week views and when one date is selected. If a 
range of days is selected, this option is gray and cannot be selected.
With a date selected in the view, click this option to display the selected date in day view. The 
work start time is highlighted.

"Time Scales" and "Time Scale Captions" from menu   
These options are available only on the timeline view. You can change the amount of time shown 
in the timeline and select which captions to display.
• Point to "Time Scales" and choose the increment of time to show in the timeline: "Year", 

"Quarter", "Month", "Week", "Day", "Hour", or "00:15:00". Selecting the same scale again 
switches between hiding and showing the scale.

• Point to "Time Scale Captions" and choose the caption for the time scale you want to see. 
Selecting the same caption again switches between hiding and showing the caption.

Hours and day range selection
You can select a range of hours or days in the applicable calendar views in the following ways:
• Drag over the desired hours or days in the view.
• Click an hour or day and then press <Shift> while clicking another hour or day.

"Next" and "Previous" tabs
The data window contains "Next" and "Previous" tabs. You can view the next or prior schedules 
in a calendar view.
• Click the "Next" tab to show the calendar view with the next schedules in the selected time 

span. For example, with the week view selected, clicking "Next" causes the current week view 
to change to the week containing schedules after the current week.

• Click the "Previous" tab to show the calendar view with the prior schedules in the selected 
time span.
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Changing the calendar view     
Standard view
Right-click in the data window. Select "Change View To" and choose a calendar view: "Day View", 
"Work Week View", "Week View", "Month View", or "Timeline View". The days highlighted in the 
resulting view depend on the day or range of days selected in the "Date Navigation" window.

Multi-resource view
Right-click in the data window. Select "Grouping" and choose a group type: "Date", "Resource", 
or "None". The way the grouping displays depends on the standard calendar view.

Changing the time ruler     
In the day or work week view, you can customize the ruler to display in a specific time zone. You 
can also change the time increment that displays.

Time zone
Right-click the time ruler and choose "Customize Time Ruler". In the "Time Ruler" dialog, enter a 
descriptive name in the "Label" field. Choose the desired time zone and select the check box to 
adjust the time when daylight saving time occurs. Click "OK".
The calendar control changes to reflect the specified label name and time zone.

Time increment
Right-click the time ruler and choose the increment of time in minutes to show in the ruler: "60, 
30, 15, 10, 6, 5". The ruler changes to reflect the selected increment.

Refreshing calendar data   
Right-click in the "Resources" window or "Date Navigation" window and choose "Refresh".

5.5.3 Multi-resource views

Introduction   
A multi-resource view allows operators to see schedules of multiple resources at the same time. 
A multi-resource view displays in addition to a standard calendar view. Multiple date areas are 
displayed vertically or horizontally. Each date area displays the schedules associated with the 
selected resource.
When configured to do so, operators can switch between the resource and date views. They can 
disable the multi-resource view so that only a standard calendar view displays.
Depending on the installed Calendar Options, a schedule can be an action schedule or 
notification schedule. A resource can be an action, notification, contact, or calendar.
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Color configuration and navigation
A typical multi-resource view would be viewing the schedules of three contacts or the schedules 
of production lines.
For quick recognition, the color configured for a selected resource displays as the background 
color for the resource in the data window. The schedules display as a neutral color to 
complement the background color.
When several resources are selected, the readability of the schedules is reduced. Operators can 
us the navigation toolbar to decrease the visible resources. The toolbar provides navigation, 
scrolling, and increasing/decreasing the number of visible resources.

Date view
When the multi-resource view is "Date", the view shows the grouping by dates displayed 
horizontally with the resources underneath displaying either horizontally or vertically. Only 
schedules for the resources selected in the "Resources" window are visible in the views.
The following figure shows the schedules for two calendars and a contact displayed with the 
multi-resource view as date. The standard calendar view is work week.

Resource view
When the multi-resource view is "Resource", the view shows the grouping by resources displayed 
horizontally with the dates underneath displaying either horizontally or vertically. Only 
schedules for the resources selected in the "Resources" window are visible in the views.
The following figure shows the same week schedules displayed with the multi-resource view as 
resource.
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5.5.4 Creating action schedules

Introduction       
Operators can create action schedules in Runtime using only configured actions that they are 
authorized to use. An operator not assigned the authorization for any of the actions cannot 
create any schedules. Rather than adding the same schedule to a calendar several times, 
operators can configure one recurring schedule that displays in the calendar at the specified 
dates and times.
Creating an action schedule in Runtime is the same as during configuration. For detailed 
instructions, see the "Configuration" chapter in this documentation.
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Procedure
1. Double-click a date or time slot to open the Action Schedule Editor. Optionally, right-click a 

date or time slot and choose "New Action Schedule".
Note
If other schedule types are available and the default schedule type is not action, you must 
right-click and choose "New Action Schedule" for this editor to open.

2. Configure the action schedule:
– Enter a name for the schedule. Optionally, enter a description.
– Set the time the schedule is to start and end.
– Select the actions to execute at the selected start time.
– Optionally, select the actions to execute at the selected end time and click "OK".
– Select the calendar names where the schedule is to occur.
– Indicate whether to execute the schedule due to a startup/shutdown or a date/time 

change.
– Optionally, configure this schedule to repeat.

3. After you finish configuring the schedule, click "OK".
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Results
The action schedule appears in the selected calendars at the specified times. The color of a 
schedule is the same as its associated calendar. The way the schedule color (Page 103) displays 
depends on the selection of multiple calendars in the "Resources" window and a multi-resource 
view.
An arrow displays in a date or time slot when it contains schedules that are not visible. Clicking 
the arrow displays the additional schedules in the "Agenda" list.

5.5.5 Modifying action schedules

Introduction   
Operators can modify only schedules that contain actions they are authorized to use. Operators 
not assigned the authorization for any of the preconfigured actions cannot modify any 
schedules.
Modifying an action schedule in Runtime is the same as during configuration. For detailed 
instructions, see the "Configuration" chapter in this documentation.
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Using the Action Schedule Editor
1. Double-click an action schedule to display its configuration.
2. Make the desired changes in the editor:

– Renaming schedule:
Enter the text in the "Name" and "Description" fields.

– Changing schedule time:
Set the time the schedule is to start and end.

– Deleting actions:
Select the desired rows. Right-click and choose "Delete". To delete all actions, right-click 
and choose "Clear".

– Adding actions:
Click "Select", choose the actions, and click "OK".

– Changing execution order of actions:
Click a row to highlight it. Drag the action to the desired location. A red line appears at the 
point where the action will move.

– Adding or changing recurrence:
Click "Recurrence" and set the recurrence pattern and time.

– Removing recurrence:
Click "Recurrence" and then click "Remove Recurrence".

– Changing associated calendar:
Click the "Calendar" arrow and select the calendars where the schedule is to display.

3. After you finish modifying the schedule, click "OK".

Dragging and dropping schedules     
Quickly modify a schedule by dragging it to the desired date and time in a calendar view or to a 
date in the "Date Navigation" window. The day and work week views let you quickly change the 
duration of a schedule by dragging its start or end border to the desired time.
If the schedule contains an action that you are not authorized to use, the schedule remains at the 
configured date and time. If you have sufficient permissions, the schedule moves to the new date 
and time.

5.5.6 Deleting and restoring schedules

Introduction
Operators can modify schedules that contain resources they are authorized to use. Operators 
not assigned the authorization for any of the preconfigured resources cannot modify any 
schedules. Depending on the installed Calendar Options, a resource can be an action, 
notification, contact, or contact group.

WinCC/Calendar Scheduler Documentation
5.5 Operation in Runtime

WinCC/Calendar Options
System Manual, 11/2020, A5E49472488-AA 111



Deleting schedules     
Quickly delete a schedule from all calendars by right-clicking the schedule and choosing 
"Delete". Optionally, you can select the schedule and press <Delete>. If the schedule is in a 
recurrence series, you will choose whether to delete all occurrences or only the occurrence of 
the selected day and time.
Deleting the selected occurrence is an override to the schedule and does not affect the other 
occurrences in the series. This capability is helpful when you do not want the schedule to 
execute on the selected date. Deleting the series deletes all occurrences of the schedule.
From the schedule editor, you can delete a schedule or an occurrence on the selected day in a 
recurring schedule by clicking the "Delete" button. Clicking the "Calendars" arrow and 
unselecting a calendar lets you remove the schedule from that calendar.

Restoring a recurring schedule     
You can restore all modified and deleted occurrences to the initial configured state of the 
recurring schedule:
1. Right-click any occurrence in the recurring schedule and choose "Edit Series".
2. In the editor, click "Recurrence".
3. In the "Recurrence" dialog, click "OK" without making any changes.
4. Click "OK" to close the editor.
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WinCC/Event Notifier Documentation 6
6.1 Introduction

The Event Notifier is a WinCC option that provides an easy way to manage time-based scheduling 
of personnel to receive notifications from automated processes that WinCC supervises. The 
Event Notifier provides a way for users to easily schedule the right persons to notify of an alarm 
condition based on the time of day and the day of week.
With the WinCC/Event Notifier, you can:
• Easily send alarms to a specific person's cell phone via email, based on work schedules.
• Schedule recurring work times with overrides for holidays or maintenance activities.
• See when a person is scheduled by filtering of views by personnel.
• Verify notifications are sufficiently staffed by filtering of views by alarm category.
• Secure operator scheduling through user authorizations.
• Choose the system configuration where this option is installed: WinCC Client/Server, multi-

user systems, redundant systems, and WebNavigator.

6.2 Calendar Options

6.2.1 How Calendar Options work

Structure   
The WinCC/Calendar Options include the WinCC/Calendar Scheduler and the WinCC/Event 
Notifier. A license is required for each option. The entry "Calendar Options" appears in the WinCC 
Explorer after the installation.
The Calendar Options share components. Only the functionality for the installed option is 
available. When both options are installed, the functionality of both options is available. The 
following diagram shows the relationship of editors used when configuring the Calendar 
Scheduler and the Event Notifier. Light blue indicates Runtime.
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Each Calendar Option has a calendar that serves as a named grouping of action schedules or 
notification schedules. The Calendar Scheduler has action schedules that reference one or more 
actions that will execute when the schedule starts and ends. The Event Notifier has notification 
schedules that specify a start and end time when a list of referenced contacts can be sent alarms 
that match the referenced notifications.

Calendar Options components   
The Calendar Options consist of server and client components that can be installed together on 
the same computer. These components can be installed across multiple computers in the WinCC 
Client/Server, multi-user, redundant, and WebNavigator system configurations.

Calendar Options Editor   
The Calendar Options Editor is accessed from the WinCC Explorer. The Calendar Options Editor 
is used to set up or edit a WinCC project's Calendar Scheduler or Event Notifier configuration.
The Calendar Scheduler lets you create schedules to execute actions. The Event Notifier lets you 
create schedules to send email notifications to specified contacts when WinCC alarm messages 
match the configured notification criteria. You would set an authorization on an action, 
notification, or contact to prevent unauthorized use by operators.

Calendar Scheduler Server       
The Calendar Scheduler Server runs as a background service on each WinCC Server in the project 
executing the configured activities. The Calendar Scheduler Server starts when the WinCC 
project is activated in Runtime and stops when Runtime is deactivated.
The Calendar Scheduler follows the same redundancy model as other WinCC functions. The 
Calendar Scheduler Servers start on both WinCC Servers. Only the server located on the active 
server executes actions. During a server switch, the standby server becomes active and executes 
the actions.
Configuration data (actions and calendars) is synchronized manually between the redundant 
servers. For information, see the WinCC Information System under "Working with WinCC > 
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Working with Projects > Copying and Duplicating Projects". Runtime data (schedules) is 
synchronized automatically.

Note
Time synchronization between the pair of redundant WinCC servers is essential for correct 
operation.

Note
In Runtime, making changes from the standby server is not supported in this version. You can 
only make changes on the master server.

Event Notifier Server     
The Event Notifier Server runs as a background service on each WinCC Server in the project 
sending the configured notifications to the scheduled contacts. The Event Notifier Server starts 
when the WinCC project is activated in Runtime and stops when Runtime is deactivated. The 
Event Notifier Server loads the configuration information at startup and loads any operator 
changes immediately.
The Event Notifier follows the same redundancy model as other WinCC functions. The Event 
Notifier Servers start on both WinCC Servers. Only the server located on the active server sends 
emails. During a server switch, the standby server becomes active without loss of Event Notifier 
data. For example: A contact who received an email from the primary server is allowed to 
acknowledge the email after a switch to the secondary server.
Configuration data (notifications, contacts, and calendars) is synchronized manually between 
the redundant servers. For information, see the WinCC Information System under "Working with 
WinCC > Working with Projects > Copying and Duplicating Projects". Runtime data (schedules) 
is synchronized automatically.

Note
Time synchronization between the pair of redundant WinCC servers is essential for correct 
operation.

Note
In Runtime, making changes from the standby server is not supported in this version. You can 
only make changes on the master server.

Calendar Control   
The Calendar Control can be placed into one or more WinCC pictures using the WinCC Graphics 
Designer. You would configure this control to display and manage the subset of schedules 
specific to the portion of the application's process used in the picture.
A server package cannot be imported or deleted while a WinCC Client is running. The Calendar 
Option servers do not recognize the imported or deleted package because the Calendar Control 
reads at startup.
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Calendar Scheduler in Runtime   
In Runtime, operators use the Calendar Control to view and manage the time-based activities. 
Operators can create and edit action schedules only with the preconfigured actions they are 
authorized to use.
When operators attempt to select an action they are not authorized to use, they receive the 
"Insufficient permission" message. When they attempt to edit action schedules that contain at 
least one unauthorized action, the schedule remains unchanged at its preconfigured date and 
time.

Event Notifier in Runtime   
In Runtime, operators use the Calendar Control to view and manage the scheduling of personnel 
to receive email when a new alarm matches the configured notifications. Operators can create 
and edit notification schedules only with the preconfigured notifications and contacts they are 
authorized to use. If configured to do so, operators can create and edit contacts and contact 
groups.
When operators attempt to select a notification or contact they are not authorized to use, they 
receive the "Insufficient permission" message. When they attempt to edit notification schedules 
that contain at least one unauthorized notification or contact, the schedule remains unchanged 
at its preconfigured date and time.

Time display format       
The Calendar Scheduler Server and the Event Notifier Server save the date and time in the UTC 
(Coordinated Universal Time) format. The Calendar Options Editor and Calendar Control display 
time based on the local time setting of the client computer. This allows multiple operators using 
WinCC systems with clients located in different time zones to view and manage schedules in 
their own time.

Alternate terminology
Throughout the documentation, alternate terminology may be used to represent names where 
functionality is the same in the Calendar Options.

Terminology Calendar Scheduler Event Notifier
schedule action schedule notification schedule
resource action, calendar notification, contact, contact group, cal‐

endar
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6.2.2 Calendar Scheduler

Structure   
The Calendar Scheduler lets you create schedules to execute actions. The following diagram 
shows the relationship of editors and dialogs used when configuring the Calendar Scheduler. 
Light blue indicates Runtime.

• "Calendar": Serves as a named grouping of configured action schedules. Optionally, a 
calendar name can have translated text.

• "Action Schedule": References one or more actions that will execute when the schedule starts 
and ends (if configured). Optionally, the schedule can be defined to reoccur, and the schedule 
name can have translated text.

• "Action": Contains at least one subaction. A subaction represents either a tag setting or C-
script execution. Optionally, an action can have a security authorization, and the action name 
can have translated text.

Workflow
In a typical WinCC project, you would configure all the actions necessary to control the process, 
independent of the action schedules. In each action, enter a descriptive name for each of the 
project’s languages and select the user authorization necessary to create a schedule using the 
action.
During Runtime, operators can create and edit schedules that execute actions for which they are 
authorized.
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6.2.3 Event Notifier

Structure   
The Event Notifier lets you create schedules to send email notifications to specified contacts 
when WinCC alarms or messages match the configured notification criteria. The following 
diagram shows the relationship of editors and dialogs when configuring the Event Notifier. Light 
blue indicates Runtime.

• "Calendar": Serves as a named grouping of configured notification schedules. Optionally, a 
calendar name can have translated text.

• "Notification Schedule": Specifies a time frame that the referenced "Contacts" or "Contact 
Groups" can be sent alarms that match the referenced "Notifications". Associated with each 
contact is an "Escalation" time that the alarm must remain unacknowledged before the 
contact is notified. Optionally, the schedule can be defined to reoccur, and the schedule name 
can have translated text.

• "Contact": Specifies an individual that can be sent notifications. Each contact is a WinCC user 
with a specified email address. Each contact identifies a communication service through 
which notification email is sent. Optionally, a contact can have a security authorization.
A "Contact Group" is a list of contacts. Messages may be sent to all contacts in the contact 
group. Optionally, a contact group name can have translated text.

• "Notification": Identifies a set of alarms or other WinCC messages. Each notification contains 
message blocks and selection filter criteria to use for the alarm output. The configuration 
defines the information to send when an alarm occurs. Optionally, a notification can have a 
security authorization, and the notification name can have translated text.

• "Communication Service": Specifies how WinCC is to connect to the email server or other 
communication service that will deliver notification email to contacts and their responses to 
the email. Multiple services can be configured.
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Workflow
In a typical WinCC project, you would:
1. Configure a communication service during initial project setup.
2. Configure the notifications and contacts necessary for your application, independent of the 

notification schedules.
– In each notification, enter a descriptive name for each of the project’s languages. Select 

the user authorization necessary to create schedules using the notification.
– In each contact group, enter a descriptive name for each of the project's languages. Drag 

contacts to the contact groups.
– In each contact, enter its email address and server name. Select the user authorization 

necessary to create schedules using the contact.
During Runtime, operators can create and edit schedules using contacts and notifications for 
which they are authorized. Occasionally, operators may be allowed to create and edit contacts 
and contact groups. WinCC alarm messages that match the notifications in the active schedules 
may be sent to the specified contacts. Messages are sent to a contact only if the alarm is not 
acknowledged before the contact's configured escalation time.

6.2.4 Calendar Options System Tags
Calendar Options has the following system tags. These tags are displaying specific message/
information for an action or event at runtime. These tags will created as “internal tag” and are 
part of the “Calendar” group in WinCC Tag Management.

@CalendarMsg
This tag holds the string value for information related to an appointment (while creating/
Modifying/deleting) and resources (Calendar changed/Notification changed/contact changed/
action changed). The message string contains information such as appointment status, 
machine name, and event name.

@EventMsg
This tag holds the string value of an initiated events. The message string contains information 
such as machine name, server status (server up/server initialized), event status (start executed/
stop executed), appointment Id, and appointment subject.

@ExecuteMsg
This tag holds the string value of an executed action/sub-action. The message string contains 
information such as system Id, executed action/sub-action, executed action/sub-action Id.
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@SynchronizeMsg
This tag holds the string value of the synchronized events. The message string contains 
information related to the synchronization of data of the actual server machine to redundant 
server machine

6.3 Working with Event Notifier

6.3.1 Email guidelines

Introduction
Email provides an easy way to notify the right persons about an alarm condition. There are 
processing and security situations to consider when using email. Developing and implementing 
email security practices are necessary to keep email communication as secure as possible. The 
following guidelines provide general email processing and security information to use with the 
Event Notifier.

Email processing
Guideline Comments
Email is not a guaranteed form of delivery. Email is not recommended as the primary method for acknowledging 

alarms. A best practice is to establish a default plan for acknowledging 
alarms and to use email as an alternate method. This way the alarms can get 
acknowledged if the contacts do not receive the notification email.

Overloading the input buffer could cause the 
email server to delay the processing of the email 
acknowledgments.

To control the mailbox size, configure a message size limit on the received 
messages. This way the email server rejects messages greater than a speci‐
fied number of bytes.
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Email security
Guideline Comments
Email is not a secure method for transmitting 
sensitive data.

• Avoid configuring proprietary information in the notifications that may 
display in email.

• Configure the communication service to use a secure version of TLS for 
better protection from sniffing and from spoofed acknowledgment re‐
sponses.

Some features of the Event Notifer provide a 
level of security.

• Configure notifications and contacts with a security authorization to al‐
low the operators to create and edit schedules only using the contacts 
and notifications for which they are authorized.

• Prevent contacts from acknowledging a notification email by disabling 
the acknowledgment option in the notification.
In this case, the contacts receive a notification email but cannot send an 
acknowledgment response. This is useful when an alarm is a high-prior‐
ity critical alarm and only an authorized operator can acknowledge the 
alarm. If email acknowledgment was allowed, the alarm acknowledg‐
ment could be spoofed.

Security concepts provide methods to ensure 
that only authenticated users can create and 
modify scheduling information.

• Understand security concepts and develop solutions to create a secure 
network for production plants.
The operational guidelines document for the WinCC security concept is 
available at the following URL:
http://support.automation.siemens.com/WW/view/en/60119725 (http://
support.automation.siemens.com/WW/view/en/60119725)

• Use VPN for point-to-point encryption to provide a secured network con‐
nection.

6.3.2 Opening the Calendar Options Editor

Introduction   
The Calendar Options Editor can be started only for the project currently open in the WinCC 
Explorer. The Calendar Options Editor contains elements of the Calendar Scheduler and the 
Event Notifier when both options are installed. If only one option is installed, the editor provides 
the elements of the installed option.

Procedure
You can open the Calendar Options Editor in the navigation window of WinCC Explorer in the 
following ways:
• Right-click "Calendar Options" and choose the installed option: "Open Calendar Scheduler" or 

"Open Event Notifier".
• Expand "Calendar Options" and double-click the installed option: "Calendar Scheduler" or 

"Event Notifier".
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• Expand "Calendar Options" and select "Calendar Scheduler". In the data window, right-click 
"Action Schedule" and choose "Open".

• Expand "Calendar Options" and select "Event Notifier". In the data window, right-click 
"Notification Schedule" and choose "Open".
Note
The option you select determines which schedule type to open when double-clicking a date 
or time slot. The default schedule type for Calendar Scheduler is "Action". The default 
schedule type for Event Notifier is "Notification".

Results
The Calendar Options Editor starts and a calendar is opened in the data window. A list of all 
available resources is visible. The month view displays the first time this editor is opened. If you 
change the calendar view, that view will display anytime the editor is opened.

6.3.3 Calendar Options Editor

6.3.3.1 Calendar Options Editor elements

Introduction
When you start a Calendar Option in WinCC Explorer, the Calendar Options Editor is opened. The 
Calendar Options Editor is used to configure a project's initial time-based activities in the 
Calendar Scheduler or time-based scheduling of personnel to receive notifications in the Event 
Notifier. Only the elements of the installed Calendar Option display.
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Elements of the Calendar Options Editor   
The user interface of the Calendar Options Editor consists of the following elements:

① Menu bar
② Toolbar
③ Resources window
④ Data window
⑤ Date Navigation window
⑥ Status bar

6.3.3.2 Menu bar

Introduction     
The menu bar includes the commands that you can use in the Calendar Options Editor. Some 
commands can be activated using the key combinations (shortcut keys). The following tables 
provide brief information on the commands in the menu bar.
Only the menu commands of the installed Calendar Options are visible.
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File menu   
The File menu includes one command:

Command Key combination Function
Exit <Alt+F4> Closes the Calendar Options Editor.

Edit menu   
The Edit menu includes the following commands:

Command Key combina‐
tion

Op‐
tio
n

Function

Action 
Schedules

<Ctrl+N> C Opens the Action Schedule Editor with the next default, unconfig‐
ured action schedule name displaying.

Actions --- C Opens the Action Editor with the next default, unconfigured action 
name displaying.

Calendars --- C E Opens the Calendar List Editor with the next default calendar name 
displaying.

Notifica‐
tion Sched‐
ules

<Ctrl+N> E Opens the Notification Schedule Editor with the next default, un‐
configured notification schedule name displaying.

Contacts --- E Opens the Contact Editor with the list of WinCC users and groups 
displaying so you can create contacts and contact groups.

Notifica‐
tions

--- E Opens the Notification Editor with the next default, unconfigured 
notification name displaying.

"C": Visible when Calendar Scheduler is installed.
"E": Visible when Event Notifier is installed.

View menu   
The View menu includes the following commands:

Command Key combination Function
Day View --- Displays all schedules in a 24-hour day format for the 

selected day.
Work Week View --- Displays all schedules in a 5-day week, 24-hour day for‐

mat. A work week contains Monday through Friday and 
begins with the selected Monday or with the Monday 
prior to the selected day or date range.

Week View --- Displays all schedules for the selected week. A week in‐
cludes all 7 days of the week and begins with the selec‐
ted Monday or with the Monday prior to the selected day 
or date range.

Month View --- Displays all schedules in a monthly format. A month be‐
gins with the week containing the selected day or date 
range.
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Command Key combination Function
Timeline View --- Displays all schedules in a timeline format. A timeline 

highlights 15 days and begins with the selected day or 
first day of a date range.

Toolbar --- Displays or hides the toolbar.
Status Bar --- Displays or hides the status bar.
Go to This Day --- With the month or week view visible and one date se‐

lected, this command displays the selected date in day 
view. The work start time is highlighted. This command 
is not available in the other views.

Go to Today --- Displays schedules for the current day or for the work 
week, week, month, or timeline that contains the cur‐
rent day. In each resulting view, the current day is high‐
lighted. On the timeline view, the current day is the first 
day in the timeline.

Go to Date --- Opens a dialog for you to enter a specific date and which 
calendar view to display. You can choose the date from a 
pop-up calendar. The view changes to the specified view 
with the work start time highlighted on the specified 
date.

Grouping --- Displays the schedules in multi-resource views in addi‐
tion to the standard calendar views. The way the group‐
ing displays depends on the selected calendar view.
• "None": Grouping is off so that only the standard cal‐

endar view is visible.
• "Date": Grouping is by the dates displayed horizon‐

tally with the selected resources underneath display‐
ing either horizontally or vertically.

• "Resource": Grouping is by the selected resources 
displayed horizontally with the dates underneath 
displaying either horizontally or vertically.

Preferences --- If more than one Calendar Option is installed, this com‐
mand sets the default schedule type to open when a day 
or time slot in the data window is double-clicked. The 
schedule type can be an "Action" or "Notification".

Time Scales --- With the timeline view visible, this command changes 
the increment of time to display in the timeline. Select‐
ing the same scale again switches between hiding and 
showing the scale.

Time Scale Cap‐
tions

--- With the timeline view visible, this command sets the 
time scale caption to display in the timeline. Selecting 
the same caption again switches between hiding and 
showing the caption.

Refresh F5 Refreshes the data in the Calendar Options Editor.
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Tools menu   
The Tools menu includes the following commands:

Command Key combination Function
Language --- Displays the "Select Language" dialog so you can change 

the configuration language of the Calendar Options and 
WinCC.

Servers --- Displays the server names when multiple servers are 
configured. You can choose a server and have the WinCC 
project connect to a different server.

Help menu   
The Help menu includes the following commands:

Command Key combination Function
Contents and In‐
dex

--- Opens the Calendar Options Information System.

Direct Help --- Activates the direct help (What's this?).
About Calendar 
Options

--- Displays the installed version and the installed compo‐
nents of the Calendar Options.

6.3.3.3 Toolbar
The toolbar contains buttons that allow you to quickly activate commands. You can switch 
between hiding and showing the toolbar by clicking "View > Toolbar". Only the toolbar buttons 
of the installed Calendar Options are visible.     
Selecting the toolbar and dragging it along the borders of the Calendar Options Editor lets you 
move the toolbar. You can reposition the toolbar by moving it either left and right or up and 
down.

Ic
o
n

Tooltip Op‐
tion

Description

Hide/Show 
Resources

C E Switches between showing and hiding the "Resources" window in the Calendar 
Options Editor.

Hide/Show 
Date Navi‐
gation

C E Switches between showing and hiding the "Date Navigation" window in the 
Calendar Options Editor.

Action 
Schedule 
Editor

C Opens the Action Schedule Editor with the next default, unconfigured action 
schedule name displaying.

Action Edi‐
tor

C Opens the Action Editor with the next default, unconfigured action name dis‐
playing.

Calendar 
List Editor

C E Opens the Calendar List Editor with the next default calendar name displaying.

Notifica‐
tion Sched‐
ule Editor

E Opens the Notification Schedule Editor with the next default, unconfigured 
notification schedule name displaying.
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Ic
o
n

Tooltip Op‐
tion

Description

Contact Ed‐
itor

E Opens the Contact Editor with the list of WinCC users and groups displaying so 
you can create contacts and contact groups.

Notifica‐
tion Editor

E Opens the Notification Editor with the next default, unconfigured notification 
name displaying.

Calendar 
Options 
Help

C E Opens the Calendar Options Information System.

"C": Visible when Calendar Scheduler is installed.
"E": Visible when Event Notifier is installed.

6.3.3.4 "Resources" window
The "Resources" window displays a grouping of the configured resource names and determines 
which resources to show in the data window. Depending on the installed Calendar Options, a 
resource can be an action, notification, contact, or calendar.     
For quick recognition, the color configured for a resource displays in the "Resources" window. 
The resources are grouped by resource type.

Selecting the check box next to a resource group selects all resources in the group and displays 
a black check mark. Expanding the group and selecting individual resources changes the check 
mark color to gray for the group.
All selected resources display in the data window, based on a standard calendar view or a multi-
resource view.

6.3.3.5 "Date Navigation" window
The "Date Navigation" window controls the date or date range to display in the data window. The 
number of consecutive months that display in this window depends on the size of the Calendar 
Options Editor window. Clicking a day or highlighting a range of days in this window displays the 
selected day or range of days in the data window. Clicking the left and right arrows next to the 
month and year allows you to quickly move through the months and years in the calendar.    
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6.3.3.6 Data window

Data area      
The data window displays the date range and the schedules for the resources selected in the 
"Resources" window. The way the data displays in this window depends on the selected calendar 
view. A standard calendar view can be a day, work week, week, month, or timeline. Each view 
displays the schedules in the color configured for the associated calendar. If a schedule is 
associated with multiple calendars, the color of the schedule displays as the first selected 
calendar when the schedule was configured.
In addition to the standard calendar views, the data window can display multi-resource views. 
In these views, multiple date areas are displayed vertically or horizontally. The color configured 
for a selected resource displays as the background color for the resource. Each date area displays 
the schedules associated with the selected resource. The schedules display as a neutral color to 
complement the background color. Depending on the installed Calendar Options, a resource can 
be an action, notification, contact, or calendar.
Double-clicking a day, time slot, or schedule in the data window opens the editor, so you can 
create a schedule or edit an existing one. You can also highlight a range of days and create a 
schedule for the duration of the selected days.

Navigating
On the left and right borders of the data window are "Previous" and "Next" tabs. These tabs are 
available when the selected calendars contain schedules not visible in the current view. Clicking 
an available tab either advances the view to display the next schedule or goes backwards to the 
previous schedule.
When multi-resource view is selected, a navigation toolbar displays for working with schedules. 
The toolbar provides navigating, scrolling, and increasing/decreasing the number of visible 
resources.

① Goes back one page
② Sliding scroll bar
③ Goes forward one page
④ First 
⑤ Previous Page
⑥ Previous
⑦ Next
⑧ Next Page
⑨ Last
⑩ Increase visible resources count
⑪ Decrease visible resources count
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6.3.3.7 Status bar
The status bar displays the current user logged in to use the Calendar Options Editor and 
indicates whether the server is running or not running. The status bar also displays the server 
name and computer name where the WinCC project is connected.     

6.3.3.8 "Agenda" list

Introduction   
The "Agenda" list is opened from the data window in the Calendar Options Editor.
When a date or time slot contains more schedules than what displays in the calendar view, an 
arrow displays on the date or time slot. Clicking the arrow opens the "Agenda" list to display the 
additional schedules that are not visible on that date or time slot.

Usage
In the "Agenda" list, you can:
• Double-click a schedule to display its configuration in the editor.
• Click a column heading to sort the schedules in ascending or descending order by start time, 

end time, or description.

6.3.4 Opening the Notification Schedule Editor

Introduction   
The Notification Schedule Editor is used to create, rename, modify, and delete notification 
schedules. This editor lets you set the start and end time for the schedule to be activated and 
deactivated.
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Procedure
You can open the Notification Schedule Editor in the following ways:
• From the toolbar, click .
• From the menu bar, select "Edit > Notification Schedules".
• In the data window:

– Double-click a date or time slot.
– Right-click a date or time slot and choose "New Notification Schedule".
– Double-click a notification schedule.
– Right-click a notification schedule and choose "Open". For all occurrences in a recurring 

schedule, right-click and choose "Edit Series".
Note
If other schedule types are available, the notification schedule preference must be 
selected as the default schedule type for this editor to open when double-clicking a date 
or time slot. To set the preference, click "View > Preferences > Default Schedule Type > 
Notification".

• From the "Agenda" list, double-click a notification schedule.
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Results
When the Notification Schedule Editor is opened from the toolbar or menu bar, a default 
unconfigured notification schedule displays. Opening a configured notification schedule 
displays its configuration.

6.3.5 Opening the Contact Editor

Introduction   
The Contact Editor is used to create, rename, modify, or delete contacts and contact groups.

Procedure
You can open the Contact Editor in the following ways:
• From the toolbar, click .
• From the menu bar, select "Edit > Contacts".
• Click the "Add New" button in the contacts area of the Notification Schedule Editor.
• Right-click in the contacts area of the Notification Schedule Editor and choose "New".
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Results
When the Contact Editor is opened, the users configured in the WinCC User Administrator and 
the configured contact groups and contacts display. Selecting a contact group or contact 
displays its configuration.

6.3.6 Opening the Notification Editor

Introduction   
The Notification Editor is used to create, rename, modify, or delete notifications.

Procedure
You can open the Notification Editor in the following ways:
• From the toolbar, click .
• From the menu bar, select "Edit > Notifications".
• Click the "Add New" button in the notifications area of the Notification Schedule Editor.
• Right-click in the notifications area of the Notification Schedule Editor and choose "New".
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Results
When the Notification Editor is opened, a default unconfigured notification displays. Selecting a 
configured notification displays its configuration. One tab shows the selection filter criteria.

Another tab shows the content structure for the message information to display in the 
notification email and response email.
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6.3.7 Opening the Calendar List Editor

Introduction   
The Calendar List Editor is used to create, rename, and delete calendars. This editor lets you 
choose a color to identify a calendar and its associated schedules. Depending on the installed 
Calendar Options, a schedule can be an action schedule or notification schedule.

Procedure
You can open the Calendar List Editor in the following ways:
• From the toolbar, click .
• From the menu bar, select "Edit > Calendars".

Results
The Calendar List Editor opens with a default calendar and color displaying.
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6.3.8 Changing the configuration language

Introduction       
You can change the configuration language in which a calendar displays by selecting a language 
from a list. The languages available for Calendar Options are those installed with WinCC except 
ASIAN languages.

Procedure
1. In the Calendar Options Editor, click "Tools > Language".
2. Select the language from the list and click "OK".

The Calendar Options Editor and WinCC configuration language change to the selected 
language.

6.3.9 Field descriptions

6.3.9.1 Calendar List Editor
In the Calendar List Editor, you create, rename, and delete calendars. You can specify a color to 
quickly identify a calendar and its associated schedules. Depending on the installed Calendar 
Options, a schedule can be an action schedule or notification schedule.   

Field Description
Name A unique, descriptive name for the calendar that represents a grouping of 

schedules.
Selecting the arrow next to this field displays a list of calendar names created 
in the opened WinCC project. You create a calendar by clicking "New", en‐
tering a unique name in this field, and clicking "OK".

Locale button Opens the Locale Editor so you can specify translated text to represent the 
calendar name. 
Calendars not configured with translated text will display in the language 
configured for the Calendar Option.
This button displays only for configured calendars. Clicking "Apply" while 
creating a calendar saves the name and displays this button.

Color picker Opens the color palette so you can select a color to associate with a calendar 
name and its schedules.

New Clears the visible configuration in the editor and displays a default calendar 
name.

Delete Deletes the selected calendar name and its associated schedules permanent‐
ly. You must confirm a calendar deletion.

OK Saves the configuration and closes the editor.
Apply Saves the configuration and keeps the editor open.
Cancel Exits the editor without saving any modifications.
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6.3.9.2 Notification Schedule Editor
In the Notification Schedule Editor, you define the general properties for a notification 
schedule.   

Field Description
Name A descriptive name for the schedule. When this editor is opened initially, a 

default name displays. Although you can keep the default name, it is rec‐
ommended that you rename the schedule for easy recognition.

Description Information that describes the schedule.
Start Time The date and time you want the schedule to start. You can enter the date and 

time or use the arrows. Clicking the date arrow opens a pop-up calendar so 
you can choose the date. 

End Time The date and time you want the schedule to end. You can enter the date and 
time or use the arrows. Clicking the date arrow opens a pop-up calendar so 
you can choose the date.

Contacts A list of contacts or contact groups with an "Escalation" time to receive no‐
tifications between the start and end time. After the schedule is saved, the 
contacts are sorted by the "Escalation" time.

Escalation Defines the delay time in minutes to wait until an email is sent to the contact. 
Clicking the "Escalation" arrow lets you set the minutes that an alarm must 
remain unacknowledged before the contact is notified. A "0" value indicates 
the notifications are sent immediately.

Notifications A list of notifications that identifies a set of alarms or other WinCC messages 
to send when an alarm occurs.

Select "Contacts" area: Opens the "Contacts" list that contains configured contacts 
so you can quickly choose the contacts for the schedule.
"Notifications" area: Opens the "Notifications" list that contains configured 
notifications so you can quickly choose the notifications for the schedule.

Add New "Contacts" area: Opens the Contact Editor so you can configure a new contact 
to attach to the schedule. After the contact is created, it displays in the "Con‐
tacts" area of the Notification Schedule Editor. The contact is also added to 
the "Contacts" list and the "Resources" window.
"Notifications" area: Opens the Notification Editor so you can configure a new 
notification to attach to the schedule. After the notification is created, it 
displays in the "Notifications" area of the Notification Schedule Editor. The 
notification is also added to the "Notifications" list and the "Resources" win‐
dow.
This button is not visible in Runtime.

Calendar Selects the calendars where the schedule is to display. Clicking the arrow lets 
you choose one or more configured calendars.

Locale button Opens the Locale Editor so you can specify translated text to represent the 
schedule name. Names not configured with translated text will display in the 
language configured for the Calendar Option.
This button displays only for configured schedules. Clicking "Apply" while 
creating a schedule saves the name and displays this button.
This button is not visible in Runtime.

Recurrence Opens the "Recurrence" dialog so you can set the frequency and time period 
to repeat the schedule.

New Clears the visible configuration in the editor and displays the next available 
default schedule name.
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Field Description
Delete Deletes the schedule from the selected calendar. If recurrence is configured, 

you can delete the schedule on a specific date and time, without deleting the 
series.

OK Saves the configuration and closes the editor. 
Apply Saves the configuration and keeps the editor open.
Cancel Exits the editor without saving any modifications.

6.3.9.3 "Recurrence" dialog
In the "Recurrence" dialog, you configure a schedule to repeat many times, so you will not need 
to create the schedule again and again. Depending on the installed Calendar Options, a schedule 
can be an action schedule or notification schedule.     

Field Description
Recurrence time The time period that the schedule is to start and end. 

When you select the start and end times, the duration is calculated auto‐
matically. If you change the duration, the end time changes to reflect the 
selected duration.

Recurrence pattern Defines the frequency that the schedule is to repeat. The options change 
based on the selected frequency:
• "Minutely"
• "Hourly"
• "Daily"
• "Weekly"
• "Monthly"
• "Yearly"
Example: To set a schedule to repeat every Friday, you would select "Weekly" 
and "Friday" and set "Recur every" to "1".

Range of recurrence Defines the date range that the recurrence pattern is to start and end.
The end date has the following options:
• "No end date"
• "End after": Specifies the number of occurrences. After you enter the 

number of occurrences, the "End by" date changes so you can see the end 
date of the range.

• "End by": Specifies a date. After you select a date from the pop-up calen‐
dar, the schedule's end time is added automatically.

Remove Recurrence Deletes the recurrence configuration from the schedule. All occurrences of 
the schedule except the initial configured instance are removed.

OK Saves the configuration and closes the dialog.
Cancel Exits the dialog without saving any modifications.
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6.3.9.4 Contact Editor
In the Contact Editor, you create, rename, modify, and delete contacts and contact groups.   

Field Description
Users Displays the list of WinCC users and groups defined in the User Administrator.

You can quickly access the User Administrator to create more users by right-
clicking in this area and choosing "User Administration". Users cannot be 
created during Runtime.
Selecting a user in this area highlights all contacts associated with the user.

Contacts Contact and contact group names associated with the WinCC users. A con‐
tact must be associated with a group.
Create a group by right-clicking "Contacts" and selecting "Add Group". Create 
contacts by dragging users to a group name. Right-clicking a contact lets you 
delete its configuration, delete it from a group, or rename it.

Contact Properties Displays the name and configuration of the selected contact or contact 
group. The properties that can be configured depend on whether a contact 
or contact group is selected.

Color picker Opens the color palette so you can select a color to identify the contact or 
contact group.

Locale button Opens the Locale Editor so you can specify translated text to represent the 
contact group name. Names not configured with translated text will display 
in the language configured for the Calendar Option.
This button displays only for configured contact groups. Clicking "Apply" 
while creating a contact group saves the name and displays this button.
This button is not visible in Runtime.

Language selector Language in which the email displays for the contact. The languages instal‐
led in WinCC are available.

Email Address Email address of the contact to receive notification email from the Event 
Notifier. This must not be the same email address configured for the com‐
munication service.

Test Sends a test email to the contact's configured email account.
Server Name Name of the server that contains the contact's communication service in‐

formation. The server name is defined in the Communication Service Editor.
Authorization Opens a list of authorizations so you can set a user restriction on the use of 

the contact. The selected authorization displays next to the "Authorization" 
button. The default authorization is "<No access-protection>".

OK Saves the configuration and closes the editor.
Apply Saves the configuration and keeps the editor open.
Cancel Exits the editor without saving any modifications.
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6.3.9.5 Notification Editor
In the Notification Editor, you define the general properties for a notification.   

Field Description
Name A unique, descriptive name to identify a notification that can be associated 

with a notification schedule. When this editor is opened initially, a default 
name displays. Although you can keep the default name, it is recommended 
that you rename the notification for easy recognition.

Locale button Opens the Locale Editor so you can specify translated text to represent the 
notification name. A "Locale" button also exists for the "Subject", "Message", 
and "Acknowledge" fields. Names and content structure not configured with 
translated text will display in the language configured for the Calendar Op‐
tion.
This button displays only for configured notifications. Clicking "Apply" while 
creating a notification saves the name and displays this button.

Color picker Opens the color palette so you can select a color to identify this notification.
Selection Defines the filter criteria used to match the notification with the alarm mes‐

sages during Runtime.
To configure a selection criterion, click the "Criteria" arrow and choose an 
available message block. Click the "Operator" arrow and choose a Boolean 
operator, such as "equal to". Depending on the selected message block, enter 
text or a value, or select an option in the "Setting" column.

Message Blocks Displays the "Available Message Blocks" that can be used to define the con‐
tent of the subject and body in the notification email and response email.
The message blocks are configured in WinCC Alarm Logging. Selecting a 
message block displays its configuration.
When defining the content for email, you can enter text and drag available 
message blocks into the "Subject", "Message", and "Acknowledge" fields. 

Subject Content structure for the subject of the notification email and response 
email. The same subject is used for the response email and its related noti‐
fication email.
Additional information about "Subject" is in the creating a notification pro‐
cedure.

Message Content structure for the body of the notification email. This field can be 
blank depending on the recipient.

Acknowledge Content structure for the body of the response email.
Authorization Opens a list of authorizations so you can set a user restriction on the use of 

the notification. The selected authorization displays next to the "Authoriza‐
tion" button. The default authorization is "<No access-protection>".

Disable Acknowledgment Prevents contacts from acknowledging the alarm condition in this notifica‐
tion via email.
With this option selected, the contacts receive a notification email but cannot 
send an acknowledgment response. This is useful when an alarm is a high-
priority critical alarm and only an authorized operator can acknowledge the 
alarm. If email acknowledgment was allowed, the alarm acknowledgment 
could be spoofed.

New Clears the visible configuration in the editor and displays the next available 
default notification name. 

Delete Deletes the selected notification. If the notification is used in a schedule, a 
message displays stating you cannot delete the notification.
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Field Description
OK Saves the configuration and closes the editor.
Apply Saves the configuration and keeps the editor open.
Cancel Exits the editor without saving any modifications.

6.3.9.6 Locale Editor
In the Locale Editor, you specify text to represent the translated name for a schedule or resource. 
Depending on the installed Calendar Options, a schedule can be an action schedule or 
notification schedule. A resource can be an action, notification, contact group, or calendar.   

Field Description
Language Displays a list of languages installed in WinCC.
Name The translated text to represent the selected schedule or resource name for 

a particular language. The translated names will display in Runtime. Names 
not configured with translated text will display in the language configured for 
the Calendar Option.

OK Saves the configuration and closes the editor. 
Cancel Exits the editor without saving any modifications.

6.3.9.7 Communication Service Editor
In the Communication Service Editor, you define the general properties for an email server or 
communication service. Obtain the email account information from your IT department or email 
provider.   

Field Description
Name Descriptive name to identify the communication service
Email Address Email address for the mailbox that the Event Notifier will use to send and 

receive email
This must not be the same as the email address of the contacts.

Type Identifies the protocol type for the email server.
• "SMTP/POP3": Default protocol type
• "Test Mailer": Demo purpose
Other types display after they are installed with a third-party WinCC mail 
service add-on.

Poll Rate Defines the frequency in seconds to check the email server for new messag‐
es. (default = 30 seconds)

Advanced Opens a third-party WinCC mail service add-on for configuring a different 
mail protocol.
This button is visible only when the add-on is installed.

Server Defines the server name or IP address for the "Send" (SMTP) and "Receive" 
(POP) email servers.

Port Port number for the "Send" (SMTP) and "Receive" (POP) email servers. 
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Field Description
SSL Specifies whether the email server requires authentication for SSL.

A secure version of SSL is recommended for better protection from sniffing 
and from spoofed acknowledgment responses.
The user name and password will be encrypted before getting passed to the 
email server.

Login Defines the email address or user name that the Event Notifier will use to log 
on to the email server

Password Defines the password for the "Login" account on the email server
Add Clears the visible configuration in the editor and displays the next available 

default name.
Remove Deletes the selected communication service from the list.
Test Opens the "Test Email" dialog for sending a test email to the configured 

communication service.
Save Saves the configuration and keeps the editor open. The configured commu‐

nication service displays in the list.
Close Saves the configuration and closes the editor.

6.4 Configuration

6.4.1 Configuring communication services

6.4.1.1 Configuring a communication service

Introduction   
The Communication Service Editor is used to define the email account that WinCC uses to send 
notifications and receive acknowledgments. Configuring the notification email account involves 
defining the email address and how to communicate with the email provider for this email 
account.
Typical applications have one communication service defined during initial project setup. In 
most cases, the communication service is a dedicated email address defined on the company's 
corporate email server. However, you can use a dedicated email address on any SMTP/POP3 
email provider, e.g. Gmail, Hotmail.

Note
• Obtain the email account information from your IT department or email provider.
• Observe the general security information stated in the email guidlelines (Page 120).
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Creating a communication service
1. Expand "Calendar Options" and "Event Notifier" in WinCC Explorer. Double-click 

"Communication Service" to open the Communication Service Editor.
2. Click "Add".
3. Enter the following settings to configure a communication service.

Example configurations are available in this chapter.

Field Description
Name Descriptive name to identify your communication service
Email Address Email address for the mailbox that the Event Notifier will use to send and 

receive email
This must not be the same as the email address of the contacts.

Type Protocol type for the email server. Use the default setting "SMTP/POP3" un‐
less another protocol is required.
For another mail protocol to be available, it must be configured. Click "Ad‐
vanced" and use a third-party WinCC mail service add-on to configure the 
protocol. The "Advanced" button is visible only when the add-on is installed. 

Poll Rate The frequency in seconds to check the email server for new messages (de‐
fault = 30 seconds)

Server Server name or IP address for the "Send" (SMTP) and "Receive" (POP) email 
servers

Port Port number for the "Send" (SMTP) and "Receive" (POP) email servers
SSL Specifies whether the email server requires authentication for SSL

A secure version of SSL is recommended for better protection from sniffing 
and from spoofed acknowledgment responses.

Login Email address or user name that the Event Notifier will use to log on to the 
email server

Password Password for the "Login" account on the email server

4. Click "Save" to save the configuration. Click "Close" to exit.
The configuration is added to the list of configured communication services.

Modifying a communication service
1. Select the communication service name in the list.
2. Make the changes and then click "Save".

Deleting a communication service
1. Select the communication service name in the list.
2. Click "Remove" and then click "Save".
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6.4.1.2 Email server configuration

Reply mailbox   
The Event Notifier removes response email from the email servers as it processes the email.
Observe the following requirements:
• Each independent WinCC server running the Event Notifier Server must have a separate reply 

mailbox. Redundant systems would use the same mailbox.
• If email software (such as Microsoft Outlook, Outlook Express, Windows Live Mail) is used to 

monitor the reply mailbox, select the "Leave messages on server" check box on the 
"Advanced" tab of the account properties.

For POP3 email servers, the Event Notifier uses "User/Password" authentication as the default 
setting. It can also use APOP or NTLM authentication, if available on the email server. If "User/
Password" authentication fails, the Event Notifier will attempt to login using APOP and/or NTLM 
where available.

Message size limit
Message size limits provide a method to control mailbox sizes, guarantee service availability, and 
protect from potential denial-of-service attacks.
To control the mailbox size, configure a message size limit on the received messages. This way 
the email server rejects messages greater than a specified number of bytes. The location to 
configure the message size limit is different on the email servers.  Refer to your email server's 
documentation for more information.

6.4.1.3 Example of configuring Microsoft Exchange

Configuring a communication service   
This example shows the settings in the Communication Service Editor when the Event Notifier 
uses a Microsoft Exchange account.

Note
Obtain the email account information from your IT department.
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Field Value 1)

Name MyMailServer
Email Address 2) notifiy@company.com
Type SMTP/POP3
Poll Rate 30
Server 3) "Send" (SMTP): 1.1.1.1

"Receive" (POP): 1.1.1.1
SSL 4)  
Port "Send" (SMTP): 25

"Receive" (POP): 110
Login 5) notify@company.com
Password LoginPassword

1) A value in italics indicates user-defined information.
2) Event Notifier mailbox. This must not be the same as the email address of the contacts.
3) Server name or IP address
4) Authentication required when selected. Setting depends on your IT department's configuration.
5) Email address or user name. This may be different than the mailbox's "Email Address". Setting depends 

on the name provided by your IT department. Login information for "Send" is not required when using 
the same server to send and receive email.
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Configuration for contacts   
This example shows the settings in the Contact Editor when the communication service is 
configured for a Microsoft Exchange account.

Field Value 1)

Email Address 2) kate@siemens.com
Server Name MyMailServer

1) A value in italics indicates user-defined information.
2) Email address of the contact to receive notification email from the Event Notifier. This must not be the 

same email address configured for the communication service.
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6.4.1.4 Example of configuring Gmail

Configuring a communication service   
This example shows the settings in the Communication Service Editor when the Event Notifier 
uses a Gmail account.

Field Value 1)

Name MyMailServer
Email Address 2) <notifiy@gmail.com>
Type SMTP/POP3
Poll Rate 30
Server "Send" (SMTP): smtp.gmail.com

"Receive" (POP): pop.gmail.com
SSL 3) Check box for "Send" and "Receive" selected
Port "Send" (SMTP): 465

"Receive" (POP): 995
Login notify@gmail.com
Password LoginPassword

1) A value in italics indicates user-defined information.
2) Event Notifier mailbox, with the email address placed between "< >" symbols. This must not be the same 

as the email address of the contacts.
3) Authentication required
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Configuration for contacts   
This example shows the settings in the Contact Editor when the communication service is 
configured for a Gmail account.

Field Value 1)

Email Address 2) <kate@siemens.com>
Server Name MyMailServer

1) A value in italics indicates user-defined information.
2) Email address of the contact to receive notification email from the Event Notifier. The email address 

must be placed between "< >" symbols. This must not be the same email address configured for the 
communication service.
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6.4.1.5 Example of configuring Hotmail

Configuring a communication service   
This example shows the settings in the Communication Service Editor when the Event Notifier 
uses a Hotmail account.

Field Value 1)

Name MyMailServer
Email Address 2) <notifiy@hotmail.com>
Type SMTP/POP3
Poll Rate 30
Server "Send" (SMTP): smtp.live.com

"Receive" (POP): pop3.live.com
SSL 3) Check box for "Receive" selected
Port "Send" (SMTP): 25

"Receive" (POP): 995
Login notify@hotmail.com
Password LoginPassword

1) A value in italics indicates user-defined information.
2) Event Notifier mailbox, with the email address placed between "< >" symbols. This must not be the same 

as the email address of the contacts.
3) Authentication required when selected
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Configuration for contacts   
This example shows the settings in the Contact Editor when the communication service is 
configured for a Hotmail account.

Field Value 1)

Email Address 2) <kate@siemens.com>
Server Name MyMailServer

1) A value in italics indicates user-defined information.
2) Email address of the contact to receive notification email from the Event Notifier. The email address 

must be placed between "< >" symbols. This must not be the same email address configured for the 
communication service.
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6.4.1.6 Example of configuring Yahoo

Configuring a communication service   
This example shows the settings in the Communication Service Editor when the Event Notifier 
uses a Yahoo account.

Field Value 1)

Name MyMailServer
Email Address 2) <notifiy@yahoo.com>
Type SMTP/POP3
Poll Rate 30
Server "Send" (SMTP): smtp.mail.yahoo.com

"Receive" (POP): pop.mail.yahoo.com
SSL 3) Check box for "Send" and "Receive" selected
Port "Send" (SMTP): 465

"Receive" (POP): 995
Login notify@yahoo.com
Password LoginPassword

1) A value in italics indicates user-defined information.
2) Event Notifier mailbox, with the email address placed between "< >" symbols. This must not be the same 

as the email address of the contacts.
3) Authentication required

Note
Make sure that the "Send" and "Receive" SSL checkbox is selected while configuring a Yahoo 
account in the Communication Service Editor.
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Configuration for contacts   
This example shows the settings in the Contact Editor when the communication service is 
configured for a Yahoo account.

Field Value 1)

Email Address 2) <kate@siemens.com>
Server Name MyMailServer

1) A value in italics indicates user-defined information.
2) Email address of the contact to receive notification email from the Event Notifier. The email address 

must be placed between "< >" symbols. This must not be the same email address configured for the 
communication service.

6.4.2 Configuring notification schedules

6.4.2.1 Creating a calendar

Introduction     
You create calendars to allow subsets of schedules to display in Runtime. The Calendar Options 
contain a default calendar. The Calendar List Editor lets you create additional calendars and 
manage the list of calendars.
When creating a calendar, you choose a color for easy identification of the calendar and its 
schedules.
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Procedure
1. Select "Edit > Calendars" to open the Calendar List Editor.
2. Click "New".
3. Replace the default name with a unique name for the calendar.
4. Click the color picker arrow and select a color to associate with this calendar and its schedules.
5. To specify translated text (Page 162), click "Apply" and then click the "Locale" button. Enter 

the translated text for the calendar name in each language and click "OK".
6. Click "OK".

The calendar is added and sorted alphabetically in the "Resources" window. The calendar can 
be selected in the schedule editor.

6.4.2.2 Creating a notification schedule

Introduction     
You create notification schedules to set the time to email WinCC users when alarms occur. You 
create the schedules using the Notification Schedule Editor by selecting contacts and 
notifications from preconfigured lists or by configuring new contacts and notifications.
A schedule designates contacts to receive the selected notifications between the specified start 
and end time. Each contact is assigned an escalation time that indicates the minutes an alarm 
must remain unacknowledged before the contact is notified.

Procedure
1. Double-click a date or time slot in the data window to open the Notification Schedule Editor.

Note
If other schedule types are available, the notification schedule preference must be selected 
as the default schedule type for this editor to open when double-clicking a date or time slot. 
To set the preference, click "View > Preferences > Default Schedule Type > Notification".

2. In the "Name" field, enter a name for the notification schedule.
3. Optionally, enter information to describe the schedule in the "Description" box.
4. Set the "Start Time" to activate and the "End Time" to deactivate the schedule.
5. Under "Contacts", choose the contacts for this schedule:

– To choose from a list of preconfigured contacts and contact groups, click "Select". Select 
the contacts and click "OK".

– To configure a new contact, click "Add New". The Contact Editor opens for you 
to configure a contact or contact group (Page 154) to attach to the schedule.

– For each contact, set an "Escalation" time in minutes that an alarm must remain 
unacknowledged before the contact is notified. A "0" indicates the contact is notified 
immediately.
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6. Under "Notifications", choose the notifications to send to the selected contacts:
– To choose from a list of preconfigured notifications, click "Select". Select the notifications 

and click "OK".
– To configure a new notification, click "Add New". The Notification Editor opens for you 

to configure a notification (Page 157) to attach to the schedule.
7. Click the "Calendar" arrow and select the calendars where the schedule is to display. Click 

outside the list.
Note
Clicking  closes the list without saving the selections made.
If you do not select a calendar, the schedule is associated with the "Default" calendar.

8. To configure the schedule to repeat, click "Recurrence". Set the desired recurrence pattern 
and time (Page 160) and click "OK".

9. To specify translated text (Page 162), click "Apply" and then click the "Locale" button. Enter 
the translated text for the schedule name in each language and click "OK".

10.After you finish configuring the schedule, click "OK".

Note
Connection to SMTP
The generated Alarm notifications will be lost if the connection to the SMTP server is lost.
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Results
The notification schedule displays in the selected calendars at the specified times. The color of 
a schedule is the same as its associated calendar. The way the schedule color (Page 181) displays 
depends on the selection of multiple calendars in the "Resources" window and a multi-resource 
view.
An arrow displays in a date or time slot when it contains schedules that are not visible. Clicking 
the arrow displays the additional schedules in the "Agenda" list.

6.4.2.3 Creating contacts and contact groups

Introduction       
You create contacts to receive the notifications generated when an alarm occurs. A contact is a 
WinCC user with a specified email address. Only users created in the WinCC User Administrator 
can be a contact. Each contact must have a communication service through which messages are 
sent.
A contact can be in multiple contact groups. Contact associations (Page 156) are created when 
a contact is used in multiple groups.
To prevent unauthorized use of a contact in Runtime, you can set a user authorization on the 
contact.
After a contact is configured, it appears in the "Contacts" list so that you can use the contact again 
for creating schedules quickly.

Creating a contact group     
1. Select "Edit > Contacts" to open the Contact Editor.

Note
While creating or modifying a schedule, you can click "Add New" to open the Contact Editor 
and configure a new contact to attach to the schedule.

2. Under "Contacts", right-click "Contacts" and choose "Add Group".
3. Replace the default name with a descriptive name and press <Enter>.
4. Click the color picker arrow and select a color from the color palette to associate with this 

contact group.
5. To specify translated text (Page 162), click "Apply" and then click the "Locale" button. Enter 

the translated text for the contact group name in each language and click "OK".
6. Save the configuration.
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Creating a contact
1. Open the Contact Editor.
2. Under "Users", select a WinCC user name and drag it to a contact group. Optionally, right-click 

and drag the user to a contact group so you can create an alias name for the contact.
Note
To create additional WinCC users and groups, right-click in the "Users" area and select "User 
Administration". Information about user groups and administration is in the WinCC 
Information System under "Working with WinCC > Structure of the User Administration".

3. Expand the group name and select the contact, so that its name displays under "Contact 
Properties".

4. Click the color picker arrow and select a color from the color palette to associate with this 
contact.

5. Click the language selector arrow and choose which language to display email for the 
contact. The languages configured with the WinCC project display.

6. Enter the email address for the contact. Click the "Server Name" arrow and select the 
configured communication service (Page 141) for your email server.

7. To permit only authorized users to create schedules using this contact, click "Authorization". 
Choose an authorization that is defined in the User Administrator and click "OK".

8. Save the configuration.
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Results
The new contact and contact group are added to the "Contacts" list for use in configuring 
schedules. Both are added and sorted alphabetically in the "Resources" window.

If the contact was created while configuring a schedule, the contact is added to the "Contacts" 
area in the Notification Schedule Editor.

6.4.2.4 Creating contact associations

Introduction   
You create contact associations when a contact is used in multiple groups. Selecting the WinCC 
user lets you see all contacts and alias names created for this user.

WinCC/Event Notifier Documentation
6.4 Configuration

WinCC/Calendar Options
156 System Manual, 11/2020, A5E49472488-AA



Procedure
1. Select "Edit > Contacts" to open the Contact Editor.
2. Choose either of these ways to create a contact association:

– Drag a WinCC user to a contact group and then drag this user to another contact group.
After configuring one of the contacts, its configuration is applied to the other occurrences 
of the contact.

– Click a contact in a group and drag it to another group.
The contact with its configuration is copied to the other group.
Note
To move a contact to another group, right-click the contact and drag it to another group.

3. Select the user to see all contacts and alias names associated with this user.
The contact groups expand to display all associated contacts in red.

6.4.2.5 Creating a notification

Introduction       
You create a notification to specify a subset of the configured messages. Each notification 
contains message blocks and selection filter criteria that determine which message information 
to send when an alarm occurs. Notifications are used in schedules to indicate which contacts are 
to receive the email.
To prevent unauthorized use of a notification in Runtime, you can set a user authorization on the 
notification.
After a notification is configured, it appears in the "Notifications" list so that you can use the 
notification again for creating schedules quickly.

Character length of the "Subject"
The Event Notifier stores a 34 character unique ID in the "Subject" line of notification email. This 
ID is necessary in the "Subject" line when contacts reply to email. The Event Notifier Server uses 
this ID to acknowledge the correct alarm.
Because some devices have a short subject length, consider the additional length required for 
the ID when configuring the "Subject" field of a notification. The character length is determined 
by the maximum width of the text display minus 34.
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Procedure
1. Select "Edit > Notifications" to open the Notification Editor.

Note
While creating or modifying a schedule, you can click "Add New" to open the Notification 
Editor and configure a new notification to attach to the schedule.

2. In the "Name" field, replace the default name with a descriptive name for this notification.
Although you can keep the default name, it is recommended that you rename the 
notification for easy recognition.

3. Click the color picker arrow and select a color from the color palette to associate with this 
notification.

4. Under the "Selection" tab, click the "Criteria" arrow and choose an available message block. 
Click the "Operator" arrow and choose a Boolean operator, such as "equal to". Depending on 
the selected message block, enter text or a value, or select an option in the "Setting" column.
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5. Under the "Message Blocks" tab, configure the content to display in the subject and body of 
notification email and response email:
– Select the message blocks to define for the notification.

The message blocks are configured in WinCC Alarm Logging. Information about message 
blocks is in the WinCC Information System under "Working with WinCC > Setting Up a 
Message System > Configuring the Message System".

– Define the content for this notification email by entering text and dragging message 
blocks into the "Subject", "Message", and "Acknowledge" fields.
The same subject is used for the response email and its related notification email. The 
message of the notification email can be blank depending on the recipient.

NOTICE
Sensitive information in notifications
Email is not a secure method for transmitting sensitive data. A best practice is to avoid 
configuring sensitive and proprietary information in a notification that may display in 
email.

6. To permit only authorized users to create schedules using this notification, click 
"Authorization". Choose an authorization that was defined in the User Administrator and click 
"OK".

7. To prevent contacts from acknowledging the alarm condition in this notification by email, 
select "Disable Acknowledgment".
This is useful when an alarm is a high-priority critical alarm and only an authorized operator 
can acknowledge the alarm. If email acknowledgment was allowed, the alarm 
acknowledgment could be spoofed.
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8. To specify translated text (Page 162), click "Apply" and then click the "Locale" button. Enter 
the translated text in each language and click "OK".
A "Locale" button displays for the notification name and for the "Subject", "Message", and 
"Acknowledge" fields. Names and content structure not configured with translated text will 
display in the language configured for the Calendar Option.

9. Save the configuration.

Results
The new notification is added to the "Notifications" list for use in configuring schedules. The 
notification is also added and sorted alphabetically in the "Resources" window.

If the notification was created while configuring a schedule, the notification is added to the 
"Notifications" area in the Notification Schedule Editor.

6.4.2.6 Configuring a recurring schedule

Introduction       
A recurring schedule is one schedule configured to repeat multiple times. Rather than adding the 
same schedule to a calendar several times, you can configure one recurring schedule that 
appears in the calendar at the specified dates and times.
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Procedure
1. Create a new schedule or double-click a schedule to display its configuration.
2. In the editor, click "Recurrence" to open the "Recurrence" dialog.

3. Under "Recurrence time", set the time the schedule is to start and end.
This step is not necessary if you are adding a recurrence to a schedule where the time remains 
the same.

4. Under "Recurrence pattern", choose the frequency the schedule is to repeat.
You can set the schedule to repeat by the minute, hour, day, week, month, or year. Different 
options display based on the frequency you choose.
Example: To set a schedule to repeat every Friday, you would select "Weekly" and "Friday" and 
set "Recur every" to "1".
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5. Under "Range of recurrence", select when you want the recurrence pattern to start and end:
– The recurrence has no end.
– The recurrence is to end after a specified number of occurrences.
– The recurrence is to end at a specified date.

6. After you finish configuring the recurrence, click "OK".
The schedule displays in the calendar at the times specified in the recurrence pattern. In 
Runtime, the recurrence symbol  displays to identify the schedule as recurring.

6.4.2.7 Adding translated text

Introduction           
You can specify text to represent the translated names of schedules and resources to display in 
Runtime. Names not configured with translated text will display in the language configured for 
the Calendar Option. Depending on the installed Calendar Options, a schedule can be an action 
schedule or notification schedule. A resource can be an action, notification, contact group, or 
calendar.

Procedure
1. Open the appropriate editor and display the configuration for a schedule or resource.
2. Click the "Locale" button  to open the Locale Editor.

The languages configured with the WinCC project display. You can make more languages 
available by opening the "Text Library" editor and selecting "Language > Add/Remove". 
Information about the text library is in the WinCC Information System under "Setting Up 
Multilingual Projects".
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3. For each displayed language, click in the "Name" field and enter the translated text to display 
for the name.

4. Click "OK".
5. Save the configuration.

6.4.2.8 Setting user authorizations

Introduction
The management of the user rights for the Calendar Options takes place in the WinCC User 
Administrator. Users are assigned various authorizations in it for operating and monitoring 
purposes.
The tasks of the WinCC User Administrator include:
• Creation and editing of users and user groups.
• Assignment and administration of access rights known as authorizations.
After users are configured in the User Administrator, you will need to assign authorizations to 
them. You can create authorizations for frequently used calendar scheduling functions.

Configuring user administration     
1. If desired, create authorizations for frequently used calendar scheduling functions in the 

User Administrator.
Example authorizations are "Production Line 1 Manager" and "Calendar Editing". Information 
about user administration is in the WinCC Information System under "Working with WinCC > 
Structure of the User Administration".

2. Create groups and users and assign the appropriate authorizations.

Setting authorizations on resources     
You can set an authorization on a resource to permit only authorized operators to create 
schedules using this resource. When operators attempt to select a resource they are not 
authorized to use, they receive the "Insufficient permission" message. When operators attempt 
to modify a schedule that contains at least one unauthorized resource, the schedule remains at 
its preconfigured date and time.
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Depending on the installed Calendar Options, a resource can be an action, notification, or 
contact.

Note
Operators can select a resource that is not assigned an authorization. To prevent unauthorized 
operators from creating or modifying any schedules, set an authorization on all resources.

1. In the editor, select the name of the resource to display its configuration.
2. Click "Authorization".
3. Choose an authorization that was defined in the User Administrator and click "OK".
4. Save the configuration.

6.4.3 Modifying notification schedules

6.4.3.1 Modifying contacts and notifications

Introduction
You can add or change the contacts and notifications used in a schedule from the Notification 
Schedule Editor. You can modify the configurations from the Contact Editor and the Notification 
Editor. You can quickly move a contact to a different contact group.
Any modifications to a contact or notification take effect immediately in all schedules where the 
contact or notification is referenced.

Adding to a schedule     
1. Double-click a notification schedule to display its configuration in the editor.

If the schedule is configured with a recurrence, right-click the schedule and choose "Edit 
Series". For more information, see editing the recurrence series (Page 169).

2. Click the "Select" button under "Contacts" or "Notifications".
3. In the list, select preconfigured contacts or the notifications that the contacts can receive and 

click "OK".
Note
You can configure a new contact or a new notification by clicking "Add New" to attach to this 
schedule.

4. For each contact, set an "Escalation" time in minutes.
5. Save the configuration.
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Changing the configurations       
1. Display the configuration for a contact or notification in its editor.

– From the Notification Schedule Editor, right-click a contact or notification row and choose 
"Edit".

– From the Calendar Options Editor, select "Edit > Contacts" or "Edit > Notifications".
2. Make the changes and click "OK".

Note
To move a contact to another group, right-click the contact and drag it to the desired contact 
group.
The changes take effect immediately in all schedules where the contact or notification is 
referenced.

6.4.3.2 Renaming schedules and resources

Introduction
You can rename schedules and resources. You can quickly rename a schedule from a calendar 
view in the data window. The editors let you rename and make additional changes to the 
schedules and resources.
Depending on the installed Calendar Options, a schedule can be an action schedule or 
notification schedule. A resource can be an action, notification, or calendar.

Note
You cannot rename the "Default" calendar.

Renaming a resource   
1. In the appropriate editor, select the resource you want to rename.
2. Enter a new name.
3. If the previous resource name contained translated text, click the "Locale" button. Change the 

entries to reflect the new translated names and click "OK".
4. Save the configuration.

The new name appears in the list of preconfigured resources, the "Resources" window, and 
the schedules that reference it.
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Renaming a schedule   
From calendar view in the data window
1. Click the schedule to highlight it and then click again.
2. Enter a new name.

If this schedule is in a recurrence series, the name changes only for the selected date. The 
name and time of other occurrences in the series do not change.

From the editor
1. Double-click the schedule. Optionally, right-click the schedule and choose "Open".
2. In the editor, enter a name and click "OK".

If this schedule is in a recurrence series, the name changes only for the selected date. The 
name of other occurrences in the series does not change.

Renaming a recurring schedule   
1. Right-click a schedule configured with a recurrence and choose "Edit Series".
2. In the editor, enter a name and click "OK".

The name changes for all occurrences of the schedule.

6.4.3.3 Renaming contacts and contact groups

Introduction
You can rename contacts and contact groups.
If a WinCC user is renamed, the "Users" area reflects this change.

Renaming a contact   
1. In the Contact Editor, expand the contact group and select the contact.
2. Right-click and choose "Rename Contact".
3. Enter a unique name and press <Enter>.
4. Save the configuration.

Renaming a contact group   
1. In the Contact Editor, select the contact group.
2. Right-click and choose "Rename Group".
3. Enter a unique name and press <Enter>.
4. If the previous contact group contained translated text, click the "Locale" button. Change the 

entries to reflect the new name and click "OK".
5. Save the configuration.
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Results
The new contact or contact group name appears in the list of preconfigured contacts and in the 
"Resources" window. The contact or contact group is renamed in the schedules that reference it.

6.4.3.4 Changing schedule dates

Introduction   
Schedules are labeled in the calendars according to the start and end time. You can quickly 
change a schedule by dragging it to the desired date and time in a calendar view. You can also 
drag the schedule to a date in the "Date Navigation" window. The day and work week views allow 
you to quickly change the duration of a schedule. The editor lets you change the date and time 
and make additional changes.

Dragging and dropping schedules     
In the displayed calendar view
Day: Drag the schedule to the desired time slot on the same day.

The schedule moves to the selected time. The configured duration 
remains the same. Depending on the selected time, the schedule 
may extend into another day.

Work Week: • Drag the schedule to the desired time slot on the same day. The 
schedule moves to the selected time.

• Drag the schedule to another displayed day and time slot. The 
schedule moves to the selected day and time slot.

The configured duration remains the same. Depending on the selec‐
ted time, the schedule may extend into another day.

Week, Month, or Timeline: Drag the schedule to another day in the displayed view.
The schedule moves to the selected date. The configured time and 
duration remain the same.

To the "Date Navigation" window
From any calendar view, drag the schedule to a date in the "Date Navigation" window. The 
schedule moves to the selected date. The configured time and duration remain the same.

Changing the duration   
1. Select a schedule in the day or week view.
2. Move the mouse arrow over the start or end border until the arrow changes to a vertical 

arrow.
3. Drag the border to the desired time and then release.
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Changing dates in the editor   
1. Display the configuration for a schedule or recurring schedule in the editor.
2. Under "Start Time" and "End Time", set the time the schedule is to start and end.
3. Click "OK".

The schedule moves in the selected calendars to the modified date and time.

6.4.3.5 Changing a schedule and resource color

Introduction
You can change the color defined for a schedule or resource. You can also delete a schedule from 
a calendar and add it to another calendar. The way the schedule or resource color (Page 181) 
displays depends on the selections in the "Resources" window and the selected calendar view 
and multi-resource view. Depending on the installed Calendar Options, a schedule can be an 
action schedule or notification schedule. A resource can be an action, notification, contact, 
contact group, or calendar.

Changing a resource color   
1. In the appropriate editor, select the resource name whose color you want to change.
2. Click the color picker arrow and choose a color.
3. Click "OK".

The color changes everywhere the selected resource name is used. If a calendar color is 
changed, the color changes for all schedules in that calendar.

Changing a schedule to a different calendar     
1. Display the configuration for a schedule or recurring schedule in the editor.

Note
For a recurring schedule, you must edit the series. You cannot set an occurrence of the 
schedule in different calendars.

2. Click the "Calendar" arrow and choose the calendars:
– Click a previously selected calendar to remove the schedule from that calendar.
– Select the calendars where the schedule is to display. Click outside the list.

Note
Clicking  closes the list without saving the selections made.

3. Save the configuration.
The schedule displays in the selected calendars. The schedule color changes to match the 
color of each associated calendar.
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6.4.3.6 Modifying or restoring a recurring schedule

Introduction   
Modifying occurrences in a recurring schedule provides time-saving ways of working with 
schedules. You can override a schedule for a particular day, without changing the initial 
configured time of the recurring schedule. For example, you might want the schedule to start 
and end at a different time on one day.
You can make changes to all occurrences in the recurring schedule or change an occurrence for a 
specific day. In case you want to revert a recurring schedule to its initial configuration, you can 
remove all overrides.

Editing the recurrence series   
1. Right-click a schedule configured with a recurrence and choose "Edit Series".
2. Make the desired changes.
3. Click "Recurrence" to edit the recurrence pattern and time (Page 137) in the "Recurrence" 

dialog. Click "OK".
4. When the confirmation message to remove the exceptions associated with this recurring 

schedule displays, click "Yes".
Any overrides made previously to this recurring schedule will be removed.

5. Click "OK" to save the configuration.
The modifications take effect immediately for all occurrences of the schedule.

Note
Modifying an instance of a recurring schedule
The "Recurrence" button is disabled if the user opens a single instance of a recurring schedule as 
the modification applies only to that instance.

Overriding a recurrence series   
1. Double-click the schedule on the date you want to change. Optionally, right-click the 

schedule and choose "Open".
2. Make the desired changes.
3. Click "OK".

The modifications take effect immediately only for the selected date and do not change the 
other occurrences in the series.
Note
You can quickly override a date and time by dragging the schedule to the desired date.
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Restoring a recurring schedule     
Restoring one override
Right-click an occurrence of the schedule that contains an override and choose "Restore Default 
State". Only this occurrence of the schedule changes to the initial configured state of the 
recurring schedule.

Restoring all overrides
1. Right-click any occurrence in the recurring schedule and choose "Edit Series".
2. In the editor, click "Recurrence".
3. In the "Recurrence" dialog, click "OK" without making any changes.
4. Click "Yes" when the confirmation message displays. Click "OK" to close the editor.

All modified and deleted occurrences are returned to the initial configured state of the 
recurring schedule. All occurrences of this schedule now have the same settings.

Removing a recurrence   
1. Right-click any occurrence in the recurring schedule and choose "Edit Series".
2. In the editor, click "Recurrence".
3. In the "Recurrence" dialog, click "Remove Recurrence".
4. Click "OK" to close the editor.

All occurrences except the initial configured instance of the schedule are removed.
Note
Rather than removing a recurring schedule, you may want to change the "End by" time so you 
can keep a record of past occurrences.

6.4.3.7 Deleting contacts and notifications

Introduction     
You can delete contacts, contact groups, and notifications. Deleting a contact or notification 
from a schedule does not remove its configuration from the calendars. The contact or 
notification remains available in the "Contacts" or "Notifications" list for configuring other 
schedules.
In the Contact Editor, you can delete a contact from a contact group or delete a contact 
configuration when the contact is not used in a schedule. Deleting the configuration completely 
removes the contact from the calendars and the "Contacts" list.
Deleting a notification from the Notification Editor removes its configuration completely from 
the calendars. You cannot delete a notification if it is used in a schedule.
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Effects of a deleted WinCC user
Deleting a contact configuration does not delete the WinCC user. Users are managed in the User 
Administrator. For more information, see the WinCC Information System under "Working with 
WinCC > Structure of the User Administration".
If a WinCC user is deleted, the user is not displayed in the "Users" area of the Contact Editor. The 
contact associations still exist. The contact's icon changes to a red X to indicate the associated 
user no longer exists.

Prerequisite
Before you can delete all occurrences of a contact or notification, you must delete the contact or 
notification from all schedules.
You can use the "Resources" window to find these schedules.
Example: To display all schedules that reference the contact "Desmond", select only "Desmond" 
in the "Resources" window. The check box next to the other resource groups should not be 
selected.

Deleting contacts or notifications from a schedule     
1. Double-click a notification schedule to display its configuration in the editor.

If the schedule is configured with a recurrence and you want to delete the contact or 
notification from the series, right-click the schedule and choose "Edit Series".

2. Choose which contacts or notifications to delete:
– To delete one or multiple contacts or notifications:

Select the desired rows in the "Contacts" or "Notifications" area. Right-click and choose 
"Delete".
When selecting rows, click a row to highlight it. To select a range, press <Shift> while 
clicking another row. All contacts or notifications between the two rows that you clicked 
are selected. To select multiples, press <Ctrl> while clicking additional rows. All contacts 
or notifications that you clicked are selected

– To delete all contacts or notifications:
Right-click anywhere in the "Contacts" or "Notifications" area and choose "Clear".

3. Save the configuration.

Deleting a contact from a group   
1. In the Contact Editor, expand the contact group and select the contact.
2. Right-click and choose "Delete Contact".
3. When the message appears, choose to delete this contact from the group and click "OK".

The contact is deleted only from the selected group.
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Deleting a contact configuration     
1. In the Contact Editor, expand the contact group and select the contact.
2. Right-click and choose "Delete Contact".
3. When the message appears, choose to delete all occurrences of this contact and click "OK".

If the contact has associations in other groups, a message displays to confirm deletion of this 
contact and all associations. After confirmation, the contact is deleted from all groups, the 
"Contacts" list, and the "Resources" window. The contact is no longer available for 
configuring schedules.

Deleting a contact group   
1. In the Contact Editor, select the contact group.

You must delete all contacts from a group before you can delete it.
2. Right-click and choose "Delete Group".

Deleting a notification configuration     
1. In the Notification Editor, select the notification to delete.
2. Click "Delete".

The notification is deleted from the "Notifications" list and the "Resources" window. The 
notification is no longer available for configuring schedules.

6.4.3.8 Deleting schedules and calendars

Introduction     
You can delete schedules and calendars. Deleting a schedule removes the schedule and its 
associated resources from the selected calendars. The resources are not removed from the 
selection lists and are available for configuring other schedules. Depending on the installed 
Calendar Options, a resource can be an action, notification, contact, or contact group.
You can override a recurrence series by deleting a schedule on the date you do not want it to 
execute. This override does not change the default configuration of the recurring schedule.
Deleting a calendar removes the entire calendar and its associated schedules. A schedule 
referenced in the deleted calendar is removed, but remains in the other calendars.

Deleting a schedule from the calendar view 
1. Right-click the schedule and choose "Delete". Optionally, click the schedule and press 

<Delete>.
2. If the schedule is in a recurrence series, a message displays asking if you want to delete all 

occurrences or only the occurrence of the selected day and time. Choose what to delete and 
click "OK".
Deleting the selected occurrence is an override to the schedule and does not affect the other 
occurrences in the series. Deleting the series deletes all occurrences of the schedule.
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Deleting a schedule from the editor
1. Double-click a schedule to display its configuration in the editor.
2. To delete a schedule from a calendar, click the "Calendar" arrow and unselect the calendar. 

Click "OK".
3. To delete a schedule from all selected calendars, click "Delete".

If the schedule is in a recurrence series, only the occurrence for the selected day and time is 
deleted.

Deleting a recurring schedule from the editor   
1. Right-click a schedule and choose "Edit Series".
2. In the editor, click "Delete".

All occurrences of the schedule are deleted.
Note
Rather than deleting a recurring schedule series, you may want to modify the schedule and 
change the "End by" time in the "Recurrence" dialog so you can keep a record of past 
occurrences.

Deleting a calendar     
1. In the Calendar List Editor, select the calendar name to delete.

You cannot delete the "Default" calendar.
2. Click "Delete". When the confirmation message to delete this calendar and its associated 

schedules appears, click "OK".
The entire calendar and all schedules associated with this calendar are deleted permanently. 
The calendar name is removed from the "Resources" window in the Calendar Options Editor.

6.4.4 Configuring the Calendar Control

6.4.4.1 Calendar Control
The Calendar Control is a .NET control that can be inserted into WinCC pictures using the WinCC 
Graphics Designer. The control in WinCC pictures at Runtime allows operators to view calendars. 
The control allows an operator to create, edit, and delete schedules.   
You can configure this control to display the schedules of one or more configured calendars. 
View options provide single or multiple months, weeks, or days in a single view of the schedules. 
Additionally, you can configure a multi-resource view to show the schedules of multiple 
resources at the same time. Each date area in a multi-resource view displays the schedules 
associated with the selected resource.
The values assigned to the attributes of the control's object properties determine how the 
calendar displays to the operators in Runtime. You can set properties for the opening calendar 
view, work shift view, and navigation capabilities. In addition to providing the means for 

WinCC/Event Notifier Documentation
6.4 Configuration

WinCC/Calendar Options
System Manual, 11/2020, A5E49472488-AA 173



displaying and editing the schedules, the control's intrinsic events can be configured to trigger 
tag and C-script actions. 

6.4.4.2 Configuring the Calendar Contol

Introduction     
You insert the Calendar Control into WinCC pictures and configure the control to display the 
schedules associated with a calendar. You can customize the opening view and set properties to 
prevent or allow operators to use functions of the Calendar Control.

Procedure
1. In the Graphics Designer, either create a new picture or open a picture where you want to 

insert a calendar.
2. In the Object Palette, click the "Controls" tab. Under ".NET controls", click 

"WinCC_Calendar.Calendar" and drag the control to the desired size in the picture.
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3. Double-click the control. Click "Control properties" and set the attributes:
– To configure how you want the calendar to display, set the appearance attributes 

(Page 176) of the object properties.

– To prevent or allow operators to use functions of the Calendar Control, set the navigation 
and usage attributes (Page 177) of the object properties.

4. Save the picture.
You can click the "Activate" button on the toolbar to see the appearance of the Calendar 
Control in Runtime.
This figure shows the Calendar Control configured to display schedules in the day calendar 
view.
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6.4.4.3 Changing appearance of the Calendar Control

Introduction
You can set the properties in the WinCC Calendar Control to customize the opening view of a 
calendar in a particular WinCC picture. Additional pictures can contain calendars set to open 
with different views. You can set the properties for these pictures to restrict the view and 
scheduling to specific areas of a process, equipment, or personnel.

Prerequisite
• You opened the Graphics Designer and configured a picture with the Calendar Control.
• The object properties dialog of the Calendar Control is open.

Setting the opening calendar view   
Double-click "ActiveViewType". Choose the standard calendar view to display when the calendar 
is opened: "Day", "Week", "Month", "WorkWeek", or "Timeline".
If you want a multi-resource view to display, double-click "GroupType" and choose "Date" or 
"Resource".
The control changes to reflect the selection.

Setting the default selected calendar   
Double-click "SelectedCalendar". Enter the calendar name exactly as it appears in the 
"Resources" window and click "OK".
In Runtime, only the specified calendar and its schedules display on initial opening.
An incorrect calendar name entry results in no calendar selected and no schedules displaying on 
initial opening. To have all calendars selected with schedules displaying, leave the attribute 
value blank.

Setting a work shift   
To set the start time:
Double-click "WorkStartTime". Enter the start time in 24-hour format (hours:minutes:seconds). 
Click "OK".
To set the end time:
Double-click "WorkEndTime". Enter the end time in 24-hour format (hours:minutes:seconds). 
Click "OK".
In Runtime, the control displays the specified time period in a different color than the 
background color.
To restrict the calendar view to display only the work shift time period:
Doublie-click "ShowWorkTimeOnly" to set the attribute to "True". Double-clicking toggles 
between "True" and "False". The work shift is visible in the day and work week calendar views.
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6.4.4.4 Changing navigation and usage of the Calendar Control

Introduction     
You can set the properties in the WinCC Calendar Control to customize the navigation 
capabilities in Runtime. You can set properties to prevent or allow operators to use functions of 
the Calendar Control.

Prerequisite
• You opened the Graphics Designer and configured a picture with the Calendar Control.
• The object properties dialog of the Calendar Control is open.

Preventing resources selection   
Double-click "ShowResources" to set the attribute to "False". Double-clicking toggles between 
"True" and "False".
When the attribute is "False", the control hides the "Resources" window. In Runtime, the operator 
cannot select and view other resources.

Preventing date navigation   
Double-click "ShowNavigation" to set the attribute to "False". Double-clicking toggles between 
"True" and "False".
When the attribute is "False", the control hides the date navigation window. In Runtime, the 
operator cannot select a date or date range to display future or previous schedules in the data 
window.

Preventing schedule editing   
Double-click "ViewOnly" to set the attribute to "True". Double-clicking toggles between "True" 
and "False".
When this attribute is "True", the control places the data window in view-only mode. In Runtime, 
the operator cannot create and edit schedules.

Restricting schedule editing to authorized operators   
Double-click "OperatorAuthorization". Select a predefined standard authorization in the WinCC 
User Administrator and click "OK". User-defined authorizations are not available for selection.
A logged in operator who is not assigned with the selected authorization can only view 
schedules. An operator with this authorization can create and edit schedules.
When this attribute is "NoAccessProtection", an authorization is not required. All operators can 
create and edit schedules using the actions, contacts, and notifications they are authorized to 
use.
Information about user administration is in the WinCC Information System under "Working with 
WinCC > Structure of the User Administration".
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6.4.4.5 Calendar Control object properties

Control properties     
The attributes in the Calendar Control object properties let you set how the calendar is to display 
in Runtime. You can customize the opening view and set properties to prevent or allow operators 
to use functions of the calendar control.

ActiveViewType
This attribute defines the default calendar view that displays when the Calendar Options Editor 
is opened. The schedules in the configured calendars display in the selected view in the data 
window. Double-clicking the attribute displays the following choices:

Day Displays a 24-hour day format.
Week Displays all 7 days of the week, beginning with Monday.
Month Displays in a monthly format, beginning with the week that contains the se‐

lected day or date range.
WorkWeek Displays a 5-day week, 24-hour day format. A work week contains Monday 

through Friday.
Timeline Displays in a timeline format. A timeline highlights 15 days and begins with the 

selected day or first day of a date range.
The default value is "Month".

DefaultScheduleType
This attribute defines the default schedule type to open when double-clicking a date or time slot 
in the Calendar Options Editor. Double-clicking the attribute displays the following choices:

Action Sets the Action Schedule Editor to open.
Notification Sets the Notification Schedule Editor to open.
The default value is "Action" if both Calendar Options are installed.

GroupType
This attribute defines whether to place the Calendar Control in a multi-resource view in addition 
to the standard calendar views. The way the grouping displays depends on the selected calendar 
view. Double-clicking the attribute displays the following choices:

None Grouping is off so that only the standard calendar view is visible.
Date Grouping is by dates displayed horizontally with the resources underneath 

displaying either horizontally or vertically.
Resource Grouping is by resources displayed horizontally with the dates underneath 

displaying either horizontally or vertically.
The default value is "None".
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OperatorAuthorization
This attribute defines whether to place the Calendar Control in view only mode for unauthorized 
operators. Double-clicking the attribute lets you select a predefined standard authorization in 
the WinCC User Administrator. User-defined authorizations are not available for selection.
A logged in operator who is not assigned with the selected authorization can only view 
schedules. An operator with this authorization can create and edit schedules.
Setting the attribute value to "NoAccessProtection" indicates no authorization is required. All 
operators can create and edit schedules using the actions, contacts, and notifications they are 
authorized to use.
The default value is "<No access protection>".

ProjectName
This attribute identifies the project name that is used to configure the Calendar Control for 
WebNavigator.
The default value is blank.

SelectedCalendar
This attribute defines whether to display the schedules of a specific calendar or all calendars 
when the Calendar Options Editor is opened initially in Runtime. Double-clicking the attribute 
opens a dialog for you to enter the calendar name exactly as it appears in the "Resources" 
window.
An incorrect calendar name entry results in no calendar selected and no schedules displaying on 
initial opening. 
The default value is blank.

ServerName
This attribute identifies the server that the Calendar Option is accessing. Double-clicking the 
attribute opens a dialog for you to connect to a different server name.
This attribute is useful in WinCC solutions where clients can be connected to multiple servers.
The default value is the server name where the WinCC project is connected.

ShowNavigation
This attribute defines whether to allow or prevent the operator's capability to use date navigation 
in the calendar. Double-clicking the attribute toggles between "True" and "False".
When this attribute is "False", the control hides the "Date Navigation" window. The operator 
cannot select a date or date range to display future or previous schedules in the data window.
The default value is "True".
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ShowResources
This attribute defines whether to allow or prevent the operator's capability to select resources. 
Double-clicking the attribute toggles between "True" and "False".
When this attribute is "False", the control hides the "Resources" window. The operator cannot 
select and view other resources.
The default value is "True".

ShowStatus
This attribute defines whether to display or hide the status bar. Double-clicking toggles between 
"True" and "False".
When this attribute is "True", the operator can see the status bar.
The default value is "False".

ShowWorkTimeOnly
This attribute defines whether to restrict the day and work week calendar views to the time 
frame specified in the "WorkStartTime" and "WorkEndTime" attributes. Double-clicking the 
attribute toggles between "True" and "False".
When this attribute is "True", the calendar view displays only the work shift time period. An 
operator can see only the schedules within the specified work shift.
When this attribute is "False", the calendar view displays all 24 hours and the schedules.
The default value is "False".

ViewOnly
This attribute defines whether to allow or prevent the operator's capability to create and edit 
events. Double-clicking the attribute toggles between "True" and "False".
When this attribute is "True", the control places the data window in view-only mode and prevents 
the operator from creating and editing schedules.
The default value is "False".

WorkStartTime
This attribute defines a time for a work schedule shift to start in the calendar. When set with the 
"WorkEndTime" attribute, the control displays the specified time period in a different color than 
the background color. Double-clicking the attribute opens a dialog for you to enter the start time 
in 24-hour format (hours:minutes:seconds).
The default value is "09:00:00".
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WorkEndTime
This attribute defines the time for a work schedule shift to end in the calendar. When set with the 
"WorkStartTime" attribute, the control displays the specified time period in a different color than 
the background color. Double-clicking the attribute opens a dialog for you to enter the end time 
in 24-hour format (hours:minutes:seconds).
The default value is "18:00:00".

6.5 Operation in Runtime

6.5.1 Event Notifier in Runtime

Preconfigured schedules     
The Event Notifier Server sends an email to the associated contacts when active alarm messages 
match the configured notification schedules between the specified start and end time. Email is 
also sent to the contacts when the messages remain unacknowledged.
The preconfigured notification schedules and the opening view of the calendar that operators 
see are determined during configuration. Any functions of the Calendar Control that an operator 
is allowed to use can be configured.

Schedules and resource colors
In standard calendar views, a schedule displays in the color of the associated calendar. If a 
schedule is associated with multiple calendars, the color of the schedule displays as one of the 
selected calendars. Typically, the color displays as the first selected calendar when the schedule 
was configured.
In multi-resource views (Page 185), the color configured for a selected resource displays as the 
background color for the resource in the data window. The schedule displays as a neutral color 
to complement the background color.
The following symbols may display on a schedule:

Displays during the start and end time of an active schedule.
Identifies a recurring schedule.
Indicates whether the start or end time of a schedule occurs from 0:00 to 11:59 (12:00 AM to 
11:59 AM). This symbol displays in the timeline view or when the schedule covers a range of days.
Indicates whether the start or end time of a schedule occurs from 12:00 to 23:59 (12:00 PM to 
11:59 PM). This symbol displays in the timeline view or when the schedule covers a range of days.

Scheduling capabilities
When configured to do so, an operator can create and edit notification schedules and calendars 
depending on the assigned authorizations. Operators may be allowed to create and edit 
contacts and contact groups.

WinCC/Event Notifier Documentation
6.5 Operation in Runtime

WinCC/Calendar Options
System Manual, 11/2020, A5E49472488-AA 181



Operators cannot create and edit notifications during Runtime. They can choose only from the 
authorized notifications available in the "Notifications" list. The notifications are created during 
configuration.
Drag and drop allows quick editing of the schedules. Any changes that the operators make take 
effect immediately.

Acknowledging messages
Any contact that receives a notification email can acknowledge a message by replying to the 
notification email. If a contact's work schedule shift ends, the contact can acknowledge 
messages beyond the scheduled time period.

Note
When acknowledging messages, contacts are not to modify the "Subject" field in the response 
email. The notification email and its related response email share a unique ID.

When a message is acknowledged by the local WinCC operator or via the Event Notifier option, 
a response email is sent to all contacts who received email for the specific message.

Message escalation
The server emails messages to a contact only if the alarm is not acknowledged before the 
contact's configured escalation time. The messages are alarms that match the configured 
notifications. The email subject and body are formatted and sent in each contact's configured 
language.

6.5.2 Viewing schedules and resources

Introduction
The schedules in the configured calendars display when a picture that contains the Calendar 
Control is opened in Runtime. The Calendar Control is configured to display in a standard 
calendar view or a multi-resource view (Page 185).
If the "Resources" window is configured to display, operators can view or hide the schedules for 
a resource. The schedules associated with the selected resources display in the data window. 
Depending on the installed Calendar Options, a schedule can be an action schedule or 
notification schedule. A resource can be an action, notification, contact, or calendar.
If the "Date Navigation" window is configured to display, operators can view schedules for a 
selected day or a range of dates. The calendar view changes based on the selections made in the 
"Date Navigation" and data windows.
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Viewing schedules for selected resources         
In the "Resources" window, select the resource names so that a check mark appears. The 
schedules for all selected resources are visible for the scheduled dates. The schedules for any 
calendars not selected are hidden.
When a date or time slot contains more schedules than what displays in the calendar view, an 
arrow displays on the date or time slot. Clicking the arrow opens the "Agenda" list to display the 
additional schedules that are not visible on that date or time slot. You can double-click a schedule 
in the list to display its configuration in the editor.

Navigating to schedules in "Date Navigation" window   
Selecting dates in the "Date Navigation" window displays the schedules for the selected dates in 
the data window. You can do the following tasks in the "Date Navigation" window to show dates:
• Click a day to show the selected day in the day view.
• Highlight a range of days to show the selected range in the month view. You can highlight 

the range by dragging over the desired days. You can also click a day and press <Shift> while 
clicking another day.

• Click a day and then press <Ctrl> while clicking additional days to show the selected days as 
a series of day views.

• Click the "Today" button to show schedules for the current day in the day view.

Navigating to schedules in data window 
Right-clicking on a calendar view in the data window provides various ways to navigate to 
schedules. The resulting view depends on the selected day and date range of the current view.

"Go to Today" from menu
Click this option to display the current day or the work week, week, month, or timeline that 
contains the current day. In each resulting view, the current day is highlighted. On the timeline 
view, the current day is the first day in the timeline.

"Go to Date" from menu
Click this option to open a dialog to enter a specific date and to select the calendar view to 
display. You can choose the date from a pop-up calendar. The view changes to the specified view 
with the work start time highlighted on the specified date.

"Go to This Day" from menu
This option is available only on the month and week views and when one date is selected. If a 
range of days is selected, this option is gray and cannot be selected.
With a date selected in the view, click this option to display the selected date in day view. The 
work start time is highlighted.
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"Time Scales" and "Time Scale Captions" from menu   
These options are available only on the timeline view. You can change the amount of time shown 
in the timeline and select which captions to display.
• Point to "Time Scales" and choose the increment of time to show in the timeline: "Year", 

"Quarter", "Month", "Week", "Day", "Hour", or "00:15:00". Selecting the same scale again 
switches between hiding and showing the scale.

• Point to "Time Scale Captions" and choose the caption for the time scale you want to see. 
Selecting the same caption again switches between hiding and showing the caption.

Hours and day range selection
You can select a range of hours or days in the applicable calendar views in the following ways:
• Drag over the desired hours or days in the view.
• Click an hour or day and then press <Shift> while clicking another hour or day.

"Next" and "Previous" tabs
The data window contains "Next" and "Previous" tabs. You can view the next or prior schedules 
in a calendar view.
• Click the "Next" tab to show the calendar view with the next schedules in the selected time 

span. For example, with the week view selected, clicking "Next" causes the current week view 
to change to the week containing schedules after the current week.

• Click the "Previous" tab to show the calendar view with the prior schedules in the selected 
time span.

Changing the calendar view     
Standard view
Right-click in the data window. Select "Change View To" and choose a calendar view: "Day View", 
"Work Week View", "Week View", "Month View", or "Timeline View". The days highlighted in the 
resulting view depend on the day or range of days selected in the "Date Navigation" window.

Multi-resource view
Right-click in the data window. Select "Grouping" and choose a group type: "Date", "Resource", 
or "None". The way the grouping displays depends on the standard calendar view.

Changing the time ruler     
In the day or work week view, you can customize the ruler to display in a specific time zone. You 
can also change the time increment that displays.

Time zone
Right-click the time ruler and choose "Customize Time Ruler". In the "Time Ruler" dialog, enter a 
descriptive name in the "Label" field. Choose the desired time zone and select the check box to 
adjust the time when daylight saving time occurs. Click "OK".
The calendar control changes to reflect the specified label name and time zone.
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Time increment
Right-click the time ruler and choose the increment of time in minutes to show in the ruler: "60, 
30, 15, 10, 6, 5". The ruler changes to reflect the selected increment.

Refreshing calendar data   
Right-click in the "Resources" window or "Date Navigation" window and choose "Refresh".

6.5.3 Multi-resource views

Introduction   
A multi-resource view allows operators to see schedules of multiple resources at the same time. 
A multi-resource view displays in addition to a standard calendar view. Multiple date areas are 
displayed vertically or horizontally. Each date area displays the schedules associated with the 
selected resource.
When configured to do so, operators can switch between the resource and date views. They can 
disable the multi-resource view so that only a standard calendar view displays.
Depending on the installed Calendar Options, a schedule can be an action schedule or 
notification schedule. A resource can be an action, notification, contact, or calendar.

Color configuration and navigation
A typical multi-resource view would be viewing the schedules of three contacts or the schedules 
of production lines.
For quick recognition, the color configured for a selected resource displays as the background 
color for the resource in the data window. The schedules display as a neutral color to 
complement the background color.
When several resources are selected, the readability of the schedules is reduced. Operators can 
us the navigation toolbar to decrease the visible resources. The toolbar provides navigation, 
scrolling, and increasing/decreasing the number of visible resources.

Date view
When the multi-resource view is "Date", the view shows the grouping by dates displayed 
horizontally with the resources underneath displaying either horizontally or vertically. Only 
schedules for the resources selected in the "Resources" window are visible in the views.
The following figure shows the schedules for two calendars and a contact displayed with the 
multi-resource view as date. The standard calendar view is work week.
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Resource view
When the multi-resource view is "Resource", the view shows the grouping by resources displayed 
horizontally with the dates underneath displaying either horizontally or vertically. Only 
schedules for the resources selected in the "Resources" window are visible in the views.
The following figure shows the same week schedules displayed with the multi-resource view as 
resource.
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6.5.4 Creating notification schedules

Introduction       
Operators can create notification schedules in Runtime using only configured contacts and 
notifications that they are authorized to use. An operator not assigned the authorization for any 
of the notifications or contacts cannot create any schedules. Rather than adding the same 
schedule to a calendar several times, operators can configure one recurring schedule that 
displays in the calendar at the specified dates and times.
If configured to do so, operators can create contacts and contact groups.
Creating a notification schedule in Runtime is the same as during configuration. For detailed 
instructions, see the "Configuration" chapter in this documentation.
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Procedure
1. Double-click a date or time slot to open the Notification Schedule Editor. Optionally, right-

click a date or time slot and choose "New Notification Schedule".
Note
If other schedule types are available and the default schedule type is not notification, you 
must right-click and choose "New Notification Schedule" for this editor to open.

2. Configure the notification schedule:
– Enter a name for the schedule. Optionally, enter a description.
– Set the time the schedule is to start and end.
– Select preconfigured contacts and notifications that you are authorized to use. For each 

contact, set an "Escalation" time in minutes that an alarm must remain unacknowledged 
before the contact is notified.

– Optionally, configure new contacts.
– Select the calendars where the schedule is to display.
– Optionally, configure the schedule to repeat.

3. After you finish configuring the schedule, click "OK".
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Results
The notification schedule displays in the selected calendars at the specified times. The color of 
a schedule is the same as its associated calendar. The way the schedule color (Page 181) displays 
depends on the selection of multiple calendars in the "Resources" window and a multi-resource 
view.
An arrow displays in a date or time slot when it contains schedules that are not visible. Clicking 
the arrow displays the additional schedules in the "Agenda" list. 

6.5.5 Modifying notification schedules

Introduction   
Operators can modify only schedules that contain contacts and notifications they are authorized 
to use. Operators not assigned the authorization for any of the preconfigured contacts or 
notifications cannot modify any schedules.
Modifying a notification schedule in Runtime is the same as during configuration. For detailed 
instructions, see the "Configuration" chapter in this documentation.
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Using the Notification Schedule Editor
1. Double-click a notification schedule to display its configuration.
2. Make the desired changes in the editor:

– Renaming schedule:
Enter the text in the "Name" and "Description" fields.

– Changing schedule time:
Set the time the schedule is to start and end.

– Deleting contacts or notifications:
Select the desired rows. Right-click and choose "Delete". To delete all contacts or 
notifications, right-click and choose "Clear".

– Adding preconfigured contacts or notifications:
Click the "Select" button under "Contacts" or "Notifications". In the list, choose the 
contacts or notifications and click "OK". For each contact, set an "Escalation" time in 
minutes.

– Configuring or changing contact associations:
Click the "Add New" button under "Contacts". Enter the necessary contact information 
and click "OK

– Adding or changing recurrence:
Click "Recurrence" and set the recurrence pattern and time.

– Removing recurrence:
Click "Recurrence" and then click "Remove Recurrence".

– Changing associated calendar:
Click the "Calendar" arrow and select the calendars where the schedule is to display.

3. After you finish modifying the schedule, click "OK".

Dragging and dropping schedules     
Quickly modify a schedule by dragging it to the desired date and time in a calendar view or to a 
date in the "Date Navigation" window. The day and work week views let you quickly change the 
duration of a schedule by dragging its start or end border to the desired time.
If the schedule contains a contact or notification that you are not authorized to use, the schedule 
remains at the configured date and time. If you have sufficient permissions, the schedule moves 
to the new date and time.

6.5.6 Deleting and restoring schedules

Introduction
Operators can modify schedules that contain resources they are authorized to use. Operators 
not assigned the authorization for any of the preconfigured resources cannot modify any 
schedules. Depending on the installed Calendar Options, a resource can be an action, 
notification, contact, or contact group.
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Deleting schedules     
Quickly delete a schedule from all calendars by right-clicking the schedule and choosing 
"Delete". Optionally, you can select the schedule and press <Delete>. If the schedule is in a 
recurrence series, you will choose whether to delete all occurrences or only the occurrence of 
the selected day and time.
Deleting the selected occurrence is an override to the schedule and does not affect the other 
occurrences in the series. This capability is helpful when you do not want the schedule to 
execute on the selected date. Deleting the series deletes all occurrences of the schedule.
From the schedule editor, you can delete a schedule or an occurrence on the selected day in a 
recurring schedule by clicking the "Delete" button. Clicking the "Calendars" arrow and 
unselecting a calendar lets you remove the schedule from that calendar.

Restoring a recurring schedule     
You can restore all modified and deleted occurrences to the initial configured state of the 
recurring schedule:
1. Right-click any occurrence in the recurring schedule and choose "Edit Series".
2. In the editor, click "Recurrence".
3. In the "Recurrence" dialog, click "OK" without making any changes.
4. Click "OK" to close the editor.
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